
B
L

M

U.S. Department of the Interior
Bureau of Land Management

ePlanning Training Manual and Reference Guide
Comprehensive Reference Guide

January 1, 2013

PREPARING OFFICE
U.S. Department of the Interior
Bureau of Land Management

Denver Federal Center, Building 50
Denver, CO 80225 USA





ePlanning Training Manual and
Reference Guide

Comprehensive Reference Guide

January 1, 2013



This page intentionally
left blank



ePlanning Training Manual and Reference
Guide

iii

Table of Contents
Course Information .................................................................................................................... xvii

Description of ePlanning Courses ........................................................................................ xvii
Basic Course Description and Outline ................................................................................. xvii
Advanced Course Description and Outline ......................................................................... xviii
Reviewer Course Description and Outline .......................................................................... xviii
Workbook Description .......................................................................................................... xix

_1. Introduction to ePlanning ....................................................................................................... 1

_1.1. Introduction ..................................................................................................................... 1
1.1.1. Objective ................................................................................................................ 1
1.1.2. Definition of ePlanning and Intended Use ............................................................. 1

_1.2. The ePlanning Software and Components ...................................................................... 1
_1.3. Benefits of Using ePlanning ............................................................................................ 3
_1.4. Navigating to NEPA and LUP Register .......................................................................... 3

_2. ePlanning Basics ..................................................................................................................... 11

_2.1. Introduction ................................................................................................................... 13
2.1.1. Objectives ............................................................................................................ 13

_2.2. Accessing ePlanning ..................................................................................................... 13
2.2.1. Access and Log into Citrix .................................................................................. 14
2.2.2. Log into ePlanning Webtop .................................................................................. 15

_2.3. Introduction to ePlanning Webtop ................................................................................ 18
2.3.1. The ePlanning Webtop Window .......................................................................... 19

2.3.1.1. ePlanning Menu and Tool Bars ................................................................. 19
2.3.1.2. The Navigation Pane and the Display Pane .............................................. 20
2.3.1.3. Terms for Navigating to and Selecting Items in Webtop .......................... 21
2.3.1.4. Breadcrumbs ............................................................................................. 22

2.3.2. Cabinets ................................................................................................................ 22
2.3.3. Subscriptions ........................................................................................................ 23
2.3.4. Your Inbox ........................................................................................................... 24
2.3.5. Webtop Search ..................................................................................................... 25

_2.4. Customizing your Work Space ..................................................................................... 26
2.4.1. Modifying the Webtop Display Pane ................................................................... 26

2.4.1.1. Changing Column Display ........................................................................ 26
2.4.2. Preferences ........................................................................................................... 28

2.4.2.1. General - Theme and Subscription Logon Preference .............................. 29
_2.5. Logging out of the ePlanning System ........................................................................... 31

2.5.1. Logging out of Webtop ........................................................................................ 32

_3. Creating a New NEPA Project .............................................................................................. 33

_3.1. Introduction ................................................................................................................... 35
3.1.1. Objectives ............................................................................................................ 35

January 1, 2013 Table of Contents



iv ePlanning Training Manual and
Reference Guide

_3.2. Working with Projects in the ePlanning Webtop .......................................................... 35
_3.3. Creating a New NEPA Project - the Background Tab .................................................. 35
_3.4. Editing a Project - The Team Definition Tab ................................................................ 43
_3.5. User Roles and Permissions .......................................................................................... 44
_3.6. Adding Team Members: Importing an IDT Group ...................................................... 46
_3.7. SUPPLEMENTAL INFORMATION ........................................................................... 47

3.7.1. Additional Web Project Form Tabs ...................................................................... 47

_4. Assigning–Acknowleging Authoring Tasks, Advanced Webtop &Workflows ................ 49

_4.1. Introduction ................................................................................................................... 51
4.1.1. Objectives ............................................................................................................ 51

_4.2. Overview on Virtual Documents and XML Documents ............................................... 51
_4.3. Assigning Document Authoring Tasks ......................................................................... 52

4.3.1. Assigning Authoring Tasks .................................................................................. 52
_4.4. My Authoring Tasks ..................................................................................................... 55

4.4.1. Acknowledging Authoring Tasks ........................................................................ 55
4.4.2. Other Functions in My Authoring Tasks ............................................................. 57
4.4.3. Navigating to an Object from My Authoring Tasks ............................................ 58

_4.5. Working with Documents from Webtop ....................................................................... 59
4.5.1. Check Out a Document for Editing ..................................................................... 60
4.5.2. Checking In a Document ..................................................................................... 62

_4.6. Export Project Info to Document .................................................................................. 64
_4.7. Advanced Webtop Features .......................................................................................... 65

4.7.1. Objectives ............................................................................................................ 66
4.7.2. The L Drive .......................................................................................................... 66

4.7.2.1. Cleaning Up Your L Drive ........................................................................ 69
4.7.2.2. Access Your Mapped Drives ..................................................................... 69

4.7.3. Clearing the Clipboard in Webtop ....................................................................... 72
4.7.4. Maintaining Project Status ................................................................................... 73
4.7.5. Copying and Pasting a Template from the Asset Library .................................... 77
4.7.6. Miscellaneous Advanced Webtop Information .................................................... 79

4.7.6.1. Printing ...................................................................................................... 79
4.7.6.2. Archive a Virtual Document ..................................................................... 80

_4.8. Project Workflows ......................................................................................................... 86
4.8.1. Working with your Inbox: Accepting a Task ....................................................... 87
4.8.2. Working with your Inbox: Finishing a Task ........................................................ 89

_4.9. Types of Workflows ...................................................................................................... 89
4.9.1. Project Workflows ................................................................................................ 90
4.9.2. Document Workflow ............................................................................................ 90

_4.10. Advanced Information on Workflows ......................................................................... 91
4.10.1. ePlanning Workflow Tools ................................................................................. 92

4.10.1.1. Workflow Reporting and My Workflows ................................................ 93
4.10.1.2. Manipulating Workflow Tools ................................................................ 94
4.10.1.3. Viewing Workflow Map .......................................................................... 94
4.10.1.4. Viewing Workflow Details ...................................................................... 95
4.10.1.5. Creating Reports ..................................................................................... 97
4.10.1.6. Changing Workflow Supervisor .............................................................. 98
4.10.1.7. Pausing and Resuming a Workflow ........................................................ 99

Table of Contents January 1, 2013



ePlanning Training Manual and Reference
Guide

v

4.10.2. Terminating a Workflow .................................................................................. 101
_4.11. Quickflows ................................................................................................................ 102

_5. Arbortext Editor .................................................................................................................. 109

_5.1. Introduction ................................................................................................................. 111
5.1.1. Objectives .......................................................................................................... 111

_5.2. Introduction to XML and Arbortext Editor ................................................................ 111
5.2.1. The Basics of XML ............................................................................................ 111
5.2.2. The Grammar of XML ....................................................................................... 112
5.2.3. Transitioning to Arbortext ................................................................................. 112
5.2.4. Structured Content ............................................................................................. 112
5.2.5. Formatting, Stylesheets, and Printing ................................................................ 113

_5.3. Arbortext Editor - Navigation and Preferences .......................................................... 114
5.3.1. Starting to Edit Your Document in Arbortext Editor ......................................... 114
5.3.2. Navigating the Arbortext Editor Window .......................................................... 114
5.3.3. Changing Views in Arbortext (tags on and off, split screen) ............................. 116

5.3.3.1. XML Tag Display ................................................................................... 116
5.3.3.2. Split Windows ......................................................................................... 117
5.3.3.3. Changing Display Font Size (Zoom In and Out) .................................... 118

5.3.4. Arbortext Editor Preferences ............................................................................. 118
5.3.4.1. Preference: Full Menus ........................................................................... 118
5.3.4.2. Preference: Change Colors ..................................................................... 119

_5.4. Arbortext Editor Basics ............................................................................................... 119
5.4.1. Enter Text ........................................................................................................... 120

5.4.1.1. Format Text ............................................................................................. 120
5.4.2. Bulleted and Numeric Lists ............................................................................... 120

5.4.2.1. Working with Ordered Lists .................................................................... 121
5.4.3. Copy a Table ...................................................................................................... 126

5.4.3.1. Modifying a Table ................................................................................... 127
5.4.3.2. Table Tags ............................................................................................... 127
5.4.3.3. The Look and Feel of a Table ................................................................. 130

5.4.4. Figures and Media Objects (Images) ................................................................. 131
5.4.4.1. Working with Graphics ........................................................................... 132
5.4.4.2. Making a Figure or Image 508 Compliant .............................................. 137

5.4.5. Static Maps ......................................................................................................... 138
5.4.6. Adding Chapters, Sections, and Sub Sections ................................................... 139
5.4.7. Check for Completeness .................................................................................... 139

_5.5. SUPPLEMENTAL INFORMATION ......................................................................... 140
5.5.1. Cover Pages ....................................................................................................... 140

5.5.1.1. Full Covers .............................................................................................. 141
5.5.1.2. User Covers ............................................................................................. 142
5.5.1.3. Standard Covers ...................................................................................... 142
5.5.1.4. The Text Overlay .................................................................................... 143
5.5.1.5. Chapter Covers ........................................................................................ 144

5.5.2. Additional Tags .................................................................................................. 145
_5.6. Advanced Arbortext Features ..................................................................................... 145

5.6.1. Introduction ........................................................................................................ 145
5.6.1.1. Objectives ............................................................................................... 145

January 1, 2013 Table of Contents



vi ePlanning Training Manual and
Reference Guide

5.6.2. Some Fundamental Tasks in AE ........................................................................ 146
5.6.2.1. Using Markups ........................................................................................ 146
5.6.2.2. Special Spacing Needs ............................................................................ 149
5.6.2.3. Subscript and Superscript Tags ............................................................... 152

5.6.3. Modifying Font Sizes and Related Attributes .................................................... 153
5.6.4. Clearing the Clipboard that is Linked to Arbortext Editor ................................ 155
5.6.5. Footnotes ............................................................................................................ 155

5.6.5.1. Multiple References to a Single Footnote ............................................... 158
5.6.6. Cross-referencing Using the xref Tag ................................................................ 163

5.6.6.1. Cross References and Links .................................................................... 164
5.6.7. Additional Tips for Working with Maps ............................................................ 170

5.6.7.1. Maps in an Appendix .............................................................................. 171
5.6.7.2. Maps That Are Not In An Appendix ...................................................... 175

5.6.8. Text Entities ....................................................................................................... 178
5.6.8.1. Creating a New Entity in Arbortext Editor ............................................. 179
5.6.8.2. Inserting an Entity in Arbortext Editor ................................................... 182
5.6.8.3. Modifying an Entity Value in Arbortext Editor ...................................... 184

5.6.9. Content Re-use ................................................................................................... 188
5.6.9.1. Types of Re-Usable Document ............................................................... 188

5.6.10. Making Your Document Complete .................................................................. 190
5.6.10.1. Appendices ............................................................................................ 190
5.6.10.2. Glossary and Glossary Terms ............................................................... 191
5.6.10.3. Acronym List and Acronyms ................................................................ 203
5.6.10.4. Bibliography and Bibliography Entries ................................................ 208
5.6.10.5. Index and Index Terms .......................................................................... 213

5.6.11. Miscellaneous Advanced Information ............................................................. 215
5.6.11.1. Tag Templates ....................................................................................... 215
5.6.11.2. Distinguishing Between Dashes and Hyphens ...................................... 220
5.6.11.3. Quotation or Inverted Comma .............................................................. 220
5.6.11.4. Processing Instructions ......................................................................... 221

_6. Reviews .................................................................................................................................. 225

_6.1. Introduction ................................................................................................................. 227
6.1.1. Objectives .......................................................................................................... 227

_6.2. Beginning a Peer-to-Peer Review ............................................................................... 227
_6.3. Document Review Workflow ...................................................................................... 230
_6.4. Commenting on a Review ........................................................................................... 230

6.4.1. Reviews from Interdisciplinary Team Members (who have access to
ePlanning) ......................................................................................................... 231

6.4.2. Reviews from Interdisciplinary Team Members (who may not have access to
ePlanning) ......................................................................................................... 232

6.4.2.1. Consolidating Reviews from Multiple PDFs into one Document .......... 232
_6.5. Print PDF to Include Comments using Adobe Acrobat Pro from Citrix Metaframe .. 233
_6.6. Comment Response and Revision .............................................................................. 234

6.6.1. Response and Revision ...................................................................................... 234
6.6.1.1. Setting Comment Status .......................................................................... 234
6.6.1.2. Replying to Selected Comments ............................................................. 234

_6.7. Revising the Arbortext Document .............................................................................. 234

Table of Contents January 1, 2013



ePlanning Training Manual and Reference
Guide

vii

6.7.1. Working with the “Author Rework” Task (if necessary) ................................... 235
6.7.2. Submitting the Work to the Team Lead ............................................................. 236

_6.8. SUPPLEMENTAL INFORMATION ......................................................................... 237
6.8.1. Interim Review Workflow and Second Way to Create a Peer to Peer Review .. 237

6.8.1.1. Interim Reviews ...................................................................................... 237

_7. Stylesheets, Builds and PDF 508 Compliance ................................................................... 241

_7.1. Introduction ................................................................................................................. 243
7.1.1. Objectives .......................................................................................................... 243

_7.2. Stylesheets ................................................................................................................... 243
7.2.1. ePlanning Stylesheets ......................................................................................... 243
7.2.2. Selecting Project Stylesheets ............................................................................. 244

_7.3. Builds .......................................................................................................................... 245
7.3.1. Creating a Document Build ............................................................................... 246
7.3.2. Creating the First Required Build: An Interactive Document Build ................. 247
7.3.3. Creating the Second Required Build: Print PDF ............................................... 249

_7.4. The Build Directory .................................................................................................... 249
_7.5. PDF 508 Compliance .................................................................................................. 251

7.5.1. 508 Compliance ................................................................................................. 251
7.5.2. Filter by Status ................................................................................................... 255
7.5.3. Manage Project Document Builds Buttons ........................................................ 255

_8. Back Office and Front Office .............................................................................................. 257

_8.1. Introduction ................................................................................................................. 259
8.1.1. Objectives .......................................................................................................... 259

_8.2. Back Office ................................................................................................................. 259
_8.3. General Information .................................................................................................... 260

8.3.1. Accessing the Back Office ................................................................................. 260
8.3.2. Back Office Navigation ...................................................................................... 260

8.3.2.1. Understanding the Back Office Homepage ............................................. 261
8.3.2.2. Understanding Webpage Status Indicators: Colors & Definitions ......... 262

_8.4. Adding Your NEPA Project to the NEPA Register ..................................................... 262
8.4.1. Adding a Project to the NEPA Register ............................................................. 263
8.4.2. Adding The Interactive Document Build ........................................................... 265
8.4.3. Adding The Print PDF ....................................................................................... 266

_8.5. Enhancing the Project Web Site .................................................................................. 269
_8.6. Submit Web Site for Public Affair's Approval ............................................................ 271
_8.7. Public Affairs Approval Process ................................................................................. 272
_8.8. Publishing the Project Web Site .................................................................................. 273

8.8.1. Publish Now Option ........................................................................................... 274
8.8.2. Publish on a Future Date Option ........................................................................ 274

_8.9. Editing the Published Website .................................................................................... 275
_8.10. Front Office (FO) ...................................................................................................... 277
_8.11. SUPPLEMENTAL INFORMATION: Back Office & Front Office ......................... 279

8.11.1. Creating a Project Summary Web Site ............................................................. 279
8.11.2. Submitting to Public Affairs ............................................................................ 280

_8.12. Advanced Back Office Features ................................................................................ 281

January 1, 2013 Table of Contents



viii ePlanning Training Manual and
Reference Guide

8.12.1. Introduction ...................................................................................................... 281
8.12.1.1. Objectives ............................................................................................. 281

8.12.2. Establish and Modify a Comment Period ........................................................ 281
8.12.2.1. Establishing a Comment Period ............................................................ 282
8.12.2.2. Modifying a Comment Period .............................................................. 287

8.12.3. How to Enter Letters via the Back Office ........................................................ 287
8.12.3.1. Comment Submission Dialog Window ................................................. 288
8.12.3.2. Entering a Letter in Back Office ........................................................... 290

_9. Decision File .......................................................................................................................... 295

_9.1. Introduction ................................................................................................................. 297
9.1.1. Objectives .......................................................................................................... 297

_9.2. The Decision File ........................................................................................................ 297
9.2.1. NEPA or LUP Project and the Decision File ..................................................... 297
9.2.2. Creation of the Directory Structure for the Decision File .................................. 298

_9.3. Working with Folders and Files in Webtop ................................................................ 298
9.3.1. Create a New Folder in your Project .................................................................. 298
9.3.2. Importing Documents or Folders ....................................................................... 299
9.3.3. Working with Folders and Documents ............................................................... 299
9.3.4. Decision File Structure ...................................................................................... 300

10. Maps in ePlanning ................................................................................................................ 303

10.1. Introduction to Maps within ePlanning ....................................................................... 305
10.1.1. Objectives ........................................................................................................ 305

10.2. An Overview of the ePlanning Map Feature .............................................................. 305
10.3. Preparing Maps for your Project ................................................................................. 306

10.3.1. Setting Up the Webmaps in Back Office ......................................................... 306
10.3.2. Publishing the Webmaps .................................................................................. 310

10.4. Understanding Public Involvement with Webmaps .................................................... 310
10.4.1. The Maps Link ................................................................................................. 311
10.4.2. The Document and Reports Link ..................................................................... 313

10.5. Analyzing the Map Comments in the Back Office or in CommentWorks .................. 318

11. CommentWorks .................................................................................................................... 323

11.1. Introduction ................................................................................................................. 325
11.1.1. Objectives ......................................................................................................... 325

11.2. Overview ..................................................................................................................... 325
11.2.1. Comment Analysis Process Overview ............................................................. 325
11.2.2. CommentWorks Terminology .......................................................................... 326
11.2.3. CommentWorks Permissions ........................................................................... 326
11.2.4. Important Notes About CommentWorks ......................................................... 327

11.3. Logging In and Out of CommentWorks ...................................................................... 328
11.4. Managing Comment Submissions .............................................................................. 329

11.4.1. Using the Submission List ............................................................................... 329
11.4.1.1. Viewing the Submission List ................................................................ 329
11.4.1.2. Searching Submissions ......................................................................... 330

Table of Contents January 1, 2013



ePlanning Training Manual and Reference
Guide

ix

11.4.1.3. Filtering Submissions ............................................................................ 334
11.5. Entering Letters Directly into CW .............................................................................. 334
11.6. Searching for Form Letters ......................................................................................... 339

11.6.1. Batch Processing Form Letters (CommentWorks 4.2.1) ................................. 341
11.7. Parsing and Coding Comments from Submissions ..................................................... 348

11.7.1. Open a Submission ........................................................................................... 348
11.7.1.1. Submission Metadata ............................................................................ 349
11.7.1.2. Commenters .......................................................................................... 351
11.7.1.3. Comments ............................................................................................. 352
11.7.1.4. Tasks ...................................................................................................... 352
11.7.1.5. Flags ...................................................................................................... 352
11.7.1.6. Attachments .......................................................................................... 353

11.7.2. Parse and Code Submissions ............................................................................ 353
11.7.2.1. Editing Tools ......................................................................................... 354

11.8. Searching, Sorting and Viewing Comments ............................................................... 358
11.8.1. Searching and Sorting Comments .................................................................... 358
11.8.2. Viewing Comments .......................................................................................... 359

11.9. Viewing, Sorting and Searching Comment Links ....................................................... 361
11.10. Viewing Comments, Summaries and Responses by Issue ........................................ 362
11.11. Writing Comment Summaries ................................................................................... 364

11.11.1. Review And Approve The Prepared Summary Statements ........................... 367
11.12. Writing Responses .................................................................................................... 367

11.12.1. Review And Approve The Prepared Responses ............................................ 369
11.13. Reports from CommentWorks .................................................................................. 369

11.13.1. Submission Report ......................................................................................... 372
11.13.2. Comment Report ............................................................................................ 372
11.13.3. Comment Links Report .................................................................................. 372
11.13.4. Issue Report .................................................................................................... 372

11.14. SUPPLEMENTAL INFORMATION ....................................................................... 373
11.14.1. Additional Functions in the Edit Mode for an Initiative ................................ 373

11.14.1.1. Details Tab .......................................................................................... 373
11.14.1.2. Lookup Values ..................................................................................... 374
11.14.1.3. Flags Tab ............................................................................................. 374
11.14.1.4. Tasks Tab ............................................................................................. 375

11.14.2. Changing the Lookup Values, Flags or Tasks ................................................ 375

12. Best Management Practices ................................................................................................ 377

12.1. Completing a Project ................................................................................................... 379
12.1.1. Updating the Status of a Project ....................................................................... 379
12.1.2. eNEPA for EPA ................................................................................................ 380

12.2. Webtop Tips ................................................................................................................ 380
12.3. Arbortext Tips ............................................................................................................. 380

12.3.1. Change Tracking .............................................................................................. 380
12.3.2. Working with Large Documents ...................................................................... 380

12.4. Back Office Tips ......................................................................................................... 381
12.5. CommentWorks Tips .................................................................................................. 381
12.6. Citrix Shadowing ........................................................................................................ 381

January 1, 2013 Table of Contents



x ePlanning Training Manual and
Reference Guide

List of Abbreviations .................................................................................................................. 383

Glossary ....................................................................................................................................... 385

Appendix A. Arbortext Editor Tags ......................................................................................... 389

Appendix B. Commonly Used Arbortext Editor Attributes .................................................. 395

Appendix C. References ............................................................................................................. 397

Appendix D. Publishing Without Using an Interactive Document ........................................ 399

D.1. Uploading the Desired Document Into the Project Folder ........................................... 399
D.2. Adding the Document to The Project Web Site ........................................................... 401

Table of Contents January 1, 2013



ePlanning Training Manual and Reference
Guide

xi

List of Figures
Figure 5.1. End result in a PDF preview using the Literallayout and Blockquote Tags .............. 152
Figure 5.2. Comment Analysis Example ..................................................................................... 223
Figure 11.1. List Submissions ...................................................................................................... 349
Figure 11.2. Edit Submission Window ........................................................................................ 349
Figure 11.3. Edit Summary and Response Tools ......................................................................... 368
Figure 11.4. CommentWorks Initiative Details ........................................................................... 373
Figure 11.5. CommentWorks Lookup Values .............................................................................. 374
Figure 11.6. CommentWorks Flags ............................................................................................. 375
Figure 11.7. CommentWorks Tasks ............................................................................................. 375

January 1, 2013 List of Figures



This page intentionally
left blank



ePlanning Training Manual and Reference
Guide

xiii

List of Tables
Table 2.1. Summary of Webtop Nodes .......................................................................................... 20
Table 3.1. User Roles and Definitions ........................................................................................... 45
Table 4.1. Field Descriptions on the Assign Document Authoring Task Form ............................. 54
Table 4.2. L Drive Folders ............................................................................................................. 68
Table 4.3. Available Project Statuses ............................................................................................. 74
Table 5.1. Standard Cover Colors ................................................................................................ 143
Table 5.2. Comment Analysis Attributes ..................................................................................... 223
Table 5.3. List of Preparers .......................................................................................................... 224
Table 7.1. ePlanning Stylesheet Descriptions .............................................................................. 244
Table 8.1. ePlanning Website Types ............................................................................................ 259
Table 8.2. Back Office Webpage Status ....................................................................................... 262
Table 11.1. Edit Submission Tools ............................................................................................... 354
Table 11.2. Tasks for Comments .................................................................................................. 361
Table A.1. Arbortext Editor Tags ................................................................................................. 389
Table B.1. Commonly Used Arbortext Editor Tag Attributes ..................................................... 395

January 1, 2013 List of Tables



This page intentionally
left blank



ePlanning Training Manual and Reference
Guide

xv

List of Examples
Example 2.1. Log In and Out of Citrix and the ePlanning Webtop ............................................... 13
Example 2.2. Navigate to a NEPA Project in Your Office ............................................................. 22
Example 2.3. Create a Subscription ............................................................................................... 23
Example 2.4. Conduct a Search ..................................................................................................... 25
Example 2.5. Change Webtop Theme ............................................................................................ 29
Example 2.6. Changing Login Screen to Open to the Subscription Folder ................................... 30
Example 3.1. Creating a New NEPA Project ................................................................................. 35
Example 3.2. Editing a Project's Team Definition ......................................................................... 43
Example 4.1. Assigning Sections to Team Members .................................................................... 53
Example 4.2. Acknowledging My Authoring Tasks ...................................................................... 55
Example 4.3. Navigating to an Object ........................................................................................... 58
Example 4.4. Check Out a Document for Editing ......................................................................... 60
Example 4.5. Checking In a Document ......................................................................................... 62
Example 4.6. Export the Project Information into the EA Document ........................................... 64
Example 4.7. Access Your L drive ................................................................................................ 66
Example 4.8. Clean Up Your L Drive Folders ............................................................................... 69
Example 4.9. Find Additional Drives ............................................................................................ 70
Example 4.10. Check (and Clear) the Clipboard in Webtop .......................................................... 72
Example 4.11. Modify the Project Status Options in Webtop ....................................................... 75
Example 4.12. Copy and Paste a Template (EA for example) ....................................................... 77
Example 4.13. Archiving a Document ........................................................................................... 81
Example 4.14. Starting a Workflow ............................................................................................... 86
Example 4.15. Accepting a Task .................................................................................................... 88
Example 4.16. Finish the Task for Getting the EA Document Template ....................................... 89
Example 4.17. Start a Workflow .................................................................................................... 92
Example 4.18. View My Workflows and Workflow Reporting ..................................................... 93
Example 4.19. Pause (and resume) a workflow ............................................................................. 99
Example 4.20. Examine the Terminate Workflow function ......................................................... 101
Example 5.1. Print Compose or Preview ..................................................................................... 114
Example 5.2. Edit your Document (Open Arbortext Editor) ....................................................... 114
Example 5.3. Change Your Tag Display ...................................................................................... 116
Example 5.4. Change How the Arbortext Editor Window Displays ........................................... 117
Example 5.5. Setting Arbortext Editor Preferences ..................................................................... 118
Example 5.6. Create Continuous Numbering for an Ordered List .............................................. 123
Example 5.7. Modifying an Itemized or Bulleted List’s Spacing ................................................ 124
Example 5.8. Copy and Paste a Table .......................................................................................... 126
Example 5.9. Insert a Digital Picture ........................................................................................... 131
Example 5.10. Adjusting the Digital Photo ................................................................................. 132
Example 5.11. Insert a Landscape Graphic or Image .................................................................. 137
Example 5.12. Making a Figure or Image 508 Compliant .......................................................... 137
Example 5.13. Inserting a Static Map .......................................................................................... 138
Example 5.14. Chapters, Sections, and Sub Sections .................................................................. 139
Example 5.15. Check Completeness ............................................................................................ 139
Example 5.16. Splitting and Joining Tags ................................................................................... 146
Example 5.17. Using the Literallayout and Blockquote Tags ..................................................... 149
Example 5.18. Using the Subscript & Superscript Tags .............................................................. 153
Example 5.19. Basic Use of the Footnote Tag ............................................................................. 157

January 1, 2013



xvi ePlanning Training Manual and
Reference Guide

Example 5.20. Use Footnote & Footnoteref Tags for Multiple References ................................ 160
Example 5.21. Cross reference (xref) .......................................................................................... 164
Example 5.22. Use the epl_map Tag in Your Document ............................................................. 171
Example 5.23. Creating a New Entity in Arbortext Editor .......................................................... 179
Example 5.24. Create a Glossary and Adding Glossary Terms ................................................... 192
Example 5.25. Adding a Acronym List and Acronyms ............................................................... 203
Example 5.26. Create a Bibliography and Add Entries ............................................................... 209
Example 5.27. Creating an Index and Add Index Terms ............................................................. 214
Example 5.28. Creating a New Tag Template ............................................................................. 215
Example 5.29. Using Processing Instructions Demo ................................................................... 224
Example 5.30. Exercise — Updating the List Of Preparers ........................................................ 224
Example 6.1. Creating a Peer-to-Peer Review Package .............................................................. 227
Example 6.2. Conduct a Review .................................................................................................. 231
Example 7.1. Select a Stylesheet for the Project ......................................................................... 244
Example 7.2. How to Create a Build of your Document ............................................................. 246
Example 8.1. Adding a Project to the NEPA Register and Creating a Project Web Site ............. 262
Example 8.2. Utilizing the Text Editor ........................................................................................ 269
Example 8.3. Using Front Office ................................................................................................. 277
Example 8.4. Establish a Comment Period .................................................................................. 282
Example 8.5. Modifying a Comment Period ............................................................................... 287
Example 8.6. Entering a Letter in Back Office ............................................................................ 290
Example 9.1. Creating a New Folder ........................................................................................... 298
Example 10.1. Create the Webmaps in Back Office .................................................................... 306
Example 10.2. Explore the Webmaps in the Maps Section ......................................................... 311
Example 10.3. Explore the Webmaps in the Document and Reports Section ............................. 313

January 1, 2013



Course Information
Description of ePlanning Courses

Currently, there are three ePlanning Courses available to users of ePlanning. They are:

● Basics Course: Gives new users an overview of the ePlanning system.

● Advanced Course: Gives users more information on how to better utilize features in the
ePlanning system.

● Reviewer Course: Gives reviewers an understanding of their role in document review(s).

Basic Course Description and Outline

Listed below is the course outline and schedule for the Basics Course. The times may vary
slightly based on class size, network speeds and progress made by the class. Times can be
adjusted to focus on the most critical areas of ePlanning, according to the needs of each class.

Breaks will be taken as needed throughout the training periods. Please ensure that you return
from breaks on time to avoid classroom interruptions. Also, please ensure that all cell phones are
turned off or on “vibrate”.

This three day training course provides instruction on how to use the ePlanning application with
the development of National Environmental Policy Act (NEPA) documents. This course will
guide the user from receiving a project proposal in the office to publishing a NEPA webpage, all
while using the ePlanning application. The trainee will create a NEPA Environmental Assessment
(EA) project, add team members, make authoring assignments, author and review the NEPA
documents and/or sections of a document, add the project to the BLM NEPA Register, create,
publish and maintain a website, (and if applicable, add a comment period), process received
comments, and discuss how to maintain an administrative record using the ePlanning application.

Day 1 Basic
● 8:00 – 8:30 – Introductions, Ground Rules, Purpose
● 8:30 – 10:00 – Front Office software Demonstration and Public Commenting
● 10:00 – 11:30 – Webtop Basics
● 11:30 – 12:30 – Lunch
● 12:30 – 2:00 – Creating & Editing Projects
● 2:00 – 4:00 – Authoring and Task Assignments
● 4:00 – Q&A

Day 2 Basic
● 8:00 – 8:30 – Review
● 8:30 – 11:30 – Arbortext Basics
● 11:30 – 12:30 – Lunch
● 12:30 – 1:30 – Arbortext Basics Continued
● 1:30 – 2:30 – Reviews/Comment Enabled PDF’s
● 2:30 – 4:00 – Publishing Preparation
● 4:00 – Q&A
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Day 3 Basic
● 8:00 – 9:00 – Review & Test
● 9:00 – 10:00 – Build PDF 508 Compliance
● 10:00 – 11:30 – File Structure & Back Office
● 11:30 – 12:30 – Lunch
● 12:30 – 1:30 – Back Office, Website Admin & Approval
● 1:30 – 2:30 – GIS Maps in BO
● 2:30 – 4:00 – CommentWorks and Back Office analysis
● 4:00 – Q&A

Advanced Course Description and Outline

Listed below is the course outline and schedule for the Advanced Course.

The two day training course provides direction on how to further utilize the ePlanning system for
the development of National Environmental Policy Act (NEPA) documents. Users should already
be familiar with the general functions of ePlanning, and should have previously attended the
ePlanning Basics course. This Advanced ePlanning course will show users how to use additional
features of the system, which will allow the user to serve as an immediate on-site resource for
fellow peers in their office.

Day One: Advanced
● 8:00 – 8:30 – Introductions and Course Outline
● 8:30 – 11:30 – Advanced Webtop Features
● 11:30 – 12:30 – Lunch
● 12:30 – 4:00 – Advanced Arbortext Features
● 4:00 – Review and Q&A

Day Two: Advanced
● 8:00 – 8:30 – Day One Review
● 8:30 – 11:30 – Advanced Back Office Features
● 11:30 – 12:30 – Lunch
● 12:30 – 3:30 – CommentWorks, Best Management Practices, and Miscellaneous Topics
● 3:30 – 4:00 – Review and Q&A

Reviewer Course Description and Outline

Listed below is the course outline and schedule for the Reviewer Course. The times may vary
slightly based on class size, network speeds and progress made by the class. Times can be
adjusted to focus on the most critical areas of ePlanning, according to the needs of each class.
● 8:00 – 8:30 – Introductions, Ground Rules, Purpose
● 8:30 – 9:00 – Introduction to ePlanning
● 9:00 – 10:00 – Front Office Demonstration & Public Commenting
● 10:00 – 11:30 – Webtop Basics
● 11:30 – 12:30 – Lunch
● 12:30 – 1:30 – Reviews/Comment Enabled PDF’s
● 1:30 – 2:00 – Publishing
● 2:00 – 4:00 – Basic Comment Works & Back Office
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● 4:00 – Q&A

Workbook Description

The NEPA process is intended to help public officials make decisions that are based on
understanding environmental consequences and taking actions that protect, restore, and enhance
the environment (40 CFR 1500.1(c)). The ePlanning software is intended to help BLM employees
create planning documents that meet our NEPA compliance responsibilities from all levels of
our agency including decision-makers, program managers, interdisciplinary team members and
BLM contractors.

This workbook contains instructions and exercises for students learning the software and
processes related to ePlanning. This workbook will be the main reference material for the course,
with other relevant reference resources mentioned throughout. The workbook has been written
for you, the reader involved with the land use planning and NEPA processes.

The workbook includes:
● Accessing and navigating around in ePlanning.
● Starting and managing a project.
● Completing tasks on a project.
● Sending and receiving peer feedback.
● Posting LUP/NEPA projects to the web.

Key Terms Used in this Workbook

There are a few terms and phrases used throughout this workbook that may be unfamiliar or used
in other ways in different contexts; these are defined below. There is also a more comprehensive
Glossary at the back of the Workbook. Also, formatting of the text is used consistently to
represent certain actions or descriptions of forms, fields, values, etc.
● A “window” opens when an application is started. An application window may be partitioned
into two or more parts called “panes”.

● A “menu bar” is displayed across the top of most windows and contains “drop-down menus”
that have many “options” or “tools” from which you can choose.

● A “Context Menu” or “Right-Click Menu”, is called forth when a user right-clicks on a
highlighted object inside of Webtop. The choices offered via the Context Menu are presented
in relation to the object a user wishes to take action on.

● Menu options and icons can be “selected” or “chosen” by moving your mouse pointer to it and
“clicking on it”. Menu bar commands are formatted in bold with the progressions indicated
with the " > " symbol (e.g., "Edit > Copy").

● “Check the box” means placing a check in the box next to an item to select the item.
● To “click on” or “select” an item means clicking on the button, menu bar option, or linked
item (e.g., a document or folder name).

How to Use this Book

This book is designed to help individuals with little-to-no technical experience learn the ePlanning
system and process. It can, however, be used by advanced or “Super Users” as a reference guide
to support their efforts to create planning and NEPA documents inside the ePlanning system. We
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strive to ensure the training material is presented in a logical format, as it is intended to lead
students through each stage of the NEPA document creation process. The structure of this book
and its chapters are described in the bullets below:

● Table of Contents – List all chapters, tables, examples, appendixes, and much more are
presented throughout the book.

● Inside each Chapter –

○ Introduction: Provides an overview of the upcoming material.

○ Objectives: Describes what knowledge, skills, and abilities students should learn and be
able to demonstrate upon lessons completion.

○ Example Boxes: List what tasks the student is expected to perform. Each example box is
followed by detailed instruction on how to accomplish a particular task.

○ Tip Boxes: Gives students recommendations for steps/practices that might aid them while
operating inside ePlanning.

○ Note Boxes: Provides users more detail about items or provides steps/actions necessary
to continue with subsequent exercises in the workbook.

○ Warning Boxes: Warns users of actions that could result in errors while using the
ePlanning system.

○ Supplemental Information: Provides information that is not covered in the three day
training, but could be useful and may be referenced by students later.

Additional ePlanning Resources

In addition to the information presented in this workbook, users have at their disposal a few other
helpful tools that can enhance their ability to use the ePlanning system. While our hope is that
system users experience little-to-no trouble, the reality is that a few will. With that said, we
encourage you to call upon us to assist you with any problems you encounter, from the simplest
to the most complex. The information that follows will tell you more about these additional
ePlanning resources.

First, there is the ePlanning Community of Practice (CoP) website. This area offers system users
a place to exchange ideas and concerns, gather reference materials (i.e. training slides/movies,
instructional manuals, etc.), and receive announcements about upcoming system improvements
and training dates. The CoP is extremely useful and we recommend users visit here first if they
have questions, as most can be answered quickly from this site. The ePlanning CoP website can
be accessed directly via this link: http://teamspace/sites-oc/eplanningcp/default.aspx.

Secondly, another additional resource users have is the ePlanning technical support team. System
users can contact technical support by submitting a remedy help desk ticket through the BLM
National Help Desk system. All user inquiries and concerns are responded to promptly by
the knowledgeable technical support team, which consist of system administrators, ePlanning
facilitators, and contractors.
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The third and final additional resource available to ePlanning users is Citrix Shadowing.
When users call the ePlanning technical support team for help, a team member may use Citrix
Shadowing as a tool to watch the user interact with the application and then lend assistance as
needed. Because Citrix Shadowing allows technical support team members to see precisely
the issues users are facing, it makes troubleshooting as well as explanation of a given problem
much easier. For those system users worried about the privacy of Citrix Shadowing, please do
not fright. While shadowing, ePlanning technical support team members can only see the user's
Citrix window and not their computer desktop. Feel free to utilize this and all the other resources
available to you. If you do, than you find the experience of using ePlanning much more enjoyable.

We are glad you are here and anticipate you having a great learning experience.
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1.1. Introduction

This chapter will serve as an introduction to ePlanning and will discuss the following:
● The definition of ePlanning and its intended use
● Navigating the NEPA and LUP Register
● The ePlanning application software, its related components, and features
● The benefits and efficiencies of utilizing ePlanning

1.1.1. Objective

The objective of this course is to provide users with a basic understanding of the ePlanning
software suite and its applicable uses for publishing NEPA and Planning documents.

1.1.2. Definition of ePlanning and Intended Use

Definition: ePlanning is a customized software application that allows for project/document
creation, document management, publication, and public commenting during the Land Use
Planning (LUP) and National Environment Policy Act (NEPA) processes. The application
includes functionality to manage the content in documents, publish the content to print (paper)
and web formats, create and enable documents for comments, and comment analysis.

Purpose: ePlanning is currently used by BLM employees and contractors to develop and publish
projects/documents that reach all levels of the BLM organization and the general public. ePlanning
has been primarily developed to support the BLM's NEPA and LUP processes with the intended
flexibility to eventually support other Department of the Interior (DOI) agencies and projects.

Uses for ePlanning include, but are not limited to the creation and publication of the following:
● Categorical Exclusions (CX) and Environmental Assessments (EA)
● Environmental Impact Statements (EIS)
● RMP revisions and amendments with associated NEPA documents
● Determination of NEPA Adequacy (DNA)

Goal:ePlanning facilitates a multi-disciplinary approach from planning development and
document management to publishing projects/documents on the web for public participation
and notification.

1.2. The ePlanning Software and Components

The ePlanning application software enables many planning processes, which include:
● Document, project, content and task management
● Authoring, reviewing, and publishing
● Comment analysis
● Web page creation and publication
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The ePlanning applications utilize and integrate a combination of commercial off-the-shelf
(COTS) software along with software that is custom coded (see below table).

ePlanning Software Suite
Software Applications Company Function
Documentum (Webtop) EMC2 Content Management

Arbortext Editor PTC XML Authoring/Publication
Adobe Acrobat Professional Adobe Document Reviews
Back Office & Front Office Custom Manage Project Websites and Comment Submissions

CommentWorks ICF International Comment Analysis

The applications are accessed through Citrix (see below image). The most commonly accessed
software applications in the ePlanning suite are:

● ePlanning Webtop (Documentum)

● Arbortext Editor

● Adobe Acrobat 9 Professional

● Back Office

Chapter 1 Introduction to ePlanning
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1.3. Benefits of Using ePlanning

Let's take a look at how ePlanning benefits you, your office, the BLM, and the general public.

Your Benefits:
● Easily incorporate all team members in the creation of project documents
● Easily assign tasks to co-workers who can work on the same documents simultaneously
● Know when your co-worker is editing a piece of the project's document
● Track accountability of documents and assigned tasks

Your Office Benefits:
● Easy to create web pages to host the document content and supporting information
● The creation of a centralized access point for templates and content reuse
● Tracking of document versions and incorporating comments into the final products
● Receiving comments online which will go to a centralized database
● All team members know the status of documents

The BLM Benefits
● Standardized look and feel to products across organizational boundaries
● Improved ability for State, District, and Field Offices to access and share searchable
documents and databases

● Consolidated and easy to find Bureau-wide NEPA and LUP registers

The General Public Benefits:
● Improved public outreach by creating more BLM transparency
● Being provided 24/7 access to documents on the Internet
● Ability to review and submit comments on document posted online
● Ability to see interactive map products for commenting

1.4. Navigating to NEPA and LUP Register

The following steps will show how to navigate to the nationwide NEPA and LUP registers.
This is where all projects are stored giving a centralized one stop shop for finding all NEPA
and LUP projects

1. Go to the home page of the BLM (www.blm.gov).
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2. Click on the “What We Do” link.
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3. Click on the “Planning” link.

4. Click on the “NEPA” link.
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5. Click on the “ePlanning NEPA Register” link.
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6. You are now sent to the consolidated NEPA and LUP registers. You have the opportunity to
choose between the NEPA or LUP register although, the opening page defaults to the NEPA
register. Users have the option to refine their search by state, office, document type, fiscal
year filed, program, and by open comment period.
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7. You can also click on the “Advanced Search” link and that will allow for a more specific
search.
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2.1. Introduction

This chapter will show you how to access and navigate through the ePlanning application.

2.1.1. Objectives

Upon completion of this chapter, you will be able to:
● Access and log into ePlanning
● Navigate through ePlanning Webtop
● Subscribe to Webtop objects
● Conduct a search
● Customize your ePlanning work space

2.2. Accessing ePlanning

In this section, you will learn how to access and log into ePlanning, including logging into the
Citrix XenApp Login Screen and the ePlanning Webtop application1.

ePlanning is accessed via Citrix. Citrix is software that enables centralized, web-based access to
software applications from virtually any type of hardware or operating system. You may already
work with Citrix-based applications, such as AFMSS or ArcGIS. Citrix is what enables ePlanning
to be an “enterprise” application that is centrally installed and managed, yet accessible to any user
within the BLM who has a web browser, an ePlanning account, and access to the BLM network.
You are required to log in and out of Citrix to access the ePlanning application. Once you have
logged into Citrix, you'll be required to login to the ePlanning Webtop application. Like most
BLM applications, in order to access ePlanning, you must work from within the BLM network
from BLM hardware.

By now, you have probably deduced that this means that you'll login to various applications in
order to work in ePlanning. The good news is that you don't need to create and remember a new
password. Citrix and ePlanning are linked to your BLM network login information, otherwise
known as the "Active Directory." Therefore, all you need to remember is your BLM network
password. Since we have linked your login information to your Active Directory account, each
time you change your BLM network password, the new password will be mirrored in Citrix
and ePlanning.

Example 2.1. Log In and Out of Citrix and the ePlanning Webtop

● Access and log into Citrix
● Access and log into ePlanning Webtop in the ePlanning Training Environment
● Log out of ePlanning Webtop
● Log out of Citrix

1Throughout this workbook, you'll see ePlanning referred to by several names, including "ePlanning," "ePlanning
Webtop," and "Webtop." For all practical purposes, they each mean the same thing.
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2.2.1. Access and Log into Citrix

Here are the step-by-step directions for accessing and logging into Citrix:
1. Open Internet Explorer from your desktop or from the Start menu.
2. In the browser address bar, enter the following URL: http://web.blm.gov/eplanning/

(Note: this is your portal to all things related to ePlanning so you may want to add it to your
Internet Explorer favorites for future reference).

3. The ePlanning home page appears (see below image):

4. Select the link “ePlanning Log-In” to the left of the web page. Clicking it will navigate you
to the Citrix Login Page (see below image):

5. In the User name field, type your BLM network user name.

Chapter 2 ePlanning Basics
Access and Log into Citrix January 1, 2013

http://web.blm.gov/eplanning/


ePlanning Training Manual and Reference
Guide

15

6. In the Password field, type your BLM network password.
7. In the Domain field, ensure that "BLM" is selected.
8. Click on the Log In button.

Note

If you see a Client File Security dialogue box (see image below), select "Full Access" and
"Never ask me again" and then click OK.

Note

You may also go directly to the Citrix login by typing in this address, https://
citrixnr.blm.doi.net/. Once there, you may save it as a favorite for easy access.

2.2.2. Log into ePlanning Webtop

Now that you have logged into Citrix, you will access and log into the ePlanning Webtop
application.

Here are the step-by-step directions for logging into the Citrix Metaframe:
1. In the Citrix XenApp application window, click on theMain link until you are in the highest

level (you will know you are in the highest level folder when only theMain link is available).

At this point, the contents of your Citrix MetaFrame application window should include
an ePlanning Folder, and for students in the course, a folder called ePlanning Training
Environment. For this training we will be working in the ePlanning Training Environment.
The Citrix MetaFrame application window may also include other programs such as
AFMSS and ArcGIS.
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2. Click on the folder for the ePlanning Training Environment. You will see the contents of
the ePlanning folder, which includes several icons representing various components of the
ePlanning application (see below image).

3. Click once on the Training ePlanning Webtop icon, located in the lower right of the
Applications window. (Note: The first time you login to ePlanning Webtop, it may take
several moments for the application to load.)

4. A BLM notification window will appear. Click OK.

5. The ePlanning Webtop Login screen appears (see below image).
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6. In the Login Name field, type your BLM Network user name.
7. In the Password field, type your BLM Network password.
8. In the Repository field, only “ePlanning_prod” should be an option (“ePlanning_prod” is

used for both the Training and Production environments).
9. Then click the Login button.

When your screen displays the ePlanning Webtop home page, you have successfully logged into
the application (see below image).
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2.3. Introduction to ePlanning Webtop

This section will introduce you to ePlanning Webtop, the hub of the ePlanning application, which
is a key software component of the ePlanning system. In essence, Webtop serves as a content
management system and it functions in some ways like your Microsoft Windows file management
system. As with Windows, you can update, upload, delete, and otherwise change document
files. ePlanning differs in that it is central to the whole Bureau and not state-centric. Because
ePlanning Webtop centralizes planning and NEPA information from the whole Bureau, you can
easily find planning and NEPA information from your colleagues all over the country. ePlanning
Webtop also enables:
● Content reuse
● Nationwide, searchable information
● The ability for more than one content author to simultaneously create and edit content in
parts of a larger document

● The ability to publish multiple document formats from the same source content
In order to help you get accustomed to this part of ePlanning, we will navigate around the
application to help you get acquainted with the look and feel of Webtop.
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2.3.1. The ePlanning Webtop Window

When you log into ePlanning Webtop, you should see a screen that looks like the one below:

2.3.1.1. ePlanning Menu and Tool Bars

ePlanning Webtop contains two sections at the top of the window, including the Search Bar, and
the ePlanning Menu Bar (see below image).
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2.3.1.2. The Navigation Pane and the Display Pane

The Webtop User Interface is comprised of two panes, the Navigation Pane and the Display Pane.

The Navigation Pane appears on the left of your screen. It displays a directory tree that shows the
ePlanning directory structure. The highest level in the directory structure is called a repository;
the top level of a repository consists of the different "nodes" that give you access to the different
items and functions. You will become more familiar with the various nodes throughout this course
and workbook, but they are summarized briefly in the table below.

Table 2.1. Summary of Webtop Nodes

Node Description

Home Cabinet Contains your personal documents and folders. Only you can see or access your
home cabinet. This is where you store personal documents.

Inbox Displays the tasks and notifications sent to you.
My Authoring Tasks Displays document and document section authoring assignments.

Recycle Bin Similar to your recycle bin on your Windows Desktop. Items you elect to delete
will be sent to your recycle bin before final deletion.

Subscriptions Displays the files and folders to which you want quick access.
My Files Displays the files you have recently created, edited or checked out.

Categories Categories is not an enabled feature of the application and will not be discussed in
this training workbook.

Cabinets Displays the highest level of organization in a repository. Cabinets hold folders
and files.

The Display Pane appears on the right of your screen; it displays the contents of the item selected
in the Navigation Pane. When you click on an item in the Navigation Pane, the contents of that
item will be displayed in the Display Pane. In the sample below, the State "CO" is selected in the
Navigation Pane and details of its contents, including four folders, appear in the Display Pane.

Chapter 2 ePlanning Basics
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Note

The Display Pane will look slightly different for different nodes. It will also look different if
you open the "Virtual Document Manager" by clicking on a virtual document. You will learn
more about the different Display Pane modes throughout this workbook.

2.3.1.3. Terms for Navigating to and Selecting Items in Webtop

When navigating in ePlanning Webtop, we will use the following terms to aid in navigation:

● Expand: To "expand" something in the Navigation Pane, you simply click on the plus (+)
symbol next to the item. Expanding in the Navigation Pane lets you see the contents of a
cabinet, folder, or document inside of the Navigation Pane, i.e., you will see those contents
inside of the Navigation Pane.

● Contract: To "contract" something in the Navigation Pane, click on the minus (-) symbol
next to the item. In doing so, it will remove from vision the contents of the cabinet, folder,
or document inside of the Navigation Pane.

● Right Click: Right clicking on an object in the display pane will display a context menu
(pop-up window) with various options to chose from. When you click on an item in the
Navigation Pane, it will appear highlighted in grey -- in the Navigation Pane -- with its
contents listed in the Display Pane.

In the image below, you can see examples of each of the navigation options listed above. You
can also see the organizational hierarchy of the ePlanning information repository. Notice that the
ePlanning Projects Cabinet contains folders for DOI and for BLM. Within BLM, it displays
cabinets for Center-based, National, or State projects. Within State Projects, you can find each
administrative state with BLM-managed land. For each of these administrative States, there are
cabinets for their District and Field offices.
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2.3.1.4. Breadcrumbs

In Webtop, "breadcrumbs" allow you to navigate quickly back to previous pages. They provide
links back to each previous folder you navigated through in order to get back to a former page.
Simply click on the link (linked items are underlined in the breadcrumb) to accomplish this.

Note

Be Aware of Using the Internet Explorer Back Button

If you use the Internet Explorer Back Button, be aware that this may cause errors or other
unanticipated outcomes. For example, when making a purchase online using your credit card,
hitting the back button will sometimes cause you to lose this information.. In ePlanning, hitting
the back button in the Internet Explorer browser can cause the same issue.

2.3.2. Cabinets

To learn more about navigation in ePlanning, we will work with a concept that may be new to
some ePlanning users, which is the concept of Cabinets. Much like your office cabinets for paper
records, ePlanning cabinets function as storage units for information. The ePlanning cabinets
are like a collection of several different filing cabinets. Some ePlanning cabinets include the
Asset Library and the ePlanning Projects Cabinet, containing folders of planning and NEPA
documents, organized by State, District and Field offices.

Example 2.2. Navigate to a NEPA Project in Your Office

Practice navigating through the Webtop cabinets to find a project in your office's Projects
cabinet. Expand the following: Cabinets, ePlanning Projects Cabinet, the DOI folder,
the BLM folder, and Click on State Projects. Folders corresponding to each state should
appear in your Display Pane.
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Note

If you do not see the folder that your are searching for in the Display Pane, your Webtop session
may be displaying only 10 items per page. You can paginate or change the number of items
displayed per page.

2.3.3. Subscriptions

In ePlanning Webtop, you can create "subscriptions" to projects, folders, and documents.
Subscriptions provide a quick way to navigate to projects or documents you are working
with. Items that you have subscribed to appear alphabetically in your Subscriptions node.
Subscriptions are different than "shortcuts" in Windows programs; a Windows shortcut is just a
link to an item, whereas items in your Webtop Subscriptions are actually the items themselves, and
not just a link. This allows you perform some commands by selecting the item in Subscriptions.

Example 2.3. Create a Subscription

Subscribe to the following folder and verify that it is displayed in your Subscriptions:

In the navigation pane located on the left side of the screen click on
Cabinets / Asset Library / Document Templates / Standard Templates
and highlight Standard Templates. This will show all of the contents of the
Standard Templates folder in the display pane on the right. Next, right click
on the Planning and NEPA Documents Templates and click subscribe.
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Here are the step-by-step directions to create a Subscription:
1. Right click on a folder or document to which you would like to subscribe.
2. Click on Subscribe, in the pop-up window.

2.3.4. Your Inbox

The ePlanning Inbox works a bit differently than other types of electronic inboxes. Most of us are
accustomed to an email inbox that contain messages from coworkers about projects, deadlines, or
other important information. While the ePlanning Inbox also contains important information
about your planning and NEPA related projects and work, it differs in its look and in the way that
it conveys information. Much of the information is automatically generated by the ePlanning
Workflow Manager.

Note

The workflow manager is like a giant, multifaceted checklist, which takes a whole RMP
process or NEPA project and tracks the project's progress as it passes through the major project
milestones. The workflow managers for each of the types of projects that will be utilized by
ePlanning (NEPA and RMP projects) have been crafted with the input of dozens of BLM subject
matter experts, ranging from NEPA and resource specialists, to RMP team leads.

You can access your Inbox by clicking on the Inbox node in your Navigation Pane. Your screen
will refresh to show the contents of your Inbox in the Display Pane (see below image). While
your Inbox may be empty at the moment, there are two types of items that can appear in your
Inbox, Notifications and Tasks.
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Notifications, represented by an icon with a red flag (see above image), are generated
automatically by the ePlanning application to let you know that a process has been completed,
or if there was a problem. You can read details of Notifications by clicking on the notification
title accompanying the flag. Your screen will refresh with more details about the notification.
Notifications can be deleted by double clicking on the item and then clicking the Delete button.

Tasks, represented by an icon with a notepad with a green check mark (see above image), are steps
from the various ePlanning workflows. Tasks are used to guide you through a business process,
such as an EA, EIS, RMP, etc. Unlike Notifications, Tasks can not simply be deleted. We will talk
in more depth about Tasks in subsequent chapters. (Tasks in your Inbox are related to the project
workflow and are different than Authoring Tasks, which are discussed in Chapter five).

In ePlanning, you check the item off by completing the task associated with it. To get started,
you would click on the Task in order to open up details of the item's contents. When you do so,
your screen will refresh to show a page with Task instructions and a set of buttons. Follow the
instructions given, which will indicate to the automated workflow in ePlanning that you have
completed the task and that the Task can be removed from your Inbox.

2.3.5. Webtop Search

ePlanning has search capabilities. Why would you want to conduct a search? You may be
interested in finding project documents that deal with certain topics or you may wish to find good
language to copy for a contentious section of your document. Because ePlanning has search
capabilities and it manages all of the Bureau's Planning and NEPA documents, you can find a
wealth of useful information and documentation.

Example 2.4. Conduct a Search

Conducting a search in ePlanning further expands your navigational skills. Take some time
to conduct your own simple search within ePlanning. Try searching for "Sage Grouse" or
"Grazing" or "Land Use Plan Conformance."
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You can perform a quick search for key words like you would in an internet search engine by
typing your search parameters into the Search field and then clicking theMagnifying Glass
button.

When you click on the Down Arrow button, the Advanced Search opens. This offers the ability
to limit the search to a specific location within the repository or other item properties, such as
Object type, Properties, Date, and Size.

To further define the intended search location, click on the Edit link to the right of the Location
options. The Change Search Sources form appears, allowing you to select specific locations
within the repository to confine the locations included in the search.

By clicking on the Search button at the bottom of the Advanced Search form, you initiate a
search based on the search criteria you have set. If an object matching the search criteria is
available, it is returned in the search results. If there is no object matching the search criteria,
the system will state that.

You can edit the search just performed by clicking the Edit Search link. You are returned to the
Advanced Search form, where all of the current search criteria are displayed. You may also save
the search. Click the Save Search link to name the search. View saved searches by clicking the
My Saved Searches tab of the Advanced Search form. You may choose to save searches and
share them with other users in the repository. Click the All Saved Searches tab to display your
saved searches and any saved searches that other users have marked for sharing with other users.

2.4. Customizing your Work Space

This section will help you customize your ePlanning Webtop work space, to include modifying
your Display Pane and setting some preferences in the application.

2.4.1. Modifying the Webtop Display Pane

You can modify the Display Pane to meet your needs. For example, you can change the number of
items displayed per page, as noted earlier. You can also change the relative size of the Navigation
and Display Panes by clicking on the bar that separates the two panes and dragging it to where
you like. Further options are discussed below.

2.4.1.1. Changing Column Display

Another way to customize ePlanning to fit your needs is to change the columns that are displayed
for each item in the Display Pane. In the example below, the ePlanning Inbox displays the
column headings Subject, From, Date Received, Due Date, Status and Repository. Different
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nodes in ePlanning have different column display options. The Cabinetsfor example, has
different column displays than the Inbox.

Here are the step-by-step directions for choosing which attributes are displayed:
1. In the Navigation Pane click on the Cabinets node> ePlanning Projects Cabinets and then

click on the DOI folder. The BLM folder will appear in the Display Pane. Click on the
Column Preferences icon circled in red (see below image).

2. On the Preferences form that opens, you can see the attributes that are already displayed on
the right-hand side, and any additional attributes you may select on the left-hand side. To
add an additional attribute, click on the attribute, then click the add button ( ). To remove
an attribute, select the attribute, then click the remove button ( ) As a best practice, we
advise that users select the following for their display preferences: Name, Title, Version,
Lock Owner, Creator, andModified (see below).
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3. You can also change the order in which the attributes are displayed by selecting an attribute

on the right-hand column and using the up ( ) or down ( ) buttons.
4. When you have finished selecting attributes, click OK at the bottom of your screen. You

will be returned to the screen from which you started the column selection and you will be
able to see any changes you have made in your column preferences (see below image).

2.4.2. Preferences

Webtop Preferences allow you to modify personal settings for the way Webtop looks and performs
certain actions. Some are superficial and only effect the colors scheme that you see in Webtop.
You can also modify the columns that are displayed for items displayed in different nodes. Other
settings are more profound and effect the way Webtop stores information and interacts with other
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applications that are part of ePlanning. This section describes some settings you may wish to use,
and also important settings that must be configured properly for ePlanning to function properly.

2.4.2.1. General - Theme and Subscription Logon Preference

Example 2.5. Change Webtop Theme

Spend a moment to explore the two themes and apply your preferred theme to your
Webtop screen.

Here are the step-by-step directions to change your Webtop theme:
1. Click on the Tools option in the ePlanning menu bar, then click on the Preferences option.

Note

When working with Preferences for the first time, the below image may appear. Select
"Always trust content from this publisher" and click Yes.

2. When the Preferences form appears, it will open to the General tab. Select a new theme
from the drop-down list for Theme.
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3. Click on the OK button in the lower right corner. The screen should refresh to display
your ePlanning Webtop with the new theme.

Example 2.6. Changing Login Screen to Open to the Subscription Folder

Spend a moment to change your login screen to open to the Subscription Folder:

1. Click on the Tools option in the ePlanning menu bar, then click on the Preferences option.
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Note

When working with Preferences for the first time, the below image may appear. Select
"Always trust content from this publisher" and click Yes.

2. When the Preferences form appears, it will open to the General tab. Select in the drop down
menu “Section to start in” Subscription.

3. Click on the OK button in the lower right corner. The next time you login to Webtop the
system will open to the Subscription folder.

2.5. Logging out of the ePlanning System

This section will guide you through logging out of bothWebtop as well as Citrix.
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2.5.1. Logging out of Webtop

Now that you have successfully logged into ePlanning, please log out of the system. To do so,
click on the Logout button in the upper right corner of the window (see below image).

After you have logged out of ePlanning Webtop, close the window.
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3.1. Introduction

This chapter will show you how to create a new NEPA project in ePlanning.

3.1.1. Objectives

Upon completion of this chapter, you will be able to:
● Create a new NEPA Project in ePlanning.
● Add/Edit information about the project.
● Provide access and define roles for people that will be working on the project.
● Understand how ePlanning project information is used throughout the ePlanning system.

3.2. Working with Projects in the ePlanning Webtop

Within the ePlanning system, the Project is an important "hub" for working on NEPA and
Land Use Planning projects. Information about the project (referred to as Project "properties,"
"attributes," or "metadata") can be entered once and is used throughout ePlanning to populate
project documents. Many of the ePlanning tools that help integrate the tasks of document
authoring, editing, reviewing, are accessible by working with the project in Webtop. An
ePlanning project also includes folders and sub-folders that help organize and store information
for the project.

Within the ePlanning project, you can:
● Record important information about the project, such as lead office, description of the
proposed action, applicant, and location. (the Background tab).

● Define the team of resource specialists who will be working on the document (the Team
Definition tab).

● Lay out a schedule and track the status of tasks (the Schedule tab).
● Identify any cooperating agencies and keep track of correspondence with them (the
Cooperating Agency tab).

● Identify funding sources (the Funding tab).
● Identify contractors (the Contracting tab).

The rest of this chapter will show how to create a new NEPA Project, add/edit project information,
and add new team members to the project.

3.3. Creating a New NEPA Project - the Background Tab

You can create and edit project information with a form that includes several tabs (Background,
Team Definition, etc.). For the first part of this exercise, we will create the new project with
minimal project information in the Background tab.

Example 3.1. Creating a New NEPA Project

● Select ePlanning > Project > New > NEPA Project.
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Here are the step-by-step directions for creating a new NEPA project:

1. In the Webtop menu bar, select ePlanning > Project > New > NEPA Project .

A New NEPA Project form is displayed in a new window (see below image).

Tip

When working in the above form (and all other forms in ePlanning), it is important to
begin at the top of the page and work your way down, as selections made in some boxes
will change the list of available options for other fields further down on the page. (The
screen will refresh after each field is populated.) Use the drop-down menus, Add or
Remove buttons, or enter text, as appropriate. Required items appear with a red asterisk
(*) or with the red text “Required field.” These required fields must be completed in order
to create the Project. There are some other fields that are not required to create a project,
but are important and used by other parts of the ePlanning system, as described below.
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2. Select the appropriate State(s) by clicking on the State name(s). You can select multiple
items by holding the Control key while clicking on items, or by adding them one at a
time. Click the Add button.

3. Select and Add the appropriate County(s).

4. Select and Add the appropriate Office Locations(s).

5. Select and Add the Lead Office.

6. Select the Project Type from the drop-down menu (see below image). For this exercise,
select "EA". The selected Project Type determines the type of NEPA document you are
creating (CX, DNA, EA, or EIS) and is used by the system when generating a NEPA
Number for the NEPA Register and setting up the directory where the project will reside.

7. Select the Document Templates you would like to use in your project by highlighting them
and then click the Add button. All templates you select will show up in the Document
Templates area on the immediate left.

8. Enter a unique Project Name (maximum of 32 characters) Note: do not add any special
characters to the project's name (i.e., Ampersand, Question Mark, Asterisks, etc.).

January 1, 2013
Chapter 3 Creating a New NEPA Project

Creating a New NEPA Project - the Background Tab



38 ePlanning Training Manual and
Reference Guide

9. Enter other project information (Project Description, Applicant Name, Project Location,
Acres for the Project Area, and BLM Acres for the Project Area). While these fields are
not required to create a project, they are available and information included can then be
used throughout the ePlanning application.

10. Select “Yes” for Land Use Plan Conformance (see below image).

11. Select a name, in the Name of Plan field.

12. Enter information and select values for other fields as you work your way down the form.
Again, the information is not required to create a project, but can be used throughout the
ePlanning application for various purposes. The following areas are searchable on the
ePlanning NEPA or Land Use Planning Registers (websites):
● Topical Issues(s) field is on the LUP Register Advanced Search form
● Special Interest(s) is on the NEPA Register Advanced Search form
● Program(s) field is on the NEPA Register homepage as a filter and is now a required field
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13. GPRA Goal(s) and NLCS Unit(s) fields are used internally by the BLM to help track
accomplishments supporting GPRA goals and activities occurring in NLCS units. Filter(s)
may be used for larger projects with public comments analyzed with CommentWorks,
part of the ePlanning application.

14. There is also a Notes field, at the bottom of the page. This is an area where you can
communicate other information about the project that may not be covered in the existing
fields on the Background tab. Notes may be typed directly into the text box.

15. TEAM DEFINITION: now we need to click on the Team Definition tab and make
ourselves the project’s Team Lead; also, we must add at least one team member and the
Public Affairs Officer to the project.

The Team Definition tab shows a summary of all team members working on a project, and
allows authorized users to add team members and edit the Team Role(s) of people working
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on the project. A user's Team Role on a project is part of the ePlanning security features1 and
dictates what user(s) can do on a given project. Users assigned the Team Role of Team Lead,
for example, can edit the Project and assign document authoring tasks. Authors can correct
and edit content to sections of the document to which they have been assigned. Editors can
add content or make edits to any part of the entire document. Only users assigned the User
Role of Public Affairs approves project websites that are published to the Internet.

16. ADD TEAM LEAD ROLES & PERMISSIONS: to edit your own team role(s) and
permission(s), highlight your name and click on the Edit button.

Warning

Do not delete the Project Creator permission the system assigned to you. If you do, you
will not be able to edit your project or you may encounter other problems.

By default the creator of the project is given the Project Creator role. If you are going to
be creating a project and will also be approving it for publishing you need to give yourself
the Public Affairs role as well as the Team Lead and Project Administrator roles. These
four roles are mandatory to creating a project and finishing a project by publishing to the
Front Office.

17. ADD IDT & PAO: to add a team member and the Public Affairs Officer to the project, click
the Add button (or add team members by Importing as an IDT Group from a past project
— see Supplemental Information for instructions). The Add Team Member form appears
(see below image).

18. Select the User Type from the drop-down menu. For this exercise, select "ePlanning System
User". The bullets below explain a little more about the different types of users:
● ePlanning System User – Includes persons with an active ePlanning system user
account.

● BLM Active Directory User – Includes BLM employees and contractors that have a
valid BLM Active Directory (Windows) account but not an ePlanning system user
account.

1ePlanning is a Permissions-based tool. What does that mean? It means that the permissions assigned to each ePlanning
user dictate the level of access they have to various pieces of the application. An RMP Team Lead may have access to
different functionality, for example, than does a Public Affairs Official, a Reviewer, or an Author. Each person who
works in ePlanning will have a specific user role or roles. If you are a NEPA specialist in your office, you may have the
role of P&EC. If you are a resource specialist who contributes to Planning and NEPA work, you may have the role of
an Author in ePlanning. Why are these user roles important? Defined user roles are key to ePlanning system security
because they enable different access to different content areas. See Table 3.1, “User Roles and Definitions” (p. 45) for
more information about ePlanning User Roles.
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● Non-BLM Active Directory User – Persons that are do not have a valid BLM Active
Directory (Windows) account nor an ePlanning system user account can be added as a
Team Member by selecting this option.

Note

If the user will be assigned authoring tasks, they must be an ePlanning System User.

19.
Click the User Chooser icon ( ). The User Chooser form appears (see below image).
The User Chooser helps by populating the Add Team Member form. (Information for
"Non-BLM Active Directory Users" must be entered manually).

20. Enter all or part of a known user’s name in the User/Group Name box and then click on
the Search button.

Note

If you leave all the search criteria fields blank and click the Search button, all ePlanning
users will be displayed.

21. Click Select next to the person you wish to add to the project's Team Definition tab. The
User Chooser form closes, and the Team Member Name and Email Address fields are
populated in the Team Member section.

22. Using the Add and Remove buttons, add Team Role(s) and Permission(s) for team
members (see below Supplemental Information for the ePlanning system’s hierarchy of
team member roles and permissions).

January 1, 2013
Chapter 3 Creating a New NEPA Project

Creating a New NEPA Project - the Background Tab



42 ePlanning Training Manual and
Reference Guide

23. Click Save on the Add Team Member form. The selected user is added to the Team
Definition form.

24. Repeat these steps to add more team members to the project .

25. Click Save on the Edit Project form.

26. When you have successfully added a team member your screen should similar to the one
below:
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Note

The Status field can be set at either "Active" or "Inactive". When a team member leaves a
project, their status can be set to "Inactive" so that a record of that former team member's
work on the project is retained. When a Team Member's status changes to "Inactive" there
is an option to transfer their tasks to another active team member.

27. Once team members have been added, click the Create button.

Tip

Subscribe To The Project!

You may want to create a Subscription and subscribe others to your newly created project
right away so that you or they can easily find it later! See Chapter 02 on how to create
subscriptions.

Note

Project Creators/Team Leads do not have permission to delete projects. If you need a
project deleted, submit a Help Desk ticket to ePlanning with the project number and the
reason for needing to the project deleted.

3.4. Editing a Project - The Team Definition Tab

Example 3.2. Editing a Project's Team Definition

Once a project has been created, the information initially added to the Background and Team
Definition tabs can be edited. This section will show how to edit a project.
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Warning

Do not delete any permissions the system assigns to you. If you do, you will not be able to edit
your project or you may encounter other problems.

1. Navigate to the Project's folder or, if you have created a Subscription to the Project, go to
the project through the Subscriptions node.

2. Left click on the menu bar and go to ePlanning > Project > Edit in the ePlanning Webtop
menu bar (see below image).

3. The Edit Project screen will open. Once open, go to whatever tab (i.e., Background, Team
Definition, etc.) add edit as needed.

3.5. User Roles and Permissions

General ePlanning users vary in their need for and interactions with the ePlanning software. A list
of the most commonly used ePlanning users is listed below.

Keep in mind that the ePlanning roles listed below are not indicative of team roles/titles within an
office. Different user types will require different levels of familiarity with the system.
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Table 3.1. User Roles and Definitions

ePlanning Role Description
NEPA Project Creator (or

Project Creator)
This ePlanning role is the initial role that is assigned automatically

to the individual creating a NEPA or LUP project.
Team Lead This role is responsible for project oversight and direction of both

the document content and the responsibilities of team members
on a project and approves the version of content (both textual

and spatial). Can access the Back Office.
Project Administrator This role is responsible for the organization and set-up of NEPA and

planning projects; creating or modifying projects and documents; assigning
metadata to projects and documents; defining and managing authorized
users within the ePlanning system. Cannot access the Back Office. The

Team Lead or P&EC often has this additional role added.
P&EC This role is responsible for the initial project setup for Land Use

Plans and/or NEPA projects.They also review NEPA documents for
compliance prior to sign-off by the Field Office Manager.

Public Affairs Official Specific reviewer responsible for reviewing content in Back Office
prior to it made available to the public.

Editor This role is responsible for editing, reviewing, and ensuring the quality
control of the entire document within ePlanning. The editor could also create
document appendices, glossaries, etc., prior to publishing and distribution.

Author This role is a team member (i.e. resource specialists, etc) who creates
content for planning and NEPA documents. These individuals have
access to only select sections of a document for which they have

been assigned (by the team lead, usually).
GIS Specialist This role is responsible for the creation, editing, and pub-

lishing of spatial content.
Reviewer This role is a team member who typically reviews the content of other

team members (peer reviews). They may be given read only access
to data, and use annotation services to provide input. If given the

additional editor role, these users could re-write content.

Data Entry The Data Entry person has a Back Office role that would enter submissions
or letters received outside of ePlanning into ePlanning.

ePlanning Specialist The primary Subject Matter Expert for a particular project within the
ePlanning application who is intended to serve as a technical expert on

all aspects of the application, and can carry out most functions.
Records Manager Manages records management functions including disposi-

tion and retention policies.

Field Office Manager This role is responsible for reviewing and signing off on
NEPA and planning documents.

District Office Manager The District Office Planner distributes and consolidates NEPA and planning
documents to specialists at the District Office-level for peer-to-peer review.

State Office Planner This role is responsible for shepherding documents through
the State Office review process.

Washington Office Planner During surnaming review, this role reviews the document and selects
additional reviewers based on their areas of specialty, if needed.
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3.6. Adding Team Members: Importing an IDT Group

When providing team members access to your project(s), you may desire to add an entire group
of individuals at once as opposed to adding members individually or separately. If that is the
case, then you're in luck. The import option that now appears on the Team Definition form,
gives project creators the ability to copy all of the team members from an existing project and
import those same team members into their new project. To do so, simply follow the instructions
outlined in the ensuing text.

Here are the step-by-step directions for selecting and importing an Interdisciplinary Team to
your project as a group:

1. To import an IDT team to the project as a group, click the Import button. The Import Team
Member form appears (see below image).

2. Choose the project you want to import/copy the team members from by selecting it from
the Lead Office Project drop down menu. Once a project is selected the screen will refresh
and list all of the IDT members for that project in the area below. Click on the ‘Import’
button at the bottom right corner of the screen to import these IDT members into your
new project (see below image).
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3. A warning message appears asking, “Are you sure you want to import the displayed team
members into the project team member list?” Click on the ‘Yes’ button (see below image).

4. The Team Definition page with the team members from the lead office project that haven’t
already been added to the new project will now appear. All team members added prior to
the import should still be in the page as well. All imported team members can be edited to
change their role(s) and discipline(s) and save to the created project just like team members
added to the project.

3.7. SUPPLEMENTAL INFORMATION

3.7.1. Additional Web Project Form Tabs

Though not covered in this course, the following describes the additional tabs in the Webtop
Project Form that can be utilized.

Cooperating Agencies

The Cooperating Agencies tab allows users to view a summary of all identified cooperating
agencies, add new cooperating agencies, to add or edit information about those agencies, and to
remove agencies from the project. The purpose of this page is to document official cooperating
agencies for the project and record responses and roles.

Funding
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The Funding tab allows users to view a summary of all identified funding sources, to add or edit
information about those sources, and to remove funding sources from the Project.

Contract

The Contract tab allows users to view a summary of all contractors selected to work on the
Project, to add or edit information about those contractors, and to remove contractors from the
Project. Different parts of the Project may be contracted to separate contractors. The Contract
tab allows the user to add the contact information for as many contractors as necessary.

Schedule

The Schedule tab allows users to view the project schedule information by project phase, to add
to or delete activities from the schedule, and to edit the schedule.
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4.1. Introduction

In this chapter you will become familiar with the “My Authoring Tasks” function and additional
Webtop tips of ePlanning. At this point, you have created the project and team members have
been assigned to the overall project. Before the Interdisciplinary Team (IDT) members can
actually jump in and start working, the next major steps in the process are to assign specific
sections of the documents to the team members and start the project workflow.

4.1.1. Objectives

This chapter will show you how to assign/acknowledge assigned tasks in ePlanning. Specifically,
it will coverMy Authoring Tasks and working with the Webtop content management system.
Upon completion of this chapter, you will be able to do the following:
● Explain the basic ideas behind Virtual Documents and XML Documents which will help
navigate through Arbortext and Webtop

● Assign specific sections of a document to IDT members
● Acknowledge authoring tasks
● Navigate to document sections you have been assigned fromMy Authoring Tasks
● Check Out and Edit a document or section of a document
● Check In a document or document section
● Export your project information into the newly copied template
● Copy a template from the Asset Library
● Begin and follow through a Project Workflow
● Work with Tasks and Notifications Messages within your ePlanning Inbox

4.2. Overview on Virtual Documents and XML Documents

Virtual Documents are a new concept for ePlanning users. Essentially, a virtual document allows
multiple contributors to add and modify content belonging to a single, large document structure.
One of the main benefits of virtual documents is the advantage of content re-use.

A Virtual Document is a container document that includes one or more components structured
in an outline format. A component is another virtual document or a simple document. Virtual
documents can have any number of components nested as far as you want it to go. A virtual
document is represented with the icon:

The smallest component of a virtual document is called a chunk and is represented as a XML
Document. In an outline format, this would be the final thought in that section (or subsection).

An XML Document is represented by this icon:

In the example below, an Environmental Assessment document is a virtual document made up of
other virtual documents, including an Introduction section, and a Proposed Action & Alternatives
section. In turn, each of these Virtual Documents is comprised of XML chunks, such as Purpose
and Need, and Conformance. These chunks are the smallest part of the document under which no
further sections exist.
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Tip

If you navigate deep into a project and view the Virtual Document Manager, as in the image
above, you will notice that the Webtop Nodes (i.e.: Inbox, Subscriptions, etc.) are no longer
present. You can get back to the normal Webtop view simply by utilizing the Breadcrumbs
feature to get back to more familiar territory.

Note

As you navigate further into the system, you may occasionally notice a key or lock icon next to
certain documents. The lock icon indicates that the virtual document is locked for editing by
someone else. The key icon will be present when you have the virtual document locked.

4.3. Assigning Document Authoring Tasks

At this point, the EA document is ready to have specific sections assigned to individual team
members. While the Inbox mainly provides information on the project's workflow, assigned
sections for a document are managed through task assignments.

When the Team Lead has delegated sections of an EA to team members, these document authoring
tasks will show up in the assigned user'sMy Authoring Tasks (and not the Inbox).

Note

Interdisciplinary team meetings are encouraged prior to starting a Project Workflow to share
information, coordinate involvement, and agree on scheduling and other expectations.

Pre-Conditions for assigning Authoring Tasks:

● A project must have been created and the desired authors must have been added to the
project's Team Definition form.

● Before the Team Lead can assign tasks, the desired document template must be in the
appropriate project folder.

4.3.1. Assigning Authoring Tasks

The Document Task Assignment form is both a task reporting and a task management interface
that is used by Team Leads to assign authoring tasks and obtain the status of a document that is in
development. The Team Lead can assign one or more authors to an authoring task.

When an author is assigned an authoring task for a document object (or section), the permissions
on the object are modified to provide the author with access to the item.
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Example 4.1. Assigning Sections to Team Members

● Navigate to the virtual document for the EA.
● Select ePlanning Document > Task Assignments from the Context Menu.
● Assign the sections to the members of your IDT.

Here are the step-by-step directions for assigning sections of a document to your team:
1. Navigate to the project's virtual document. The document is represented by the virtual

document icon ( )
2. Right-Click on the virtual document icon.
3. From the Context Menu, select ePlanning Document > Task Assignments. A Document

Task Assignments screen will appear.

The top half of this form contains filters that allow you to select documents from the various
projects on which you are working. There are other filters to select or display parts of the
single document by various authoring task criteria. The lower half of this form includes a
document map that shows the document and its sections and subsections in a tree view (see
below image). By examining the “Assigned To Status” column the Team Lead will be able
to see the status of the entire document. Assigned To Author: means the Task Assignment
has not been accepted yet. Authoring: means the Task Assignment has been accepted and is
in progress. Author Rejected Task: means the Task Assignment has been rejected. Submit
to Team Lead: means the Task Assignment has been completed.

4. You may select one or more document sections to assign from the document map. To select
multiple sections, simply hold down the shift button on your keyboard while choosing the
desired sections. You do not have to select each individual section because there is an option
to include subsections (or object descendants) in the authoring task assignments.
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5. Right click the highlighted area and select Assign Authoring Tasks listed in the Context
Menu. The Assign Document Authoring Task form appears (see below image).

6. Enter the appropriate information in the fields on the Assign Document Authoring Task form.
Specifically, select the individual(s) for the “Assign to Author(s)” section, set a due date,
and if needed check the box to assign the subsections also (see above image).

Required fields appear with a red asterisk (*).
7. Click the Finish button to complete the authoring task assignment. The Document Task

Assignments form appears, showing the assignment information in the Assigned To, Status,
and Due Date columns of the document map.

8. When finished, click the Save button in the Document Task Assignments form. No task
assignments are permanent until the Save button is pressed. When the authoring tasks are
saved, the system updates the document information and permissions accordingly, and the
selected authors will see the assigned sections in theirMy Authoring Tasks. They will
also receive an email in their Outlook email inbox notifying them that they have tasks
to accomplish.

Table 4.1. Field Descriptions on the Assign Document Authoring Task Form

Field Name Description Required
Field?

Document Section(s) This select list is populated with a list of all document sections that were
selected in the document map of the Document Task Assignment form,
before, the Assign Authoring Task button was clicked. When one or
more sections are selected in the list, the Remove button is enabled.

Yes

Remove Button This button allows the user to remove one or more selected document
sections from the Document Section(s) list.
This button is enabled when one or more rows are selected in the
Document Section(s) list.

N/A
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Field Name Description Required
Field?

Assign To Author(s) The user selects one or more team members from this list in order to
assign authoring tasks to those users. At least one team member must
be selected for the authoring task.
This list is pre-populated with a list of all team members in Active status.

Yes

Filter by Project Role The user selects a value from this list in order to filter the list of team
members in the Assign To Author(s) list. When a value is selected from
this list, the list of team members is updated to only include team members
that have the selected role on the Project team.

N/A

Filter by Discipline The user selects a value from this list in order to filter the list of team
members in the Assign To Author(s) select list. When a value is selected
from this list, the list of team members is updated to only include team
members that have the selected discipline on the Project team.

N/A

Due Date A text box in which the user specifies the due date for the authoring
tasks. The system will verify that all manually entered dates are valid.
Alternatively, the user may click on the Calendar icon to the right of
the text box to open a calendar date-chooser pop-up window. The date
selected in the calendar pop-up window automatically populates the Due
Date field.

Yes

Assign Authoring
Tasks to Subsections

Selecting this check box assigns authoring tasks to the selected authors for
the subsections of the selected sections of the document.

No

Assignment Note A text box allowing the user to specify editorial notes for the task. No

4.4. My Authoring Tasks

My Authoring Tasks shows you projects to which you have been assigned a Team Role1 For each
project, this node shows you the section(s) of the document(s) that the Team Lead has assigned to
you. TheMy Authoring Tasks node also allows you work with your authoring tasks, including
acknowledging them (so that the Team Lead knows that you are aware of the task), navigating to
the document (where you can check it out from the content management system for authoring and
editing), create review packages, and submit your completed assignments to the Team Lead.

4.4.1. Acknowledging Authoring Tasks

The first step in working with your project's documents is acknowledging the authoring tasks.
Acknowledging the task assigned to you lets the Team Lead know that you have accepted the task
and allows you to check out that document's section out for editing.

Example 4.2. Acknowledging My Authoring Tasks

● Click onMy Authoring Tasks and select the project and document you created in
Chapters 3 and 4.

● Select a document section by highlighting and right clicking on the section(s).
● Then, click on Acknowledge Task.

Here are the step-by-step instructions for acknowledging a task:
1. Click onMy Authoring Tasks in the Navigation Pane.

1For more information on Team Roles, see Chapter 3, Creating a New NEPA Project.
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2. In the Display Pane, click on Filter by Project (see below) and choose the project you
created. The lower section of the Display Pane will show the documents or document
sections that have been assigned to you. The new authoring tasks have a red flag icon
( ) displayed in a column on the far right.

3. Select the appropriate type of document with the Filter by Document drop-down list (for
this exercise, choose Environmental Assessment).

4. Highlight one or more of the tasks assigned to you (see below).
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5. You will notice when you right click on highlighted sections that other options are enabled.
Select the Acknowledge Task option. Your screen will refresh and the red flags will
disappear. Acknowledging the task(s) will register in the application that you have accepted
the task and will work on it.

Be sure you pay attention to selecting one or more tasks. For example, if you highlight
one task, you are given different options compared to highlighting two or more tasks.

A Note About Notes...

The list of document sections in theMy Authoring Tasks node includes a column for Notes.
These notes can be used to share information between team members sent to you by your Team
Lead. When there are no notes a blank notepad icon ( ) will be displayed; when there are notes
a notepad icon with lines on it ( ) will appear.

4.4.2. Other Functions in My Authoring Tasks

Return to theMy Authoring Tasks in the Navigation Pane and, notice the additional options
available. We have discussed Acknowledge Task and Navigate to Object. Several other options
become enabled when checking the box next to a document assignment. They are:
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Create Peer Review: An author may want to have their document or document sections
reviewed by peers in their field or counterparts at other agency organizational levels. These
reviews are usually not formal (no formal approvals are required) and improve communication
and collaboration on the contents of the document. This option will be covered in more detail in
this book later.

View Object History: This button will take the user to a screen that highlights the version, task
assignment, and peer review history information for that particular document object. This button
is only enabled when a single section of the document has been selected from the document map.

Reject Task: This should be selected when a task is mistakenly assigned to a user.

4.4.3. Navigating to an Object from My Authoring Tasks

My Authoring Tasks provides a method to navigate through the Projects Cabinet directly to
the parts of the document you are assigned.

Example 4.3. Navigating to an Object

Using the instructions below, you will navigate to a document section assigned to you
found in My Authoring Tasks.

Here are the step-by-step directions for navigating to a document section assigned to you found
in My Authoring Tasks:
1. InMy Authoring Tasks, highlight a single document section (you may not simultaneously

navigate to two objects).
2. Right click on the highlighted section and then click on the Navigate to Object option.

Your screen will refresh to show the virtual document or XML document for the assigned
task in the Display Pane. The Display Pane may also contain folders icons that represent
chapters or sections of that document.
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Note

Clicking on Navigate to Object is only one method to locate the document object assigned to
you. You can also navigate to the section using your Subscriptions, or by drilling down through
the ePlanning Projects Cabinet.

4.5. Working with Documents from Webtop

Webtop is a content management system which is used to keep track of all of the document
versions. While the content management system allows for multiple authors to work on different
sections of a document at the same time, multiple users can not edit the same section of a
document at the same time. To ensure that versions are accurate, a section can not be edited
simultaneously by multiple authors. A document section must be checked out from the content
management system before any edits can be made. Only the person who has checked it out can
make edits. Other people will not be able to make edits on an object that is checked out by
someone else. They may open the document in “read only” mode.

ePlanning Commands:

● Check Out: Checks out and locks the selected document and related descendents, or
subsections out of the content management system and stores them in the user's "Checkout"
folder on the Citrix server. Checking out an item also locks an item and prevents other users
from making any edits. (Other users can still view checked out items in read only mode.) An
item must be checked out before it can be edited.

● Edit: Performs the same functions as “Check Out”, and opens the document in Arbortext
Editor.

● Check In: Uploads the selected document and subsections back into the repository and
unlocks them so that other users can edit them. If you do not check in a document, your
changes will not be recorded in the repository and other users will be unable to make edits to
your.

● Cancel Checkout: Releases the lock on a document and cancels the checkout without
uploading any edits or changes that may have been made to the document in the user's
Checkout folder. Added or changed information will be lost. When you cancel a checkout
on a document that has descendents, you will be provided with two options (1) to cancel the
checkout for the "Virtual Document and all Descendants" or (2) "Only the Virtual Document".
It is recommended to choose "Virtual Document and all Descendants." Otherwise, you may
think the checkout was cancelled entirely even though there will still be descendent objects
that are locked and inaccessible to other users.

● Add to Clipboard: Copies the item(s). This function is useful to copy a document from
another project. You can view your clipboard by selecting Edit > View clipboard.
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4.5.1. Check Out a Document for Editing

Example 4.4. Check Out a Document for Editing

Highlight the virtual document section and right click on it to pull up the Context Menu,
from there select the Edit option.

Here are the step-by step instructions to check out an item for editing:
1. FromMy Authoring Tasks select the project you want to edit from the Filter by Project

drop-down.
2. Highlight the virtual document section, right click on the highlighted area (be careful not to

select the link underlined or you will see a status check mark appear) and select Navigate to
Object option (see below).

3. Once you have navigated to your virtual document section, right click on it, and select
the Edit option.
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4. If the object that you have selected has descendent objects, a dialog box will appear that
gives you options on whether you want to check out "All, root and descendents," "Root with
read-only descendents," or "Root only" (see below). For this exercise, leave it on the default
"All, root and descendents" and click OK. This will ensure that any of the subsections that
may have been included in your authoring task will also come with the root section and that
you will be able to edit them (if the object you selected does not have any descendent
objects, it will be opened in the application for editing).

5. The selected objects will open in Arbortext Editor.
6. Make some edits to the text of the document you have opened (for this exercise, make only

a minor edit). More information on how to use Arbortext Editor is presented in Chapter 6,
Introduction to Arbortext Editor.

7. Do a completeness check by clicking on the button that looks like this ( ).
8. At this point you should have no errors found appear at the bottom left of your screen.
9. Save the document in Arbortext Editor.
10. Close the Arbortext Editor window.
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Note

Look at the Webtop Display Pane: a key icon ( ) should be next to the document you checked
out. The key icon indicates that you have the item checked out. If another user has an item
checked out, you will see the lock icon ( ) .

4.5.2. Checking In a Document

After you have finished editing, you must check the document back into Webtop to upload any
changes that you have made. You must check in your document so other team members can view
your edits. Checking in the document also unlocks it so that other users may make edits.

Example 4.5. Checking In a Document

Select the document or document section you have just checked out by highlighting it
and now right click and select check in.

Important

Make sure that you have saved and have done a Check Completeness on your document!

Also, ensure you have closed the Arbortext Editor window of your document before checking
in your document; because, if you leave the document open and try to check it in, you will
encounter issues with the version of your document down the road!

Here are the step-by-step instructions on how to Check In a document:
1. Highlight the virtual document.
2. Right click on the highlighted document.
3. Click on the Check In option. The Check In screen will appear (see below).
4. You will be prompted to choose a version for your document. You may not overwrite the

previous copy with "Same Version," (this selection is greyed out) but you may track the
content changes by choosing either "Minor Version" or "Major Version".
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5. If desired, enter information in the Version label. The version label will be displayed in the
Version column next to the document object when viewing the object in the in the Webtop
Display Pane. The version label can only be up to 32 characters. If you would like to
add more detail, use the Description field.

6. Click the OK button in the lower right hand side of the window.

Note

Your screen will refresh to show the document section with no key, indicating that it is no
longer checked out.

Tip

Always make sure your document or section is checked in at the end of the day so that others
can work with the document!

When you have finished adding and editing the virtual document's content, you may submit it to
the project Team Lead to let them know the task has been completed. Once a section has been
submitted to the Team Lead, you no longer have authoring privileges to that section. Submit to
Team Lead: by highlighting and right-clicking on the section(s) and selecting this option from the
context menu. The status of the selected section(s) will be removed fromMy Authoring Tasks.
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4.6. Export Project Info to Document

Now that the template has been copied into your project folder, there is a feature that allows for
users to re-use content entered in the background tab (when the project was created) and copies it
directly into the document template that is going to be used. This is performed through the
“Export Info to Document” feature.

The best way of further describing this step is that it is akin to a copy and paste operation for
certain components of a document. Instead of entering information (such as name, office location,
project description, acreage, etc) repeatedly over multiple documents, that information is entered
once into Webtop and the changes can be propagated throughout your ePlanning documents.
Ultimately, this will save users a little bit of time, as some of the basics in the document will
be filled in already.

Note

The information transfer from Webtop to Arbortext is a "one-way street". That is to say, if
information is edited in the document, it does not automatically update the corresponding
properties in the ePlanning Webtop Project.

When the information is exported, the processing instructions in the document are overwritten
with the values of the project attributes. Thereafter, the document must be edited manually or,
processing instructions "re-added" to the document (which is beyond the scope of this course).

Example 4.6. Export the Project Information into the EA Document

● Navigate to the project folder and right-click on it to call forth the Context Menu.
Select the Properties option from the Context Menu.

● Type in “EA_Document” in the field titled EPL Project Export Document Type .
● Right-click on the project folder and select the ePlanning project > Export Info to
Document option from the Context Menu.

Here are the step-by-step directions for exporting the information to the EA document:

1. Navigate to the project folder and right-click on it to bring up the Context Menu. Select the
Properties option from the Context Menu (See image below).

2. When the Properties form is displayed, scroll down to the very bottom of this screen and
look for the field titled EPL Project Export Document Type.

3. Type in “EA_Document” in this field and when you're finished close the Properties menu.
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4. Next, navigate to project folder again and right-click on it.
5. Select ePlanning Project > Export Info to Document from the Context Menu.

Note

The easiest way to find other EPL Document Types is by navigating to the template folder
located at Cabinets / Asset Library / Document Templates / Standard Templates / Planning
and NEPA Documents Templates.

In this folder, there is a Microsoft Excel file titled “EPL Workflow Details.xls”, which can be
opened by clicking on the name of the file.

4.7. Advanced Webtop Features

This section will further delve into Webtop and functions that will be of assistance to more
advanced users. Users should have a general understanding of Webtop before attempting to
perform the procedures covered in this section.
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4.7.1. Objectives

Upon completion of this section, participants should be able to use Webtop to:
● Practice and demonstrate understanding of Webtop basics, which include:

○ Navigating to the L drive (where ePlanning files for users reside)
○ Accessing additional mapped drives
○ Clearing the clipboard

● Maintain project status
● Work with additional feature of workflows
● Archive a virtual document

4.7.2. The L Drive

The L drive contains the ePlanning files, maps, graphics, and GIS data for projects that you may
be working on in the ePlanning system. For ePlanning on Citrix, the L drive is similar to your
U drive. It is important to know how to access the L drive since this is where your working
files are stored.

Example 4.7. Access Your L drive

Navigate to your L drive (via Webtop).

Here are the directions for how to access the L drive:

1. From within Webtop, open the File menu from the Internet Explorer browser and select
Open (or use the Ctrl + O shortcut).
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2. Type in L: and click OK.

3. A window will open in Windows Explorer. There will be four folders in that window.

The main one that most users will find useful in the DocuTemp folder. The DocuTemp
folder contains everyone's working files. Double-click on the DocuTemp folder and you will
see folders for all ePlanning users.
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Double-click on your folder (i.e. uhong). A Documentum folder will be displayed.

Double-click on the Documentum folder. You will see the following folders (as well as
some miscellaneous files):
● Checkout
● Export
● Logs
● Temp
● ucf
● Viewed
● XML Applications

The purpose of these folders is explained a little further in the Table 2.1 (below).

Table 4.2. L Drive Folders

Folder Name Purpose
Checkout When you open a document for editing, the document is

downloaded to your checkout folder. All objects contained
in the document are also downloaded. If you run a Compose
from Arbortext, and you use the default location for the PDF
file, the file will be located here.

Export This folder does not have a specified use. You can add any
files to this folder.

Logs The system uses this folder to log what you are doing. Do
not modify anything in the directory!

Temp This folder does not have a specified use. You can add any
files to this folder.

ucf The Documentum Unified Client Facilities folder allows
for check-in of content. Do not modify anything in the
directory!

Viewed When a file is opened in the read-only mode (not
check-out/edit mode), the file will be located here. The
system never cleans this folder out. If there are lots of
documents viewed in read-only mode, then it would be
good to periodically delete some of the files in this folder to
mitigate network performance issues.

XML Applications This folder contains the XML application configuration file,
which defines the rules for processing XML. Do not modify
anything in the directory!
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4.7.2.1. Cleaning Up Your L Drive

Now that you are familiar with the folders structure on the L drive, you may need to do some
clean-up on these folders. Sometimes, not all of the documents are removed from the Checkout
folder after checking in the document. It might be a good idea to review and delete extra files
from the checkout folder.

Warning

Since you are not forced to check-in a document when you close Arbortext Editor, you must
be very careful about deleting files in the Checkout folder.

You can always make a backup copy of the file(s) and put it in the Temp folder.

If you are uncertain about moving or deleting files from these folders, contact the
ePlanning team for assistance.

PDF files that are created as a result of compose or print preview in Arbortext are usually not
deleted automatically. So, if it is located in the Checkout folder, it should be okay to delete the
PDF files.. These files (in the Checkout folder) are not part of the administrative record for
a project.

Every time you open a document as a read-only file, a copy of that file is put in your Viewed
folder. This does include any type of document that you may have added to your project library
(Word documents, spreadsheets, etc.). Every once in a while, it would be a good idea to delete the
files in the Viewed folder.

Example 4.8. Clean Up Your L Drive Folders

Take a few minutes to explore the contents of the folders in your L drive in ePlanning.
These questions may help you explore those folders.
1. Is there anything in your Checkout folder?
2. Is there anything in your Viewed folder?
3. Make a backup of one of your files in the Checkout folder, if you have one and

copy it into the Temp folder.

4.7.2.2. Access Your Mapped Drives

If you have important files on your office’s shared drive and you would like to bring those files
into Webtop, you can manually navigate to those drives.

Tip

Though the menu option differs slightly, this could also be performed from within Arbortext,
when inserting images and figures.
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Example 4.9. Find Additional Drives

Take a few minutes to explore additional drives that you may have access to. Import
a file into the GIS folder of your project.

Here are the directions for accessing additional drives in your profile:
1. From within Webtop, open the GIS folder of your project. This should be empty. Select the

File menu and choose the Import option.

2. In the new Import window, select either the Add Files button or the Add Folders button. In
the subsequent “Select File” window that appears, click on “My Network Places” on the
left hand side of the menu.
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3. Double-click on “Entire Network”.
4. Double-click on “Citrix Client Network”.
5. Double-click on “ICA-tcp#XXX (Client)”. The title of this network will vary.
6. A list of the mapped drives you normally have available on your desktop will now be

displayed. Double-click on the drive you are looking for.

7. Navigate to the file (or folder) as you normally would to complete that Import process.
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4.7.3. Clearing the Clipboard in Webtop

In Webtop, the process of copying templates is now automated for new projects. Though, copying
and pasting templates manually is still a function that is available within the ePlanning system.

Copying and pasting documents within Webtop is a relatively fast process, but in one continuous
session of Webtop, there is a risk of copying and pasting multiple documents into a specific
location. This occurs because the clipboard that is used in Webtop does not automatically clear (or
overwrite the previously copied file) until you logout or become timed-out of your Webtop session.

To prevent multiple documents from being inadvertently pasted, it is always recommended
that you check and clear the document that is not needed on the clipboard in Webtop before
completing a paste function.

Example 4.10. Check (and Clear) the Clipboard in Webtop

Double-check the clipboard in Webtop and remove all unnecessary files that are not needed.

Here are the directions for clearing the clipboard in Webtop:

1. From the ePlanning Menu Bar, click on the Edit button and then select the View Clipboard
option (see image below).

2. If you have previously copied documents, you will now be able to view them on the new
window that appears (see image below).

Chapter 4 Assigning–Acknowleging Authoring Tasks,
Advanced Webtop & Workflows
Clearing the Clipboard in Webtop January 1, 2013



ePlanning Training Manual and Reference
Guide

73

3. Note: For your project, you may not have two or more documents on your clipboard. If
that is the case, do not worry, simply follow the instructions to remove the single document
that appears for you.

In this example, there are two items in the clipboard, so we are going to practice removing
one of these documents. If we attempt to paste from the clipboard to a folder (without
removing the two files in this example), then we would be pasting both template documents
into the desired location. Highlighting one of these files and clicking the Remove link above
is how we will get rid of the unwanted item. After doing so, you will notice that the only
item left on the clipboard is the one document that we didn’t select to remove.

4. Click on the Close button to close the clipboard. From here, the paste command will only
copy over that one specific template into the folder you have chosen.

4.7.4. Maintaining Project Status

All projects in ePlanning have a status associated with them. In the introductory course for
ePlanning, as you were creating the EA project in training, the status for the project was set to
“Active”. However, when projects (especially NEPA projects) are signed and are essentially
completed, the project status needs to be updated.

Important

Remember that the status of projects are also displayed in the NEPA and LUP Register and on
the project websites. So, it is very important to remember to keep the project status up-to-date.
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The table below gives some more details regarding the available status options, and what results
in the My Authoring Tasks node, if certain status options are chosen.

Table 4.3. Available Project Statuses

Status Definition Removed from My
Authoring Tasks

Preparation For RMPs and some EISs, when you know you are going
to start one and need to create the web page to put it into
the Federal Register, instead of using an email address for
comments.

No

Active Currently conducting analysis, no decision of any type. No
Draft Working on the draft stage of a project. No
ROD After the ROD is signed. No
Scoping Used while conducting scoping. Most likely, there will be a

comment period open while a project has the Scoping status.
No

Closed Used when a project has been cancelled. A project can only be
deleted when it has a project status of “Closed”.

Yes

Completed NEPA analysis completed. No appeals implemented. Yes
Decision Record The Decision Record has been signed. Yes
Deferred The project proposal has been shelved for the time being. Yes
Evaluation For RMPs, when going through a evaluation. Yes
Proposed Typically, used for third party NEPA work, when you want

to enter the project in the NEPA log and are waiting for the
work to start.

Yes

Rejected Denied the proposed action. Considered the action and the
authorizing official’s decision was to reject it.

Yes

Withdrawn The applicant withdrew the proposed action. Yes
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Example 4.11. Modify the Project Status Options in Webtop

Take a few minutes to explore the choices available to you for setting the project status in
Webtop. At this point in this course, we’ll just stay focused in the Webtop application,
but the directions below will show how a change in Webtop will update the project status
in Back Office also.

Here are the directions for modifying the project status:

1. Highlight a project and right-click it to open the context menu. Choose Edit under the
ePlanning Project sub-menu.

2. Assuming the status of the project has been completed, change the Project Status menu to
“Completed”.
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3. Move down this screen and add the Decision Date. This would be the date that the
authorizing official signed the decision document. Click the Save button when ready.

4. At this point, jump into Back Office. Find the project in the NEPA or LUP Register.

5. Check the box to the left of the project number. Click the Refresh link up near the top,
which will update the Project Status column within the NEPA or LUP Register.
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6. A pop-up window similar to the image below will notify you that the update was successful.

Since many projects are now loaded onto the NEPA and LUP Registers for ePlanning, it will be
very important to keep the project statuses updated for public knowledge and transparency.

4.7.5. Copying and Pasting a Template from the Asset Library

The Asset Library is a cabinet located in the ePlanning system that is used to store document
templates, content examples, and frequently used items such as glossaries, lists of acronyms,
and other documents for the BLM.

Example 4.12. Copy and Paste a Template (EA for example)

● Navigate to the Asset Library and copy the EA template.
● Navigate to your project folder and click open the EA Document folder.
● Paste the EA template into the EA Document folder.
● Go to the Inbox node and check for the “Document Copy Results” notification.

Here are the step-by-step directions for copying a template into your project folder:
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1. In the Navigation Pane, expand the following folders: Cabinets / Asset Library / Document
Templates / Standard Templates / Planning and NEPA Documents Templates.

If you subscribed to the Planning and NEPA Documents Templates folder as described in
Chapter 2, you can open this folder up through the Subscriptions node.

2. Navigate to the location of the NEPA document template specified in the workflow task
item. For this exercise, you will navigate into the folder for EA.

3. Right-click on the Environmental Assessment virtual document template to call forth the
Context Menu (See below image). Make sure to select the EA virtual document template,
not the folder!

4. Copy the virtual document template by selecting the Add to Clipboard option from the
Context Menu.

5. Now, navigate to your project in Webtop. You can navigate to the project folder in three
different ways:

a. If you created a subscription to the folder, you can open the project folder by just
clicking on the project name from Subscriptions.

b. The task in your Inbox includes a link to the project folder on the bottom half of the
display pane. Clicking on that link will take you to the project folder.

c. You can navigate to the project, manually, by drilling down into the Cabinets. This is
just an example of the path you can follow to get to a project in Colorado: Cabinets /
ePlanning Project Cabinets / DOI / BLM / State Projects / CO / Front Range DO /
NEPA / 2010 / <your project>.

6. Click on the folder that you would like the EA template copied into. For this exercise,
click on the folder called EA Document.
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Tip

Check your clipboard!

If you have to work with other templates in a project (or more specifically, if you are
copying and pasting multiple templates without logging out of a Webtop session), you
should check your Webtop clipboard often.

To check your clipboard, go to the Webtop menu bar and select Edit > View Clipboard.
It will be greyed out, if there are no templates on the clipboard. If there are multiple
templates, select the template that you wish to remove by checking the box to the left
and clicking on the Remove link located above the listed templates. You can now paste
the current template to the target folder.

7. Paste the template into the folder by selecting Edit > Paste from the ePlanning menu bar.
As you can see from the image below, the document is being pasted into the empty folder.

8. A “Document Copy Notification” window will appear stating that the operation is in
progress and a notification will be sent to your Inbox. Click the OK button.

4.7.6. Miscellaneous Advanced Webtop Information

The following supplemental information is provided for your convenience, but will not be used
for exercises in the class. This information is intended to assist you as you work on even more
advanced concepts in Webtop.

4.7.6.1. Printing

The best way to print a document from within ePlanning is to save a copy to your local system
and then print to your local printer (outside of ePlanning).

While working with your document in Arbortext, perform the Compose PDF function. The file
opens in Adobe Acrobat Professional. In Adobe Pro, choose the File menu and select Save As.
When the Save As window pops up, select a place on your local desktop or preferred location
to save the file (see image below).
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Open the file from your local desktop and you may print the file to any of printer in your office’s
network.

Tip

When attempting to print a document that has been built (or composed) within ePlanning,
remember to rename the file when you save it to your local desktop. For example, the default
name for a built PDF will be” DfBIFetchPDF.pdf”. This might be better recognized to you or
others, if it was renamed.

4.7.6.2. Archive a Virtual Document

Once a document has been signed, you may not want any additional changes made to that
document. To ensure that there is a version of a document that stays unmodified after a critical
point in the planning process, there is the option to take a “snapshot” of the document. Documents
that have had a snapshot taken would then be ‘frozen’ to further ensure that an archived version of
a document exists. This will prevent additional changes or modifications from being made to a
specific version of that document.

This could be practical, for example, when a ROD or an ARMP is in process and the document
could be frozen and unfrozen, as needed.
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Note

For clarification, note that the archive feature described here is not the same as official records
archiving.

Example 4.13. Archiving a Document

Using a training project you have created, archive a document within there using the steps
outlined below. Make sure to ‘freeze’ your snapshot.

Archiving a document essentially involves three major steps which are described further below.
In short, the three steps for archiving a document include:

1. Applying a version label for the virtual document.

2. Creating a snapshot of the document.

3. Freezing (and unfreezing) a document.

4.7.6.2.1. Apply a Version Label for the Virtual Document

The first step in the archiving process is to set a label for the frozen version. Keep in mind,
that after performing this first step that you will have to finish the remaining two step in order
to complete the archive procedure.

Here are the directions for setting the version label for a document:

1. Navigate to the virtual document and highlight it to select it.

2. Right-click to open the context menu and select Virtual Document > Modify Version
Labels.
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3. A version label window will appear (see image below). Enter a version label and check the
box to apply the label to all descendants in the document (optional).

4. Click the OK button at the bottom of the screen to continue onto archiving or taking a
snapshot of the document.
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4.7.6.2.2. Create a Snapshot of the Document

The second step of the archiving process is to create a snapshot of the document.

Here are the directions for archiving the document:

1. Highlight the virtual document by clicking on it.

2. Right-click to open the context menu and select Virtual Document > New Snapshot.

3. A Create Snapshot window will appear. Follow the steps below:

a. Enter a Name for the snapshot.

b. Change the Type field to “EPL Document (epl_doc)”.

c. Enter a brief description in the Description field (optional).

d. Leave the Location in Repository field as is. There is no need to change the location
here.

e. By default, the Freeze Snapshot box should be checked (see image below). Leave
this checked as well. By freezing the snapshot, you ensure that the frozen version of
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the document (and frozen version of each descendant) cannot be changed without
creating a new version.

4. Go ahead and click the Finish button down below. (Hitting “Next” would move you to the
next two tab where you could add for information, this is optional).

An ‘archive’ of that virtual document has now been created.

Note

Take a close look at the icons for these two documents. The snapshot virtual document icon is
slightly different ( ) from the regular virtual document icon ( ).

4.7.6.2.3. Freeze and Unfreeze a Snapshot

Once the snapshot has been taken, you can ‘freeze’ (to archive) that snapshot file.

Here are the directions to freeze this snapshot:

1. Highlight the snapshot file by clicking on it.
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2. Right-click to open the context menu and select Virtual Documents > Freeze Snapshot.

Freezing a snapshot blocks users from editing the frozen version of the document (or
the frozen version of each descendant). Any changes a user makes to the document or a
descendant can be saved only as a new version of the document (or descendant). This is
the icon for a frozen virtual document, ( )

If you’re ready to resume work on a frozen document, you can ‘unfreeze’ that file.

1. Highlight the virtual document by clicking on it.

2. Right-click to open the context menu and select Virtual Documents > Unfreeze Snapshot.

Unfreezing a snapshot lets users edit the document (and descendants) without additional
versioning.

Important

If a descendant is part of multiple frozen snapshots, then you must unfreeze all the
snapshots to edit the descendant.

4.7.6.2.4. View a List of Snapshots

You have the option to view all snapshots for a virtual document.

Here are the directions to view your snapshots:

1. Highlight the virtual document by clicking on it.

2. Right-click to open the context menu and select View > Snapshots.
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4.8. Project Workflows

Workflows are a way to organize and automate manual work processes in an automated format. In
ePlanning, the workflows guide a user through an EA project in a step-by-step process reminding
the user to complete certain tasks. Keep in mind that in ePlanning, the workflows will vary
slightly according to the type of project that was created.

Once a workflow has been initiated, the system will begin to send tasks and notifications to the
Inbox. The messages will differ depending on the specific role(s) an individual has on the project.
As tasks are completed, the workflow moves on to the next step of the workflow; and then sends
out tasks for the subsequent steps until the project is completed.

Example 4.14. Starting a Workflow

● Navigate to your project folder and right-click on the project folder link.
● From the Context Menu, select ePlanning Project > Start Workflow.

The project must have an individual with the role of Team Lead before the following
steps can be performed.

Here are the step-by-step directions for starting the project workflow:
1. Navigate to the folder for the project in Webtop.
2. Right-click on the project folder.
3. From the Context Menu, select ePlanning Project > Start Workflow from the menu bar.
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4. A new information window with the message "The Project Workflow was successfully
started" will appear. Click OK on that new screen.

4.8.1. Working with your Inbox: Accepting a Task

Once the project workflow has successfully started, a message will appear in the Inbox of the
Team Lead.

The Inbox node is an integral component which assists with project workflows. The Inbox
contains two types of messages: Tasks and Notifications.

Tasks are indicated with this icon:

. Generally, for these types of messages, you will be required to acknowledge the message,
complete an action, return to that message to finish it, and move it onto the next step of the
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workflow process. Please note that some tasks, such as copying a template, cannot be finished
(and moved to the next step in the workflow process) without completing that task.

Actions that can be taken for task items include (but are not limited to) these buttons:
● Accept: This removes the task from any other Team Lead's Inbox (if there are multiple Team
Lead roles for your project) and records the date and time you accept it.

● Forward: This informs the system that you want to move onto the next step in the workflow.
● Finish: This will only show as an option after you accept a task and will move the project
workflow to the next step.

● Delegate: This will allow you to reassign the task to another individual in the ePlanning
system.

● Repeat: This restarts the workflow step.

Notifications are indicated with this icon:

. Notifications are messages letting you know when a specific action has occurred. Once this
message is read, you can delete this message.

Example 4.15. Accepting a Task

● Navigate to your Inbox and open up the newest message that pertains to your project.
● Read the directions for that message, and select Accept at the bottom of the screen.

The ePlanning Inbox only contains the tasks and notifications messages sent within the
ePlanning system via Webtop. It is not linked or synchronized with your Outlook Inbox.

Here are the step-by-step directions for accepting a message in your Inbox:
1. In Webtop, click on the Inbox in the Navigation Pane on the left side of the screen.
2. Click the link for the Inbox item titled “Get EA Template”.

a. The Task includes additional project information, instructions, and will include a
shortcut to navigate to the project. The first task in the project workflow (for an EA
project) instructs the Team Lead to copy the appropriate template from the Asset
Library and paste it into the appropriate folder in the project.

3. Click the Accept button on the bottom of this screen (see above image).
a. The screen refreshes to show the following buttons are enabled: Forward, Delegate,

Repeat, and Close.
4. Click the Close button. The Inbox screen reappears with the status column changed to

“Acquired”, indicating the task has been acknowledged and is in progress.
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Note

The directions just described are only one of many project workflow items that will show up in
your Inbox. If you are working on multiple projects simultaneously, you may have the “Get EA
Template” message in your Inbox more than once.

So, how do you know which workflow item goes with a specific project? From your Inbox,
there is a dropdown menu on the right side of the screen which is defaulted to Show All (Hide
Attachments). Click on the dropdown menu and select Show All (Attachments). Now, the
project number or name of the document will now be displayed in your Inbox, next to the
“Attachments” section.

4.8.2. Working with your Inbox: Finishing a Task

When the copy process is complete, a new sub-folder containing the document template is created
in the EA Document folder (within the project folder).

Once you have completed the process for copying the necessary template, as described in your
Inbox task, you will need to finish the task. Once the task is marked as “Finished”, the workflow
will move on to the next set of steps in the system.

Example 4.16. Finish the Task for Getting the EA Document Template

● Navigate to the Inbox and Delete the “Document Copy Results” notification for the
copy template process.

● Click the “Get EA Template” task from the Inbox and Finish the task.

Here are the step-by-step directions for finishing the task for the EA Document:
1. Navigate to your Inbox.
2. Open the “Document Copy Results” notification by clicking on the name of that notification.
3. Delete the notification by clicking on the button at the bottom of your screen.
4. After deleting the notification, the Inbox will refresh and you will see the original “Get

EA Template” task item.
5. Open the “Get EA Template” task by clicking on the name of that task.
6. Click on the Finish button to move the workflow system into the next stage of the project

(see example image above).

After you have finished this task and your Inbox refreshes, you will notice a new task titled
“Assign and Review Sections/Tasks”.

4.9. Types of Workflows

There are two major types of Workflows in ePlanning: Project Workflows and Document
Workflows.

January 1, 2013

Chapter 4 Assigning–Acknowleging Authoring
Tasks, Advanced Webtop & Workflows

Working with your Inbox: Finishing a Task



90 ePlanning Training Manual and
Reference Guide

4.9.1. Project Workflows

A Project Workflow manages an entire project, such as an RMP process, Environmental
Assessment process, or Categorical Exclusion process. Each project workflow is defined from
its initiation to the its completion, including the variable steps in between. In addition, project
workflows may be comprised of many Document Workflows.

Let’s take a quick look at the workflow for a CX, for example. A Categorical Exclusion Project
Workflow is comprised of the following general steps:

1. The project is initiated.
2. The CX Template is copied from the Asset Library and pasted into the CX project library.
3. A CX document workflow is initiated (steps that include authoring the document and

reviewing the document).
4. A 30-day waiting period occurs upon completion of the CX document, during which

appeals may be submitted.
5. If no appeals are received, an approval letter document workflow is started.
6. The approval permit is added to the project and published (if desired).
7. The CX project (and its workflow) ends.

The Steps of a Categorical Exclusion Project Workflow

4.9.2. Document Workflow

The Document Workflow manages the creation, review, approval, and publication (if appropriate)
of individual documents. In some cases, a project may have one or several documents within the
entire process.

A document lifecycle is a sequence of phases that a file goes through between its creation and
expiration. When you create a file, the system assigns a document lifecycle to the file and puts
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the file into the first phase in the lifecycle. Typical lifecycle phases include “Work In Progress”
(indicating a document is in its draft phase), or “Staging” (indicating a document is complete
and ready for approvals).

By default, Webtop does not let you make changes to an item that is in the Staging lifecycle phase.
A file advances through its lifecycle phase through either manual or automatic “promotion”
(confirmation that the task is completed). Typically, a document lifecycle is incorporated into
a workflow, and you are alerted to your role in a file’s lifecycle when a workflow task appears
in your Inbox.

The Steps of a Categorical Exclusion Document Workflow

4.10. Advanced Information on Workflows

The basic ePlanning course introduces the concept of Workflows, but does not follow through
an entire workflow for an EA document. Therefore, in this advanced information area, we will
spend some more time discussing Workflows.

Generally speaking, a workflow is a set of predefined sequences that walks users through
finishing their ePlanning projects. It can be the work process and steps of a person, a group, or an
organization. A workflow automates a process, ensuring that the correct file (or task) goes to the
correct people in the correct order.

In ePlanning, workflows help us manage the business of the planning & NEPA processes and its
related documentation. A workflow step or series of steps exists for each point in the planning and
NEPA process in which documentation is required or recommended. A workflow may have a few
steps, as is the case for processing a small categorical exclusion, or, it may have hundreds of steps,
as is true for a complete Resource Management Plan. ePlanning workflows begin after a project
has been created. The workflows within ePlanning are structured to follow the requirements
set forth by NEPA and most business practices within the BLM. However, your office may
have its own unique business processes. Regardless, it is important to recognize that not all of
the work related to planning and NEPA is done inside ePlanning (that is to say, according to one
standard workflow). ePlanning helps manage the documentation of the decision-making process.
Ultimately, the nuts and bolts of how your office comes to decisions can be a unique and dynamic
process (see below image).
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4.10.1. ePlanning Workflow Tools

Remember that Workflow tasks which require an action by you or other members of your project
will appear in your Inbox. In addition to workflow tasks appearing in the ePlanning Inbox, you
can view project workflow items using workflow reporting tools in ePlanning. These tools give
you a quick glance at the workflow status for each step of your project/document workflow. You
can also create workflows on the fly, independently of the project status. This may come in
handy if, for example, you need a map for your document. Each of these advanced workflow
tools are discussed below.

Example 4.17. Start a Workflow

In order to learn more about workflows, we will need to create a simple project, assign
some ePlanning User Roles and start the workflow for the project. This will be a good test
of your basic ePlanning knowledge

For this exercise, take a few minutes to perform the following steps:
1. Create a new ePlanning project such as a Categorical Exclusion, making sure to complete

all of the required fields in the Project Background tab.
2. In the Team Definition tab, edit your profile to ensure that you have the following ePlanning

roles:
a. NEPA Project Creator
b. Team Lead
c. Project Administrator
d. P&EC

3. Once you have created the project, subscribe to it and start the workflow.
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4.10.1.1. Workflow Reporting and My Workflows

Workflow Reporting allows you to view all workflows for which you are a team member. To view
these, selectWorkflow > Workflow Reporting under the Tools menu. Webtop will display the
workflows that you are supervising and performing.

Example 4.18. View My Workflows and Workflow Reporting

Take a moment to review these workflows. Notice that here underMy Workflows, you
can see the workflow you own, whereas under theWorkflow Reporting option, you will
see the workflows that you are participating in.

To filter the list that appears, use the drop down menu to select the appropriate filter in the upper
right corner of the page. To configure what is displayed in the list of workflows, select the Edit
Workflow Report link.

Under the Edit Workflow Report link, this screen (below) will appear. Here, you have the option
to display:

● Only those workflows that have overdue tasks.
● Workflows supervised and performed by a specific user.
● Workflows for a specific document.
● Workflows started from a specific workflow template.
● All workflows.
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Select OK or Cancel to exit this window.

Now, in contrast to the Workflow Reporting option, jump to the project workflows that you
"own" or created using theMy Workflows tool. From the Tools menu, selectWorkflow >
My Workflows.

4.10.1.2. Manipulating Workflow Tools

From eitherMy Workflows orWorkflow Reporting, you have the ability to manipulate some
workflow functions. The following items under this sub-section will go through some of these
features that you may want to use.

4.10.1.3. Viewing Workflow Map

To view the workflow map, select the workflow to highlight it. Under the Tools menu, select
Workflow > View Details > Map.

Be patient as a Java component loads up. A workflow map, similar to the one below, will appear.
The map below displays the overall project or document workflow.
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4.10.1.4. Viewing Workflow Details

The workflow details option (see image below) will show information about each step of the
workflow process, including the status of each step (i.e., complete, pending, future, etc.). In
addition to that, it will show the action taken to reach that status, which user completed that step,
as well as dates for when steps have been received or completed.
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To view the details of each step of a workflow, including the status of each step, you have two
options:
1. Highlight the workflow, and under the Tools menu, selectWorkflow > View Details >

Summary, or
2. Double-click on the name of the workflow.

You can filter the information in the summary page using the filter menu on the right side of the
screen. Also, you can show related attachments, filter by overdue or current workflow tasks (see
below image).
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4.10.1.5. Creating Reports

The detailed information for your specific workflow (described in the previous section) can be
converted to a Microsoft Excel file and saved in your project library, if desired. To create this
report, start in the Workflow Details screen, and select the Save Report button (see below image).
Navigate to the location where you would like to save the report. It is recommended that you save
the report within the project that you are working on.

Once the report has been saved and you locate the file in the project, the report will look like
the example image below.
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4.10.1.6. Changing Workflow Supervisor

If you have initiated a workflow for a project, you can change the workflow owner, also known as
a "supervisor" within Webtop, from you to someone else. Once the supervisor has been changed,
that person is the only one who will be able to modify workflows (i.e., halting or terminating
workflows). As a result of this, you will no longer be able to manage these tasks.

Important

When you use the “Change Supervisor” button to name another individual, the system will not
allow you to have the permission to rename yourself as the supervisor.

Here are the directions for changing the supervisor for the workflow:

1. Under the Tools menu, selectWorkflow > Workflow Reporting.

2. Highlight the specific workflow that you would like to modify.

3. Click on the Change Supervisor button.

4. Select the user who will be the new supervisor for the workflow. Start by typing in the
name of the person in the search field and clicking the right arrow next to that field to find
the individual you want.
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5. Click OK at the bottom to move on.

4.10.1.7. Pausing and Resuming a Workflow

Workflows can be temporarily paused, but still exist in the project with the intention that it can be
resumed when ready. You may, for example, wish to pause a workflow in an RMP process, if the
project takes a long break due to decisions at another level or something unforseen. When the
project is ready to be continued again, you can resume the workflow. The project’s workflow will
continue from the point at which it was paused.

Note

Depending on the specific feature of workflows that you have gone into (“My Workflows” vs.
“Workflow Reporting”), the terminology will differ just slightly (“pause” vs. “halt”). Both
methods will function the same and are described further below.

Example 4.19. Pause (and resume) a workflow

Take a few minutes to explore the ability to pause and resume a workflow.

Here are the directions for pausing a workflow (throughMy Workflows):

1. Under the Tools menu, selectWorkflow > My Workflows.

2. Highlight the workflow you would like to pause.

3. Under the Tools menu, selectWorkflow > Pause Workflow.
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4. You are prompted with a message that the workflow is going to be halted. Click OK
to confirm this message.

5. The workflow is now paused.

Here are directions for halting a workflow (throughWorkflow Reporting):

1. Under the Tools menu, selectWorkflow > Workflow Reporting.

2. Highlight the workflow you would like to pause.

3. Click the Halt Workflow button near the top of the screen.

4. You are prompted with a message that the workflow is going to be halted. Click OK
to confirm this message.

5. The workflow is now paused.

Important

You can resume a paused workflow easily. However, you cannot resume a terminated workflow
(which is discussed in the next section).

To resume a workflow that has been paused or halted, go into either of the methods described
above and choose Resume Workflow from the Tools menu or using the button (in Workflow
Reporting). See the images below for clarification.
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4.10.2. Terminating a Workflow

If needed, you can terminate the workflow of a project. However, in choosing this option, you will
remove all the Tasks and Notifications from the Inboxes for all of that project’s team members.
You can terminate a workflow at any point in the project life cycle. This is especially useful if
there are many Inbox messages that you would like to clean up simultaneously. Terminating a
workflow will help in removing many messages at a time, if related to one project.

Just as in the section above (describing halting or pausing workflows), the terminology will differ
slightly depending on the workflow method you have chosen to go into. Essentially, “terminating”
or “stopping” a workflow are the same function.

Warning

Keep in mind that a terminated workflow cannot be restarted! If you wish to utilize workflow
functions for a project after it has been terminated, you will have to recreate the project!

Example 4.20. Examine the Terminate Workflow function

If you have an extra workflow or two in training that you would like to stop, go ahead and
choose the Terminate Workflow option. If you have just one workflow for this training,
leave it alone for now. We may need to explore other workflow functions later.

Here are the directions for terminating a workflow:

1. From eitherWorkflow Reporting orMyWorkflows functions, highlight the workflow you
would like to stop.

2. Under the Tools menu, selectWorkflow > Stop, or click the Terminate Workflow button.
See the images below for clarification.
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3. You are prompted with a message that the workflow is going to be aborted. There will be
a box that you can uncheck or check to remove all related messages for this workflow.
Click OK to confirm this message.

4. The workflow has now been terminated. (It won’t be back).

4.11. Quickflows

As mentioned during the ePlanning introduction course, there are three types of reviews that
can be used for documents.

The three reviews are:

1. A Peer-to-Peer review is chosen when a major document, such as an EIS, is in development.
An author would select this review option if they want their sections to be reviewed by a
peer or professional counterpart. They can also be used for conducting multidisciplinary
review of less complex documents (e.g., CX, EA, DNA, etc.) where a review is desired, but
formal approval and signatures are not required.

2. An Interim review can be used to distribute an entire document for review to a broader
audience, but it is a little more formal than the Peer-to-Peer review. An Interim Review
can be sent to the Field Office Manager and/or planners at various organizational levels,
as needed.

3. A Surname review is a final and formal review where the document is routed to a particular
agency level for review and approval. This is usually completed by a formal management
briefing where the document is signed. This type of review could be conducted, for example,
in the District Office or State Office for certain EAs (or EISs), or it could go all the way up
to the Washington Office for highly complex EISs and RMPs. Surname reviews are more
formal than are usually needed for CXs, DNAs, and most EAs.
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In addition to those reviews, Webtop also has an “out of the box” review function called
Quickflows.

Quickflows are less structured than the traditional workflows that are mentioned in the
introductory course. Almost any ePlanning user can create a Quickflow for a document that they
are working on. In addition, a Quickflow can be sent to one user, or it can be sent to multiple
users. If it is sent to multiple users, you have the option to choose whether all users receive the
task simultaneously or sequentially.

Note

The directions below will illustrate how to add members in a field office, presuming that IDT
members are usually the same, from one project to another. However, individuals can be added
by beginning the search using the first name of that person. For example, to find “John Doe” in
the list, start typing “John” and search to narrow the list down to users you are looking for.

Important

One crucial item to note about Quickflows is that this function is, essentially, an informal
method of sending documents to others. As such, the ePlanning system does not really
track when individuals have reviewed documents or have completed tasks, while formal
workflow reviews track progress and changes made to the document. If you are looking to
build a comprehensive review and would like to have the system track those details, we
highly recommend you continue using the basic workflow and review process taught in the
introductory course.

Here are the directions for creating and sending out a Quickflow:

1. Highlight a document(s) that you would like to send out for review using the Quickflow
function. You can select any document (e.g. virtual document or PDF), or even a folder
containing all the necessary documents to send via a Quickflow. Right-click and select
Quickflows from the context-menu (see image below).

2. The Quickflow window will come up. The left-hand side of the Quickflow window contains
a list of the selected files. Files can be added or deleted in that left side of the window.
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Choose the Select user/group link in the main area of the window to add users to the
Quickflow (see image below).
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3. A new window will appear containing an extensive list of groups that can be used. However,
this list can be narrowed drastically by looking for your specific office. Start by inputting
your state’s initials (i.e. “nv” for Nevada) and clicking the right arrow next to that field to
bring up a list of offices in that state (see image below).
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4. Highlight the group that you would like, select the right arrow in the middle of the screen to
move that group into the right side of the screen. When ready, click the OK button in the
lower right area of the window.

5. The original Quickflow window reappears after clicking OK. Once the individuals or
groups have been identified, you have the option to specify the Priority using the drop-down
menu, add instructions, and check some additional boxes below (see image below). The
checkboxes are explained in greater detail in the table further down in this section.
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Option Description
Send to users sequentially If you have selected more than one user, then select this option

to send the quickflow to each user sequentially rather than
simultaneously.

Return to Me Select this option to receive a notification when a user completes
the task.

Require signoff Select this option to require each user to enter an electronic
sign‑off when completing the task. This will use each user’s BLM
AD password to complete the task.

Warning

Selecting Require signoff will require your regular BLM Active Directory password to
complete the review. This is not a critical issue, but it does confuse many users. We
recommend NOT checking this option.

6. Click the OK button to send the Quickflow to the selected users. A message will appear in
their Inbox node, similar to a regular Peer-to-Peer review message. When the user opens
that message, they will see the details for reviewing the document(s). When they have
completed the task, the reviewer would click the Finish button at the bottom of the screen.
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7. A notification message will appear in your Inbox indicating that the review has been
completed by that individual.
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5.1. Introduction

Arbortext is an Extensible Markup Language (XML) authoring tool that supports creation and
publishing of complex documents in multiple formats.

5.1.1. Objectives

Upon completion of this chapter, you will be able to use Arbortext Editor to:
● Enter text
● Copy and paste text and tables from Word documents
● Create tables
● Add images and static maps
● Preview documents

5.2. Introduction to XML and Arbortext Editor

This chapter introduces and provides common definitions, procedures, and instructions for tagging
XML content so that ePlanning publications appear properly in their multiple media outputs.

5.2.1. The Basics of XML

There was a conscious decision to choose XML instead of Microsoft Word (MS Word) due to
the additional benefits provided by the content management software and the inherent problems
found with using MS Word or MS XML language. Within ePlanning, documents are created and
edited with Arbortext Editor. Arbortext Editor is an XML editor and not a simple word processor.
XML is a non-proprietary data format that is platform, application, and media independent.

With XML, the content of a document is separated from the way the content is displayed. This
allows the same content to be produced in multiple outputs by simply applying various stylesheets
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to it. Think about how an EA currently gets published: authors write content, a Team Lead or a
writer/editor takes these various sections and puts them together into one or more documents.
These documents are then sent to be published. Typically this means that they put the MS Word
documents into some other software. They also must make changes to the content for better flow,
add graphics, pictures, etc., and a PDF file is sent to a commercial printer. The EA also needs to
be posted on the web along with the maps. At the BLM, currently these documents are posted as
different PDF files that are not connected. There are a lot of renditions of the EA for the desired
output media. Since ePlanning is storing text separate from the style of a document, the various
required renditions are simply completed by applying a stylesheet to the content which can be
completed in minutes instead of days and weeks.

5.2.2. The Grammar of XML

The characters which make up an XML document are divided into markups and content. XML
uses named elements that are delimited by "tags", which identifies the markup in a document and
provides information on how the text will be displayed or handled by other applications. Content
is preceded and ended by a pair of "tags" for the same element (e.g., <title>The Shining</title>).
Because we are using Arbortext Editor for developing content, Arbortext Editor is doing the XML
validation. Only valid elements appear when you click enter. Arbortext Editor also performs a
completeness check which makes sure the XML is valid for the current document.

5.2.3. Transitioning to Arbortext

Most of the basic things you are used to doing in MS Word can also be done in Arbortext Editor,
often with the same or similar commands. That means that for most of the word processing work
you do, there will be no or minor adjustments in how you do them. In this course, we'll stick with
the basics. The two biggest adjustments to make when switching from MS Word to Arbortext
Editor will not normally being able to format your text as you would in MS Word.

5.2.4. Structured Content

Arbortext Editor, XML and the DocBook DTD are tools for producing structured content. The
text that is authored must follow rules, somewhat similar to a menu, a simple structured document.
Typically, a menu requires several components: type of menu, food items, prices, descriptions
and calories. The style of the menu is at the discretion of the editor or the restaurant owner who
enforces the style guide. This can be easily enforced by providing the authors with a template that
menu items will conform to. Without structure from the authors, the editor has the tremendous job
of reformatting the unstructured menu items into the structured format. In this way, the published
menu will have the look and feel the owner desires.

For example, structured content:
● Breakfast Menu
● Food items
● Cost of the food item
● Description of the food item
● Calories of the food item

The breakfast menu in XML:
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After composing the menu in XML, select the desired stylesheet and your menu could look like
the example below:

5.2.5. Formatting, Stylesheets, and Printing

What displays on your computer screen is not necessarily how your document will appear in
print. You can modify some minor formatting (bold, italics), but document-wide formatting of
things like section headings, number of columns, how footers look, and page numbering are
now taken care of by using stylesheets. Stylesheets in ePlanning are essentially agreed upon
formatting conventions for a variety of documents (e.g., a categorical exclusion, an environmental
assessment, or a cover letter). Stylesheets are created by developers at NOC's National
Application Branch with feedback from the various users at all levels of the organization. They
are applied when you want to finalize your document and can ensure documents are in compliance
with national policy and guidance.
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Example 5.1. Print Compose or Preview

Using the Main Menu select File > Compose > PDF File or File > Print Preview.

Use either the Print Compose or Print Preview options. Both methods require the user to select
the appropriate stylesheet. Here are the two choices for previewing your document:
1. The Print Compose option will allow you to compose a document as a PDF.
2. The Print Preview option will allow you to see a temporary view of your document.

5.3. Arbortext Editor - Navigation and Preferences

This section will walk you through opening up, navigating around and editing your document.

5.3.1. Starting to Edit Your Document in Arbortext Editor

Example 5.2. Edit your Document (Open Arbortext Editor)

● Select the virtual document from the ePlanning Cabinets; or if subscribed, go to your
Subscriptions.

● Highlight the virtual document and then right click on the highlight to reach the Edit
option.

Here are step-by-step directions to Edit your document:
1. Highlight the virtual document and then right click on the highlighted document.
2. Once you right click on it, the Edit option will be the first on the list. Click the Edit option.
3. The Edit: BLM Environmental Assessment form will open. Select the default of "All, root,

and descendants" option and click the OK button.

The Arbortext Editor window will open with your virtual document ready for editing.

5.3.2. Navigating the Arbortext Editor Window

Below is an image that shows a typical Arbortext Editor window. The window has many of the
same components of other common applications.
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Arbortext Editor Window Components

The components:

● The Title Bar displays the name of the program, Arbortext Editor, and the name of the
document that is currently open in editor.

● TheMenu Bar displays the names of menus, each of which lists available editing functions
and commands.

● The Edit Toolbar displays a standard set of buttons for use in Arbortext Editor.
● TheMarkup Toolbar is a set of button(s) that manipulate the markup in a document. Markup
deals with XML.

● The Tables Toolbar is a set of buttons to aid in the creating and editing of tables while in
Arbortext Editor.

● The Application Toolbar allows some minimal formatting of text. It is a quick way to modify
or insert some XML tags tools such as bold, italics, underline, and numbered and bulleted lists.

● The Edit Window displays your document with all of the content exposed in addition to
the tags (elements) that control the structure of the document. In the example above, the
Edit Window is split with a Left-Right Split, and the left hand side has the Document Map
displayed. This is the default setting for new users.

● The Status Bar displays tool tips and other messages related to Arbortext Editor’s interface,
operation and format status updates in the boxes on the right side of the window.
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Tip
● The function of a button in the tool bar is displayed in a text box when you hover the cursor
over the button.

● If you seem to be missing a toolbar, right click in the empty space to the right of the toolbars
and select the one you want to activate it.

5.3.3. Changing Views in Arbortext (tags on and off, split screen)

Arbortext Editor allows you to modify your window display to meet your preferences and needs,
including:
● Tag Display options
● Split Windows
● Document Map
● Display Font Size
● Preferences

○ Select “Full Menus” option
○ Change Colors
○ Other display and Menu Bar preferences

5.3.3.1. XML Tag Display

Arbortext Editor is an XML editor that allows authors to markup content with XML "tags", or
graphical representations of XML elements. For example, a "para" tag, which denotes a basic

paragraph with text, will be displayed like this: Tags come in pairs
with each defined element having both a start and end tag. You can also modify how tags are
visible similar to how Reveal Codes in WordPerfect or Show Formatting in Word documents.

Tag Display Options:

● Full Tags- fully displayed
● Partial Tags- partially displayed
● No Tags- completely off

Example 5.3. Change Your Tag Display

● Use the Menu Bar to change your tag display between Full/Partial Tags/No Tags.
● Click on the Tag Display button to change your tag display between Full/Partial
Tags/No Tags.

Here are step-by-step directions to change the tag display. There are two ways to perform this
function:
1. When your cursor is in the Display Pane select View > Full/Partial Tags/No Tags from

the Menu Bar.
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2.
Click on the Tag Display button ( ) and toggle to the desired tag display mode.

Switching between the display modes, will allow users to focus on different aspects of their work.
Once you become comfortable with Arbortext Editor, you may find that working with the tags
off helps you focus on content. When in doubt, display the tags to make sure you're typing
within the correct tags.

5.3.3.2. Split Windows

The Arbortext Editor Edit Window may be split into two panes, with either a Left-Right or
Top-Bottom split, or left whole as one window. Split Windows may help when working with large
documents by allowing you to maintain your place in a document in one pane while checking
content elsewhere on the other pane. By default, the Edit Window is displayed with a Left-Right
Split and the Document Map displayed on the left side.

Example 5.4. Change How the Arbortext Editor Window Displays

● Use the menu to change your window display to the Top-Bottom Split view.
● Use the Left-Right Split button to change the window display back to Left-Right
Split.

Changing the Window Display

Here are step-by-step directions to change the Arbortext Editor window display:
1. Select Main Menu -

● Window > No Split
● Window > Left-Right Split
● Window > Top-Bottom Split

2. Or click on the Buttons icons:
● Left-Right button ( )
● Top-Bottom button ( )

Document Map

The Document Map is similar to the Navigation Pane in Webtop. The Document Map, an
outline-like view of the document similar to the Webtop Navigation pane, may be displayed
in either window. To display the Document Map, click on the screen where you would like it
to appear and then select:

● Main Menu select View > Document Map from the menu bar; or

● Click on the Document Map button ( ).
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You can also move items such as sections and paragraphs in your document map to other locations
and the corresponding change will take place in your document. This makes it easier to move
around large sections of documents to other locations.

Synchronizing the two panes can be done automatically (so that moving in the document in
one pane will cause the other pane to move to the same place in the document) or manually.
To Synchronize follow these steps:

● To automatically Synchronize go to the Main Menu and select View > Document Map >
Auto Synchronize.

● To manually Synchronize

○ go to the Main Menu and select View > Document Map > Synchronize Views from the
menu bar; or

○ click on the Synchronize Views button ( ).

5.3.3.3. Changing Display Font Size (Zoom In and Out)

You can "zoom in" or "zoom out" on the Arbortext Editor window to make it easier to read
or display more text at one time by using the Increase Font ( ) and Decrease Font ( )
buttons or through the View menu bar (View > Font Size > Increase Font or View > Font
Size > Decrease Font). You are only changing the view on the screen, not how it will appear
when the document is printed or published.

5.3.4. Arbortext Editor Preferences

To set preferences in Arbortext Editor go to the Menu Bar and select Tools > Preferences.

Example 5.5. Setting Arbortext Editor Preferences

● Check to see that Full Menus are enabled.
● Change the color of the tags.

5.3.4.1. Preference: Full Menus

Here are step-by-step directions to setting your Arbortext Editor Preference of Full Menus:
1. From the Menu Bar select Tools > Preferences.
2. In the Category box select "Window".
3. To activate the full menus check the box next to "Full Menus" (See below image).
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5.3.4.2. Preference: Change Colors

4. In the Category box select "Colors".
5. You can change the colors for the following Arbortext Editor items:

● Tag Font
● Generated Text
● Text Entity
● File Entity
● XML Inclusion

6. Select a preferred color for each item.
7. Click the OK button.

Note

If you get tired or dislike the colors you selected, just reset the colors by clicking on the
Default button.

5.4. Arbortext Editor Basics

In this section, you will learn to use Arbortext Editor to:
● Enter text
● Format text
● Bulleted and Numeric lists
● Formal and Informal Tables
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● Figures and Media Objects
● Static Maps
● Find and replace text
● Check for Completeness
● Edit someone else's work
● Saving your work in Arbortext

5.4.1. Enter Text

To enter text in Arbortext Editor your cursor needs to be in the correct location within the desired
set of tags. This will ensure that your text will show up in the correct place and be formatted
properly. To add text to a document, place the cursor between the appropriate tags and then type.

5.4.1.1. Format Text

Copying, Pasting Text and Importing Documents

The simplest way to move text from another document into Arbortext Editor is to copy and paste
one paragraph at a time and apply additional formatting directly in Arbortext Editor. When
pasting items from your computer's clipboard to an Arbortext Editor document, only the text is
pasted. Formatting that exists in the original document may not be pasted along with the text.
Note that some formatting is lost, which may have some unanticipated results.

Emphasizing Text (Bold, Italics, etc.)

Emphasizing can be accomplished using buttons from the application toolbar that have the same
look as in Word. Emphasizing text can be accomplished with basic font highlight functions such
as: bold, italics, and underlining. Accessing the properties of theModify Font box, which
includes: type, size, color, shading, and superscript, is done by selecting:

● From theMain Menu select Format >Touchup > Font.

5.4.2. Bulleted and Numeric Lists

Here are step-by-step directions for adding a Bulleted and Numeric list to your document:
1. Place the cursor where you want to start your list and press Enter.
2. Select itemizedlist (for bullets) or orderedlist (for numbers), then begin typing information

(you will be putting text between the <para> tags).
3. To get a new bullet, either press Enter and select listitem after para, listitetm if you are

within <para> tags (like you would normally be when typing a list) or just two returns (the
second chooses the listitem split tag) if you are between the <para> and <listitem> tags.

4. If you would like secondary bullets or numbers (subsets of existing ones), hit return and
choose itemizedlist (for bullets) or orderedlist (for numbers).

To create a list from existing text (or change the type of list between bullet and numbered):
1. Each item for your list must be between <para> tags.
2. Select all the items (left click on the first <para> tag, shift and click on the last <para> tag)

and click on the Bulleted List or Numeric List buttons.
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You may wish to start a list with a number other than 1. This may be helpful if a list is "broken"
by text, formatting, images, etc., but start again later in the document. There are two different
ways to get a list to start with a number other than one. To manually edit the starting number:

1. Place the cursor after the first <listitem> tag

2. Open the Modify Attributes window by selecting Edit > Modify Attributes or pressing
Ctrl+D.

3. In the override field, type the number you want the list to begin with, click OK

It is also possible to have the numbers continue from a previous list. The benefit of this method is
that it is dynamic and will be updated if the number of items in the first list changes:
1. Place the cursor after the <orderedlist> tag.
2. Open the Modify Attributes window by selecting Edit > Modify Attributes or pressing

Ctrl+D.
3. In the continuation field, select restarts from the drop-down list.

5.4.2.1. Working with Ordered Lists

When creating BLM documents using ePlanning, you undoubtedly will be require to use an
Ordered or Itemized List (numeric and bulleted list respectively). In order to ensure that users get
the most out of using these lists, we will review a couple of advanced topics that should come
in handy. The first being how to alter the numbering of itemized or numeric list items, and the
second being how to modify the spacing between each list item. The image below is an Arbortext
view of how a itemized list might be arranged.
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5.4.2.1.1. Continuous Numbering for an Ordered List

Let's look closer at the ordered list attributes. By altering these attributes, we can break up two
different numeric list but still maintain a continuous numbering convention. The image below
illustrates this most clearly. Notice in the image that there are two items labeled 1 in the list.
However, with the second item that is labeled one, look at the attributes associated with the
Orderedlist tag. When rendered with a style sheet the attribute continuation “continues” means
continue the numbering from the previous Orderedlist tag.
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Example 5.6. Create Continuous Numbering for an Ordered List

Create continuous numbering between two separate ordered list

Here are the step-by-step instructions for altering the numbering for a pair of ordered list:

1. Locate the second of the two list that you wish to use the continuous number feature with.

2. Place you cursor just inside the opening orderedlist tag and press Ctrl + D button together;
doing so will bring up the Modify Attributes box for the second ordered list (see below
image).
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3. There are two options with the continuation attribute drop-down menu, which are “restarts”
(the default) and “continues.” Select the “continues” option from the drop-down menu and
then press the OK button (see below image).

4. The second of the two ordered list will now continue the numbering from the first ordered
list.

5.4.2.1.2. Spacing of an Itemized List

Two “styles” are available for the spacing of the output from the Orderedlist and Itemizedlist
tags. Specifically, this relates to the line spacing between bullets in the list. There are two
choices: compact or normal. The default is normal. Changing these options are primarily
stylistic; however, compacting the bullets does have a practical purpose, which is to save space
in a document. If, for example, you have a document that has an abundance of ordered or
itemized lists, you may wish to compact all of the bullets in order to decrease the page count of
the document.

Example 5.7. Modifying an Itemized or Bulleted List’s Spacing

● Compact the bullets of an Itemized List

Here are the step-by-step instructions for modify the spacing between bullets of itemized list:
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1. Place you cursor just inside the opening Itemizedlist tag and press Ctrl + D buttons
together. Doing so will bring up the Modify Attributes box (see below image)

2. Two options are available in the spacing attribute drop-down menu, which are “normal” (the
default) and “compact.” If you want to compact the bullets, then select the “compact” option
from the drop-down menu and then press the OK button.

3. The space between the bullets has been decreased.

The images below display the difference between the two spacing options, normal and compact.

PDF Output - itemizedlist - Spacing Normal

PDF Output - itemizedlist - Spacing Compact
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5.4.3. Copy a Table

In this section we will be demonstrating how to create a table in Arbortext Editor. The instructions
on how to import a table from Microsoft Office applications is covered in this section; and,
specifically covers Microsoft Word and Excel.

Example 5.8. Copy and Paste a Table

● Copy a table from a MS Word document.
● Paste it into your virtual document.

Here are the step-by-step directions to copy and paste a Table from MS Word or Excel:
1. From your MS Word document, copy the table you want.
2. Within your virtual document, place the cursor in the desired location for the table and

paste the table.
3. The pasted table will appear within a set of Informal tags.
4. If you want the informal table to appear in the Table of Content’s List of Tables, continue on

with the following steps:
5. Right below this Informal table, press Enter and then select the Table tag option.
6. When the Insert Table box opens, don’t worry about selecting the number or columns

and rows, just press OK (You will now have a set of empty Table and Title tags in your
document).

7. Highlight the pasted Informal table, but do not include the Informal table tags.
8. Once highlighted, drag and drop the created table into your Table tags, right after the end

Title tag and before the end Table tag.
9. Delete the empty table rows (the two columns and rows) that was just created within your

formal table tags.
10. Delete the empty Informal table tags.
11. Give your table a title
12. Adjust the table as needed (i.e., columns, color, size, etc.).
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Tip
● Change row heights or column widths - line the cursor up on the row or column line (look
for the double headed arrow), click and drag to the desired width/height

● Create a header row - place the cursor in the first row and select from the main menu Table
> Convert to Header Row

● Adding or deleting rows or columns - place the cursor in the desired position and use
the Insert Row Below and/or Insert Row Above buttons, or right mouse click in the
row/column and choose the desired action (Insert or Delete).

● Change from portrait to landscape - place the cursor after the table tag, select Edit > Modify
Attributes, select orient (land, port), for pgwide type 1

● Shading cells - select the cells you want to shade, use the Apply Cell Shading button and
choose from the incredible palette of colors

5.4.3.1. Modifying a Table

In Arbortext Editor, tables’ properties and formatting can be modified. For basic table formatting
(row height, column width, borders) follow these steps:
● Right click anywhere in the table and select Table Properties or
● From the Main Menu select Table > Table Properties.

5.4.3.2. Table Tags

The way tags are displayed within tables is handled differently than the rest of Arbortext Editor.
To change the way table tags are displayed go to View > Tables > Cell Tag Display. There
are four different options:

1. Inherit: This means that the tables tags will be the same as the rest of Arbortext Editor
tags display.

2. Full Tags: All the tags will be displayed (see below image).

January 1, 2013
Chapter 5 Arbortext Editor

Copy a Table



128 ePlanning Training Manual and
Reference Guide

Full table tags

3. Partial Tag: Tag locations are displayed.
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Partial table tags

4. No Tags: No tags will be displayed.
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No table tags.

5.4.3.3. The Look and Feel of a Table

The stylesheets no longer control the look and feel of tables. The user has most of the control
over the way a table will look. This means what you do in AE will carry over to the published
document.

Some things that you may want to do with tables:

● Make the font smaller for the whole table so it fits better on a page.

○ Put you cursor after the opening table tag.

○ Edit > Select Element Content All of the table content should be selected but not the tags.

○ Format > Touchup > Font

● Always identify the Header Row.
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● Always give it an ID so you can reference it properly in your document using the xref tag.

5.4.4. Figures and Media Objects (Images)

Images will generally come from another source, so make sure the ones you want to use are in a
place you can access from ePlanning. You can place images, figures, or photos in your document
using similar steps. The only difference being, is that if you want your images to show up in the
Table of Contents as opposed to not showing up you must follow slightly different steps.

Example 5.9. Insert a Digital Picture

Insert digital pictures into your Arbortext Editor document using the
<figure><mediaobject><imageobject> tags.

Here are step-by-step directions for inserting a Digital Picture:
1. Place the cursor outside of <para> tag.
2. Press Enter. A list of valid elements appears. Select <figure> from the list
3. Enter a title for the figure.
4. From within the <figure> tag press Enter. Click <mediaobject> from the list of valid

elements. The <mediaobject> tags appear.
5. From within the <mediaobject> tag press Enter. A list of valid elements appears.
6. Click <imageobject>. The locate image File to Reference window appears.
7. Locate and select the image file to be inserted then click on the Open button [The file name

of the image must NOT include special characters or punctuation mark such as commas,
apostrophes, etc. (, . ! & %). The file name of the graphic appears in the markup window
bracketed by an <imageobject> tag].

Note

Using the <Figure> tag will reference your image in the Table of Contents. Otherwise, omit the
figure tag before the other image tags.

Warning

DO NOT insert images using the Insert > Graphic command from the menu bar or clicking on
the Insert Graphic button ( )! Doing so will cause errors when you check in the document to
Webtop. When you use the <mediaobject> or <inlinemediaobject> tags, a copy of the image is
created and stored in the Webtop when you check in the document. If you use the insert graphic
command a copy will not be created, only a link to the image will be stored. This will cause
conflicts between the permissions of the Windows file servers and the Documentum Webtop.

Modifying the way the image appears in the published PDF and HTML documents is very
different in Arbortext Editor than in MS Word. Because what is visible in Arbortext Editor is not
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necessarily what is printed in the completed product, you will not see the way the image will look
in the finished document until you do a Print Preview, Print Compose, or Build the document.

In order to work with images, you need to work with the attributes on the <imagedata> tag. For
example, to center the image, you would modify the align attribute (you can align the image to
the center, right, or left of the page).

Sizing and scaling of images also requires modifying attributes of the <imagedata> tag. Arbortext
Editor also processes images in a literal sense, pixel by pixel. Just like with a digital camera, the
higher the number of pixels, the higher quality the image tends to be--but the image will also
be much larger in your Arbortext document. This may result in images that are too big for your
page and scroll off the edge. Using two key attributes, scalefit and width, you should be able
to effectively resize your image to dimensions that fit your document. The scalefit attribute is
a "true/false" field. If the scalefit is set to "1" ("true"), your image will be scaled to fit inside a
specified area. The specified area is defined by the width and depth attributes. While width and
depth are both important, it is easier to pick one parameter. Technically, the image is scaled until
either it fits to the content width (and the content depth is less than or equal to the viewport
depth) or the depth (and the content width is less than or equal to the viewport width), whichever
comes first.

Example 5.10. Adjusting the Digital Photo

● Make the properties of digital photo for the first figure width = '2.5in'.
● Center align the digital photo.
● Create captions for both of the digital photos.

Here are step-by-step directions for Modifying image size:
1. Place the cursor to the right of the <imagedata> tag.
2. Select Edit > Modify Attributes from the menu bar or press Ctrl+D. The Modify Attributes

window appears.
3. Set the value of the scalefit attribute to "1".
4. Set the value of the width attribute to a width appropriate to the space you want to give it

in your document. For example, if you want your image to be no larger than 2 1/2 inches
across, you would set the width attribute to "2.5in". Notice that there is no space in the
attribute's value and that the units of measure ("in") are used. You must follow these rules or
the width setting will not work.

5.4.4.1. Working with Graphics

Images or graphics can be very challenging within XML environment. With AE, it is assumed that
users know things such as resolution, file size, high quality versus low quality. This assumption,
however, is not always the case or true. ePlanning doesn't have a graphic software package
associated with it. So, it was always assumed that working with graphics would be done outside
of ePlanning. So if you need a graphics software program, there are many COTS applications
designed specifically for graphics. Graphics to be included in XML document need to be created
outside of ePlanning then added to the XML document when using AE. Another assumption is
that your graphics will be rotated BEFORE they come into ePlanning.
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Another limitation of graphics in XML is that graphics cannot be layered. This means you cannot
for example, have a background image and then place some text on top of the image. In order to
have that type of graphic used in an XML document, the graphic needs to be created in some
other graphic software and then inserted with the <mediaobject> element to add the graphic to
your document.

Note

The recommended supported file formats are: BMP, GIF, JPEG, PNG and TIFF.

Important

The July 2010 Version of the Arbortext Editor Quick Reference Guide for ePlanning V. 2.0 has
some good information about adding graphics to your documents.

When adding a graphic to a document in AE you should notice that the
path is the path to one of your directories, as demonstrated by this graphic,

. Upon checking in
the document, Documentum makes a copy of the file from the G drive and puts that copy in
the ePlanning repository. If you drill down to the virtual document, you will eventually find
the graphic file. When you check the document out again, you will see that the path to the
graphic has changed. The graphic now has link to the Documentum repository. For example,

.

5.4.4.1.1. Graphic Attributes

There are many attributes associated with the <imagedata> element. After the <imagedata>
element, press Crtl + d for theModify Attributes window to display.
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Now lets take a closer look at the most commonly used attributes:

● Align— The align field is a pull down with the following options; center, left and right.
Select the desired alignment. The default is left.

● ID— The id field is for identification used in linking the graphic to other places. It is a good
practice to populate the id field when you add a graphic so that you can easily link to it later
(We will cover linking a little later in this module).

● Scalefit— There are two values for scalefit, 0 or 1 (binary). The default is 0. When enabled
(set to a value of 1), Arbortext Editor calculates a magnification factor to size the image (after
cropping) to fit the dimensions specified by depth or Scalefit width. If enabled, you must also
set depth or width. If you change your mind and want to disable it, set it to a value of 0.

● Width & Depth— There are a number of different ways to describe the width and depth
of a graphic. Depth is what is normally called height. The reason it is called depth instead
of height is because at the point 0,0 of the graphic (in the upper left), and if we used height
instead of depth, the height would be a negative number. See below for more information.
The number must be followed, without any space, by the unit of measurement. Typically that
would be inches, as expressed by "in". So, for example, a page size graphic the width would
be 6.5in. The below image visually displays the width and depth concepts.
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<imagedata fileref="image.png" width="6in" depth="5.5in" scalefit="0"/>

Note

Other units of measurement are: 3pi, 35mm-1pt, 0.45in + 2pt, or 1cm.

● Scale—A positive number (zero or greater) represents a percentage. For example, Arbortext
Editor interprets a value of 300 in this field as 300%, or three times the original size. See
below.
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imagedata fileref "image.png" scale="300"

● Role— The role attribute will be used for the resolution of the graphic. The role ="print"
for high resolution graphics for printing and role="web" for low resolution graphics that will
display faster of the web. For web graphics the idea is to get the file to be as small as possible
and still be readable. This means that the graphic needs to be added to the XML document
"twice," once where role="print" and again where role="web."

5.4.4.1.2. Landscape Graphic or Image

There is a trick for adding landscape graphics or images. There is no landscape attribute with
the figure tag. So the trick is to put the figure inside of an informal table tag, make the table
landscape. The idea to use the informal table tag so the table does not show up on the list of
tables. There is a tag template available to add the informal table for a figure. We will cover tag
templates in Section 5.6.11.1, “Tag Templates” (p. 215).

The code looks like the following:
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Example 5.11. Insert a Landscape Graphic or Image

Insert a landscape graphic or image into your project’s document

Here are the step-by-step directions for inserting a landscape image into your document:

1. Put your cursor in a valid location to add a table. From the Arbortext Menu Bar select Tools
>Tag Templates > and highlight Landscape Figure.

2. Click the Insert button.

3. Double click on the <instructions> tag to select the tags and contents and press the Delete
button.

4. Your cursor will be between the <mediaobject> tags. Press the Enter button and select
imagaobject from the Context Menu. Doing so will launch the “The Locate Graphic File to
Reference” window.

5. Navigate to a graphic or image that you wish to add to your document. Select it and press
the OK button.

6. Add a Title, Figure ID (optional, you may want to do this in order to reference the graphic
later), and Textobject to complete the process.

5.4.4.2. Making a Figure or Image 508 Compliant

Example 5.12. Making a Figure or Image 508 Compliant

● Add alternative text to an image.
● Add caption to an image.
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Here are step-by-step directions for adding alternative text and caption to your images:

To add alternative text to an image:
1. Place the cursor after the ending <imageobject> tag and before the ending <mediaobject>

tag.
2. Press Enter. A list of valid elements appears.
3. Click textobject. The <textobject>tag appears with [Alternate mediaobject text:].
4. After the alternative text colon, but before the end bracket, place the cursor there and hit

Enter. Insert the <phrase> tag here, then type within the Phrase tags the alternative text
you desire.

To add a caption to an image:
1. Place the cursor after the ending <textobject> tag and before the ending <mediaobject> tag.
2. Press Enter. A list of valid elements appears.
3. Click caption. The <caption> tags appear.
4. Type the image caption text within the <caption> tags. The text will appear below the

image in the finished document.

5.4.5. Static Maps

A map can be added as a static image (i.e. .jpeg, .bmp, .gif, etc) within your project's virtual
document. The process for incorporating a static map image into an Arbortext document is similar
to adding regular images, using the epl_map tag with the mediaobject and imageobject tags. If
you want your map to show up in the Table of Contents (ToC), use the epl_map tag, if not, just
use the mediaobject and imageobject tags.

Example 5.13. Inserting a Static Map

1. Use the epl_map tag (by adding this epl_map tag in your document, it ensures that
your map appears in the ToC's list of maps).

2. Also, use the mediaobject and imageobject tags.

Here are the step-by-step directions for inserting a static map into your document that will show
up in your ToC:
1. Navigate to where you want to place a static map within your document.
2. Press Enter and select the epl_map tag (by adding this epl_map tag in your document, it

ensures that your map appears in the documents list of maps).
3. The epl_map tag option appears with a pair of empty title tags.
4. Give your static map a name within the title tags.
5. Place the cursor after the end title tag, and then press Enter.
6. Select the mediaobject tag option.
7. Then, with the cursor inside the mediaobject tags, press Enter and select the imageobject

tag option.
8. When the Locate Graphic File window opens up, locate your desired static map image

that you would like to place here.
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The map, imageobject, can be modified by opening theModify Attributes dialog box when your
cursor is to the right of the imagedata tag.

5.4.6. Adding Chapters, Sections, and Sub Sections

To create a new chapter, section, or sub section in Arbortext Editor it is important to remember
that your cursor needs to be in the correct location within the desired set of tags. If you want to
create a new chapter in a document, then you need to make sure that your cursor is placed within
the Book tags. If you want to create a new section well then you need to make sure the cursor
is placed within the Book tags, and within the appropriate Chapter tags. If you want to create
a sub section, your cursor must be placed within the Book tags, appropriate Chapter tags, and
appropriate Section tags.

Example 5.14. Chapters, Sections, and Sub Sections

Use the methods below to add additional chapters, sections, and sub sections.

Here are step-by-step directions to add a chapter, section, or sub section.

:

Chapter
1. Place cursor after the Chapter tag where you would like to add an additional chapter and

press enter.
2. Select Chapter

Section
1. Place cursor where you would like to add an additional section within a chapter and press

enter.
2. Select Section

Sub Section
1. Place cursor within the section tags where you would like to add a sub section and press

enter.
2. Select Section

5.4.7. Check for Completeness

Example 5.15. Check Completeness

Use one of the two below mentioned methods to check your document for completeness.

Here are step-by-step directions to check your document for completeness:
● Tools > Check Completeness; or
● Click on the button.
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If there are issues the Completeness form will pop up displaying each tag that needs modification
in your document. You can visit each mistake by double clicking on the underlined error. A clue
to the problem is listed as well as a suggestion on how you might fix it.

5.5. SUPPLEMENTAL INFORMATION

The following information is provided for your information but will not be used for exercises
in the class. This information is intended to assist you as you work on more advanced concepts
in Arbortext Editor.

5.5.1. Cover Pages

The ePlanning style sheets have been customized to allow for inclusion of cover pages for both
PDF and Interactive Document output. Cover pages are not available the Federal Register style
sheet. To turn off covers, simply set the cover role attribute to be an empty value.

There are three types of covers.

1. Full Covers – blm-bg-full – A complete cover designed by the user. No text is printed on
this page. The user supplies the completed graphics which is displayed full page in the
PDF and Interactive document. In addition, Back and Spine covers can also be created
with the blmbgfull option.

2. User Covers – blm-bg-user – A complete cover designed by the user. Text is printed on this
page just like on a Standard Cover. The user supplies the graphic file which is used as a
background for printing standard information. No Back or Spine covers are generated.

3. Standard Covers – blm-[bl|dt]-[color] – A group of covers which reside on the ePlanning
servers. Text is printed on this background to create a cover page. No Back or Spine covers
are generated.

New options for covers are found in the role field of the cover attributes. We will look at each of
these.
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5.5.1.1. Full Covers

To include a full cover, the user must supply a graphic file (jpg, png, eps, gif, bmp, tiff) which is
8.5in x 11in size. This can be any design the user wishes. Here is an example:

The user must follow BLM design guidelines when creating the cover page.

These are located at: http://web.blm.gov/nstc/Design%20Standards/
welcome.html

As you can see, the Title and Subtitle and any other text is part of this graphic
file. ePlanning will not overprint any text on this graphic.

To add to your document, in Arbortext:

1. In the beginning of you document, add a cover tag inside of the bookinfo tag.

2. With your cursor inside of the cover tag hit Crtl + d to edit the cover attributes.

3. Set the “role” field to “blm-bg-full” which can be chosen from the supplied list of options.

4. Now add you graphic, mediaobject > imageobject > imagedata within the cover tag.

5. You can also add a Back cover! This is done by adding a second mediaobject within the
cover tag.
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6. You can also add a Spine cover. Add yet another mediaobject within the cover tag. This
will be generated after the Back cover at the end of the document.

5.5.1.2. User Covers

To include a user cover, you must supply a graphic file (jpg, png, eps, gif, bmp, tiff) which is
8.5in x 11in size. This can be any graphic you desires, however, text will be overlaid on this
background, so clear space should be provided for this purpose.

To add to your document, in Arbortext:

1. In the beginning of you document, add a cover tag inside of the bookinfo tag.

2. With your cursor inside of the cover tag hit Crtl + d to edit the cover attributes.

3. Set the “role” field to “blm-bg-user” which can be chosen from the supplied list of options.

4. Add tags within the cover tag to fill in information as described in Section 5.5.1.4, “The
Text Overlay” (p. 143)

.

5.5.1.3. Standard Covers

To include a standard cover, the user does not need to supply a graphic file. Simply choose
a role for the cover tag. A variety of covers in either “bleed edge” (bl) or “desktop” (dt) are
available in an assortment of colors. The “bleed edge” covers print all the way to the edge of
the paper. The “desktop” covers are inset from the edge of the paper for those printers which
cannot print to the edge of the paper. Text will be overlaid on these backgrounds to produce
a formalized cover page for your document.

To add to your document, in Arbortext:

1. In the beginning of you document, add a cover tag inside of the bookinfo tag.

2. With your cursor inside of the cover tag hit Crtl + d to edit the cover attributes.

3. Set the “role” field to “blm-[bl or dt]- [color]” which can be chosen from the supplied
list of options.

Note

You do not need to insert any cover graphics with this option. Graphics are available within
the ePlanning system.

4. Add tags to the cover tag to fill in information as described in the Section 5.5.1.4, “The Text
Overlay” (p. 143) below.

Use the following chart to choose an appropriate cover.
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Table 5.1. Standard Cover Colors

Standard Covers blm-[bl|dt]-[color]
blue fuscia gold green orange purple red sage teal

bl

dt

5.5.1.4. The Text Overlay

The text that is overlaid on the User and Standard covers comes from tags within the bookinfo
and cover tags.

The following example shows the tags that are inserted.
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The following example cover has been annotated to indicate where optional text tags will be
displayed in the text overlay of User and Standard Covers.

5.5.1.5. Chapter Covers

If you desire, you can create Chapter Covers as well. The process is slightly different however.
Here are the step-by-step directions to add chapter covers to your document in Arbortext:

1. Place your cursor after the opening chapter tag and hit Enter. The only tag that should be
available to chapterinfo.

2. Inside of the chapterinfo tag hit Enter and mediaobject > imageobject > imagedata.

3. Select your image.
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5.5.2. Additional Tags

A more comprehensive list of Arbortext tags is located in the back of the book.

Arbortext lists additional tags which are included in the advanced class:
● When the Enter key is pressed, multiple tags are available, which may include:

○ abbrev for abbreviations
○ acronym for acronyms
○ citation for [literature cited]
○ glossterm for glossary items
○ blockquote for offsetting a quotations

5.6. Advanced Arbortext Features

5.6.1. Introduction

This chapter covers advanced concepts of working within Arbortext Editor (AE). Users should
have a general understanding of Arbortext Editor prior to attempting the materials covered in this
section. Since functionality changes with each version of Arbortext Editor (AE) and each patch
within the a version knowing which version of AE represented in this workbook is important.

The current version of Arbortext is: 5.4.

5.6.1.1. Objectives

Upon completion of this chapter, participants should be able to use Arbortext Editor to:
● Practice and demonstrate an understanding of Arbortext Editor Fundamentals, to include:

○ Using Markups
○ Copying from Microsoft Word into AE
○ Special Spacing Needs
○ Subscripts & Superscripts
○ Creating and Working with Tables
○ Ordered & Itemized List
○ Footnotes

● Create & Use Cross References and Links
● Work with Maps & Learn Advanced Map Concepts
● Create & Insert Text Entities
● Work with Graphic/Images
● Utilize the Content Reuse Feature
● Make a Complete Document
● Create & Insert Tag Templates
● Learn Tips for Working with Large Documents
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5.6.2. Some Fundamental Tasks in AE

5.6.2.1. Using Markups

Inside of Arbortext Editor, the characters that make up an XML document are divided into
content and markups. XML uses markups, in particular, to define a document's content structure,
which provides information about how that content is displayed or handled in other applications.
Markups are visually represented by named elements called “tags” in Arbortext's Edit Window.
As you may remember from the basic user course, tags always appear as a pair. With that in mind,
let's examine some common markups as well as how to use them in Arbortext Editor (AE).

5.6.2.1.1. Splitting and Joining Tags

There are times when working on a document you want to add a new section. When you hit the
Enter key, however, section is not on of the options available. In this example, what are our
options? What should we do in order to create this new section? Try splitting the tag into two
elements.

Example 5.16. Splitting and Joining Tags

To Split Tags:

● Place the cursor where you want to separate the content.

● From the Menu Bar, select Edit > Split.

To Join Tags:

● Place the cursor where you want to separate the content.

● From the Menu Bar, select Edit > Join.

Here are the directions for splitting tags to add a new section:

1. Place the cursor after the first opening section tag (see below image).
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2. From the menu bar, select Edit > Split. A new section was added at the beginning of
Chapter 4 (see below image).

The opposite of splitting tags is joining tags, which is done by:

1. Without moving the cursor, from the ePlanning menu bar select Edit > Join. The two
items unite to become one.
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Important

Placement of the cursor is very important. If you split or join a pair of tags and do not get the
desired results, use the Ctrl + Z hot key command or the Undo button, then try moving the
cursor to a different location and attempt to split or join the tags again.

5.6.2.1.2. Selecting Content

There are times when you may want to select all of the content within a set of tags in order to
change/modify the group. For example, this can especially be useful for tables, lists, sections, etc.
that are multiple pages long. Rather than trying to highlight these lengthy sections by clicking
and dragging your mouse upward or downward, it is much easier to use the “select element”
or “select element content” option.

Note

To select the tag along with the content you can double click the opening tag or from the menu
bar, select Edit > Select Element (see image below). This can be done when your cursor is
anywhere within the tag.

Here are the directions to select all of the content within tags:

1. Put your cursor after the opening tag (see image below).

2. From the menu bar, select Edit > Select Element Content.

5.6.2.1.3. Replacing a Tag with Another Tag

In some areas of Arbortext, you can change certain tags to other types of tags, provided that the
alternate tags you wish to insert are valid to be placed in that location.
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Here are the directions to replace tags:

1. Place the cursor to the left of the tag you want to change.

2. From the ePlanning menu bar, select Edit > Change Markup or click on the Change
Markup button ( ) from theMarkup Toolbar. The change markup dialog box will
appear with the available options.

3. Select the interested tag and click OK.

4. If, by chance, you selected the wrong tag to insert and wish to reverse the change, then select
Edit > Undo from the ePlanning Menu Bar, or use the shortcut, Ctrl + Z.

5.6.2.2. Special Spacing Needs

There may be times when you want some text to appear just as you have typed it, or you may
want extra space in the document to make room for signature(s). Two options are available in
these situations. Use either the literallayout or the blockquote tags to accomplish these tasks.

Example 5.17. Using the Literallayout and Blockquote Tags

Literal Layout:

● Place the cursor where you want to use the Literallayout tag.

● Press the Enter button and from the context menu, select the literallayout option.

Block Quote:

● Place the cursor where you want to use the Blockquote tag.

● Press Enter and from the context menu, select the blockquote option.

5.6.2.2.1. Literal Layout

Definition of the literallayout tag: A block of text in which line breaks and white space are
to be reproduced verbatim.

While developing an Arbortext document, you may have a need to create extra vertical space
at certain places of your document. The easiest way to create extra white space is to insert a
<literallayout> element and add as many blank lines as needed. Also, the literal layout option
is useful for easily listing contact information in a document.

Here are the step-by-step directions to using the literallayout tag:

1. Place the cursor inside a set of para tags, where you want to use literallayout.

2. Press Enter and from the context menu, select the literallayout option.
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3. Press the Enter button in order to create additional blank lines inside of the literallayout
tags. The blank lines are preserved, so you’ll get as much extra space as you need (see
below image).

5.6.2.2.2. Block Quotes

Definition of the blockquote tag: A quotation set off from the main text.

Using the blockquote tags for addresses or anything that you want indented, without using the
basic orderedlist or itemizedlist tags, is a nice added feature.

With addresses, there are two ways to do this: one, by using a para tag, or two, using the
newline tag.

Here are the step-by-step directions to using the blockquote tag:

1. Place the cursor inside a set of para tags, where you want to use the blockquote tag.

2. Press the Enter button, and from the context menu, select the blockquote option.

3. Press the Enter button again, in order to select a set(s) of para tags to insert inside of the
blockquote tags (see below image).
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Within the blockquote tag, there are two ways in which users can add a new line for information:

1. From the ePlanning Menu Bar, choose Format > Touchup and select newline from the
drop down menu.

2. The alternative method to add a new line is to hold down the Shift key and click the Enter
key (see below image).

Below is an image of what the final result in a PDF preview of the examples described above.

January 1, 2013
Chapter 5 Arbortext Editor

Some Fundamental Tasks in AE



152 ePlanning Training Manual and
Reference Guide

Figure 5.1. End result in a PDF preview using the Literallayout and Blockquote Tags

5.6.2.3. Subscript and Superscript Tags

Understanding how to use the subscript and superscript tags is a fairly simple concept to master in
Arbortext. As many of BLM’s employees are scientists and engineers, and will likely contribute
to your project’s document(s), it’s important to learn how to use these tags in order to annotate
mathematical and scientific notations properly.
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To display the molecular formula for water, for example, use the subscript tag instead of simply
typing H2O. Many of you already know that, but you may not know how to write that formula in
Arbortext. With that in mind, let’s briefly examine how this is done.

Example 5.18. Using the Subscript & Superscript Tags

Use subscript and superscript tags to write scientific or mathematical notations.

Here are the step-by-step directions for using subscripts and superscripts:

1. To write the scientific formula for water, type H2O into Arbortext.

2. Next highlight the number two in that expression and press the Enter button.

3. From the context menu, select the Subscript tag option. The formula you typed should now
look like the following:

4. The end result is that the Arbortext content will look like this in a final document: H2O
Likewise, for writing the mathematical notation for ‘X’ squared, you would simply use the
superscript tag.

1. To write the mathematical notation for ‘X’ squared, type X2 into Arbortext.

2. Next, highlight the number two in that expression and press the Enter button.

3. From the context menu, select the Superscript tag option. The formula you typed should
now look like the following:

4. The end result is that the Arbortext content will look like this in a final document: X2

5.6.3. Modifying Font Sizes and Related Attributes

While the purpose of ePlanning is focused on streamlining documents such that they are
standardized and transparent, there may be instances where some content might want to be
emphasized a little differently than normal.

In the previous section, you may have noticed that the text size of the H20 and X2 end result
examples may be slightly larger than the sentence that preceded it. This can be done through the
use of touching up the fonts.

Here are the step-by-step directions for adjusting fonts:

1. Highlight the content that you would like to modify. In this example, let’s make the term
Grus americana larger and in a different font style.
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2. A Modify Font window will pop up. Let’s adjust the font size to 20 and choose a different
font style.

3. After clicking OK, the example text in this discussion (in the final document) will look
like this:

Grus Americana
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5.6.4. Clearing the Clipboard that is Linked to Arbortext Editor

If you are doing a lot of copying and pasting to the clipboard while working in a document in
Arbortext, be mindful that this clipboard can get full. Some users have experienced a freezing
effect in Arbortext Editor (AE). Arbortext uses the clipboard.exe file that Microsoft Office
programs also use. So, in a lengthy concurrent session of Arbortext where there is a lot of copying
and pasting of content, it is recommended to regularly check the clipboard in Microsoft Word.

To clear the clipboard while in Arbortext, go to Microsoft Word and view your clipboard. In the
Home tab, there is a “clipboard” ribbon. Expand the arrow in the bottom right of the ribbon. This
will open up a small side window where you can clear out the clipboard contents that Arbortext
also uses. See image below.

Note

This information is also in the ePlanning Community of Practice Sharepoint site.

5.6.5. Footnotes

Footnotes are an extremely important and useful option to use in Arbortext. As with other tags,
the footnote feature operates slightly different from other word processors. The footnote tags look
strange while in Arbortext, so this is another one of those occasions where you’ll have to trust
the stylesheets to display the information correctly. One useful feature of Arbortext’s footnote
feature is that you aren’t required to add the number for each footnote, all you have to do is trust
the system to keep track of numbers. The image below is an example of how a footnote tag looks
inside of Arbortext. In Arbortext, this is the correct way to add errata for a document. You
can have multiple lines inside of the footnote.
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The image below is the final output in a two column stylesheet that displays a footnote.
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Example 5.19. Basic Use of the Footnote Tag

Insert a footnote into a document.

Here are the step-by-step instructions for inserting a footnote into your document:

1. Identify a section of your document that a footnote is required, place the cursor there and
press the Enter button. Next, from the context menu, select the footnote tag. The image
below provides a definition of a “motorized vehicle” by using the footnote tag.
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2. Place your cursor inside of the footnote tags, which are now displayed on the screen, and
begin typing the information that you wish to appear in the footnote (see below image).

3. You have successfully created a footnote with specific text item. The below image is a PDF
rendition of what this footnote will look like.

5.6.5.1. Multiple References to a Single Footnote

So, now that the basic concept of footnotes is out there, what would you do for designating one
footnote to the many references, especially in tables such as in the image below?
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The answer to that question is to make use of the footnoteref tag along with the footnote tag.

However, just using the footnote tag in Arbortext when you have multiple references to the same
footnote would result in a table that looks like the image below:

Notice that the footnotes are repetitive. This is not the ideal way to add footnotes to this table.
There is another tag that can be used to reference a footnote that has already been identified. That
is the footnoteref tag. It is a cross reference tool to an existing footnote. The image below shows
the end result of using both the footnote and footnoteref tags in Arbortext.

This process is very similar to using cross-reference (xref) tags that are described in the basic
ePlanning course.
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Example 5.20. Use Footnote & Footnoteref Tags for Multiple References

Use the footnote and footnoteref tags to cite a single reference in multiple locations.

Using the example in the image above, let’s look at how those footnote and footnoteref tags are
used. We’ll start with adding the footnote tag. Here are the step-by-step directions for citing a
single reference in multiple locations:

1. Press Enter and select footnote.
2. A footnote number will appear between the footnote tags, and the cursor will be after

the opening footnote tag.
3. Type in the contents of the footnote (see example image below).

4. In the example we are using, Chinook salmon (King), Chum salmon and the Coho salmon
are all anadromous species. Therefore, the footnote we set up for the Chinook salmon
needs to also go with the Chum salmon and the Coho salmon. We don't want to have three
footnotes that say the same thing, so we are going to use a new tag that references the
anadromous fish species. Add a unique identifier in the id field (or use Ctrl + D to modify
the tag’s attribute). See image below.
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5. Now, we need to reference the footnote that we set up for the Chinook salmon, and link it to
the Chum and Coho salmon. The second reference to the same footnote uses the footnoteref
tag. Inside of the footnoteref tag, insert the unique id from the footnote tag in the linkend
field. See image below.
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6. In the original table, the footnote references were customized, they were “A” or “AR”
instead of the ePlanning-generated “a” or “b”. To customize the footnote reference
numbering, go to the modify attribute window for the footnote tag and enter the numbering
(or lettering) in the label field.
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7. This is the end result (image below).

5.6.6. Cross-referencing Using the xref Tag

Internal document links are used for a variety of reasons, to link text to tables, figures, maps, as
well as other sections to content in a document. This section will cover the most common internal
document link, a cross-reference. The xref tag is used to cross reference to another part of the
document. Since the xref tag automatically generates text, it will allow the system to track
numbers of tables, figures, etc.
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Example 5.21. Cross reference (xref)

Using the xref tag, create a cross reference in your "Purpose and Needs" section of your
Environmental Assessment document to a figure you have inserted.

Cross-references can be used for such items as:
● Tables
● Images
● Maps
● Sections or Chapters

Here are step-by-step directions to insert an image cross-reference in your document:
1. Place your cursor where you would like to add a set of Figure tags.
2. Press Enter and select the Figure tag.
3. Add a title to your figure.
4. Enter your image using both the Media Object and Image Object tags.
5. Place your cursor right after the opening Figure tag, and press Control+D.
6. TheModify Attributes window will open.
7. Type in a unique ID name in the id field (with no spaces or special characters in it).
8. Go to the other location in your document where you would like to place a link to your

cross-referenced image.
9. From within a set of paratags, press the Enter key. A list of valid markup options appears.
10. Select xref. TheModify Attributes form appears. In the linkend: field, enter the unique ID

for the object you entered for your image. The system will add the bring in the title for the
object you want to reference to.

11. Click the OK button.
12. Do a Compose of your document and select Web PDF-One Column to view your

document’s new image cross-reference.

Note

There can be no spaces in “ID” field. The recommended method is to use the title of the object
as the id. For example, create a naming convention within your office that will be easy to
distinguish files, such as, TABLEIdentifiedScopingIssues, or FIGUREsagegrouse.

5.6.6.1. Cross References and Links

Cross referencing internal and external document links and references are used for a variety
of reasons, including:
● Linking text to tables
● Linking text to figures, maps, and images
● Linking to other sections of a documents
● Linking to external websites
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5.6.6.1.1. Referencing Websites Using the Ulink Tag

In addition to linking to maps stored in Webtop, the ulink tag also gives you the opportunity to
link to websites.

Here are the step-by-step instructions to use the ulink tag for external websites:

1. Place a ulink tag around the content you want to link to.

2. In the URL field, type (or paste) the address of the external website to which you would
like to link.

3. Your text to be linked will now appear blue and underlined, and will be linkable to the
website you want to reference to.

5.6.6.1.2. Cross Referencing with the Link Tag

The link tag creates a hypertext link. With this form of cross referencing, the user generates the
text for the reference. This gives you a bit more freedom and flexibility with your reference,
but it's up to you to make sure that numbering remains consistent as your document evolves.
Therefore, just use this tag for internal document references.

Here are the step-by-step directions to use the link tag:

1. Give a unique ID (Crtl + D or Edit >Modify Attributes) to the item you will be referencing.

2. Place a link tag around the content you wish to cross reference.

3. Modify the attributes of the link tag and place the same value you gave to the ID in step 1,
above, in the linkend field.
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4. Your text to be cross-referenced will now appear blue and underlined and will be linkable to
the item to which you are referring.

5.6.6.1.3. IDs and ID References Dialog

With many authors working on large documents keeping track of all of the IDs could be a
nightmare. However, there is a tool in Arbortext that can be very helpful. Under Tools > IDs and
ID References..., the list of all of the IDs along with some extra information will be displayed
for the current document.
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Tip

The table is sorted based on the ID column by default. You can sort the table based on another
column by selecting the column heading. Sorting by the References or Element columns brings
any error messages in those columns to the top of the table.

Warning

If one ID is a duplicate of another ID elsewhere in the table, this column contains the error
message “DUPLICATE”. These will cause completeness errors and you most likely receive a
Fatal Error if attempt to compose a document that contains these “DUPLICATE” IDs.

To avoid this error near the completion of a document, review the IDs of the elements and make
sure that they are different from one another.

Description of Buttons in the ID References Window

Button Description
Moves the cursor to the element in the document that contains the selected ID. This button
is enabled when you select an ID in the ID table that is not missing from the document.
Moves the cursor to the next reference to an ID in the document. This button is enabled
when you select an ID in the ID table and there are one or more references to the ID after
the current cursor location in the document.
Moves the cursor to the previous reference to an ID in the document. This button is
enabled when you select an ID in the ID table and there are one or more references to the
ID before the current cursor location in the document.
Moves the selection in the ID table to the next ID with an error. This button is enabled
when the ID table contains errors.
Reloads the ID table. This button is enabled when you make changes to the document
after invoking the dialog box.
Closes the ID table.

Open the Arbortext Editor Help.

The ID references feature can be useful, especially when trying to troubleshoot your document.
When you run a completeness check, you may see the following error message:
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If you double click on the “show ids” link, the IDs and ID Reference dialog box will be
displayed. Notice in the next image (below), it is easy to see where the issue is.

Chapter 5 Arbortext Editor
Cross-referencing Using the xref Tag January 1, 2013



ePlanning Training Manual and Reference
Guide

169

If you highlight the error, which is labeled “MISSING”, then click the Next Reference button
your cursor will be moved to the location of the error.

January 1, 2013
Chapter 5 Arbortext Editor

Cross-referencing Using the xref Tag



170 ePlanning Training Manual and
Reference Guide

5.6.7. Additional Tips for Working with Maps

Maps are a very important part of BLM’s NEPA and planning documents. Since we manage
public lands, we must use GIS. In Chapter 11 of the basic training course, you saw how to get map
data that was created in ArcGIS, into ePlanning’s Back Office and Front Office, for the public
to use. This section will go a little more in-depth into an alternative method of using maps in
ePlanning, different from the process(es) taught in the basic ePlanning course.

Years ago, when discussing the path for version 2.0 of ePlanning, one of the requirements was
for the ability to create a List of Maps section, which was to be included in a document's Table
of Contents. There was no such element to start with in Arbortext (or more specifically, the
DocBook file in Arbortext), so the developers took the List of Figures element and modified a
similar tag to be a used for a List of Maps section.

As a result of that, there is an element in Arbortext called epl_map. This can be used to insert
static images, for example, maps that are saved in a PNG or JPEG format. However, there are
additional uses for the epl_map tag that might be useful. It can also be used for maps that have
been saved in a PDF format.
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5.6.7.1. Maps in an Appendix

What could you do if you find that your project has 100 or 125 maps? Instead of having the
epl_map tag throughout a large document, one useful option could be to put them all into an
appendix. Then, within the content of the document, you would have links to the appendix. This
was done for the ROD/ARMP for the Agua Fria National Monument RMP and the Bradshaw
Harquahala RMP. (see image below)

An Appendix of Maps From a Project in the Front Office.

How did we get there? We used the epl_map tag in the appendix. The title of the map, is linked
to the title field, which is inside of the ulink tag.

5.6.7.1.1. Using the epl_map Tag for Appendices

Example 5.22. Use the epl_map Tag in Your Document

Use the epl_map tag to insert a link to PDF maps into your document

The List of Maps generated for the Table of Contents for a document is pulled from the epl_map
element. Here are the step–by–step directions to use the epl_map element:

1. Find a location in your project to store all of your maps. Using the “GIS” folder in your
project in Webtop is a good place to start.

2. Import that map into your project library, such as that GIS folder. Make sure that it is
imported as an epl_map in the “type” field, during the import process.

3. Once the file has been imported, open the Properties: Info tab by right-clicking the file and
selecting “Properties” (see below image).

January 1, 2013
Chapter 5 Arbortext Editor

Additional Tips for Working with Maps



172 ePlanning Training Manual and
Reference Guide

4. Copy the “EPL Ulink URL”. This is a long link.

5. In your document, insert the epl_map tag. Notice that there is a title tag that appears. This
is the title information that is used in the List of Maps page. (see below image).

6. Enter the title of the map inside of the title tag. With your cursor just after the first epl_map
tag, press Crtl + D to bring up the modify attributes menu. Because maps may not always
appear in the numerical order of their numbering, you may want to override the automatize
numbering. In the label: field, enter the map number, for example, “2-4”. You do not want
to add the word "Map" since the DocBook element will do that for you.

Chapter 5 Arbortext Editor
Additional Tips for Working with Maps January 1, 2013



ePlanning Training Manual and Reference
Guide

173

7. After the title tag, click enter for a list of valid tags and select ulink. In the type field, enter
dctm and paste the EPL Ulink URL that you copied into the url field. See image below.
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8. The end result is that your screen should look similar to the image below.

The Maps Appendix in Arbortext.
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For the appendix to readMap 1. Agua Fria National Monument — Special Area Designations
and National Register District. We need to populate the xfreflabel field of the attributes for
ulink (modify attributes).

Tip

Using the method described above you will get a completeness error, “unexpected end tag
encountered”. More content is required. Another tag needs to be added. The easiest one is to
add the indexterm tag. for more information about how to do this please see Section 5.6.10.5,
“Index and Index Terms” (p. 213)

5.6.7.2. Maps That Are Not In An Appendix

If there are not a lot of maps in a document, you may not want to have an appendix for the
maps. Though, you may want to reference a map elsewhere in the document. You can still
use the epl_map tag to achieve this.
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From the example image above, the biggest thing to note here is that the epl_map tag is used
inside of the text of the document (near the top of the image), and is referencing a map further
downward on the page (near the bottom of the image).

To use this format, place the epl_map tag inside of the text of the document. See image below
for an example:
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Then, use the xref tag to reference the epl_map maps.
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5.6.8. Text Entities

Important

Text Entities should only be used at the master, parent document level. Otherwise the entities
may not transfer properly throughout the entire document.

One issue that the BLM has had with land use planning (in general) is keeping track of all of the
numbers of features and being consistent with those numbers. For example, the number of BLM
managed acres in Summit county of Colorado, needs to be consistent throughout the document.
Arbortext Editor has a tool to help with that task. It is called Text Entities.

An entity is a self-contained piece of data (also referred to as a “chunk” of data) and can be
referenced as a unit. Entities can contain text, such as a boilerplate paragraph, or numerical
values that are used throughout a document. Entities provide an easy way to incorporate often
repeated characters, phrases, or paragraphs within a document; or to bring in separate units of
information (for example, graphics or external files).

Once an entity has been defined, the value of the entity can be changed in one place to have it
updated throughout the entire document. After you insert a text entity, it appears as a single
markup icon representing the text entity. You can view the contents of your text entities within
your document by choosing View > Text Entities from the Arbortext Editor menu bar.
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5.6.8.1. Creating a New Entity in Arbortext Editor

Example 5.23. Creating a New Entity in Arbortext Editor

Create a new text entity in Arbortext.

Here are the step-by-step directions to create a text entity in Arbortext for an ePlanning document:

1. Open the your document in Arbortext.

2. Click Entities > Text from the menu bar.

Tip

If the Entities menu option does not appear on the menu bar, you can display all of the
available menu options by choosing Tools > Preferences, selecting theWindow category,
and make sure the Full Menus option is checked (see below).

3. The Text Entities window appears (see below).
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4. Click the New button. The New Text Entity window opens.

5. In the Name field, type in a unique entity name. The name must be single term (no spaces).

6. In the Content field, type the value of an entity. The content information can be a single
word, a phrase, or in this case, a number (see below image).
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Important

An entity value will be consistently displayed anywhere it has been inserted into the
document, and if the value of the entity is changed, the change will update all inserted
instances of the entity in the document.

7. Click OK. The entity has been defined and it is available to all users who are authoring or
editing the document via the list of entities in the Text Entity window (see below)
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8. Click Close. You have now successfully created a text entity. The next section details
how to insert that entity into your document.

5.6.8.2. Inserting an Entity in Arbortext Editor

Here are the step-by-step directions to insert an entity that has already been defined into the
document:

1. Place the cursor at the location in the document where you would like the entity value is to
be inserted. In the example below, the text in highlighted in black.
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2. Click Entities > Text from the menu bar. The Text Entities window appears showing
the list of available text entities.

3. Select the entity to insert into the document, and then click Insert. The entity is inserted
into the document at the location where the user placed the cursor.
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The acres value of “70,900” is now denoted in green indicating it is a text entity.

4. To view the entity as markup, click View > Text Entities to unselect the check mark for that
menu option. The text entities will appear as a tag instead of text.

5.6.8.3. Modifying an Entity Value in Arbortext Editor

Use the following steps to modify an entity value that has already been put into the document:

1. Click Entities > Text from the menu bar. The Text Entities window appears displaying the
list of previously defined entities.
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2. Click the text entity to be modified.

3. Click theModify button. TheModify Text Entity window appears. Change the value
of text entity in the content field

4. Click OK to save the changes. This text entity will be updated, in every spot it was
referenced in the document.
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By clicking on the Find button, you can see the next place the entity exists and see that it has
been updated.
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The Count Uses button shows you how times each text entity is used in the document.
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5.6.9. Content Re-use

There is no reason to recreate some content that is used in many BLM documents. For example,
every RMP has a glossary, acronyms, list of applicable laws, why start that section from scratch?

Re-using content is an important tool for building planning documents. ePlanning users can, for
example, link a local office’s standard guidelines document to all NEPA documents for the office.

These re-usable documents can be kept in the main Asset Library within Webtop (or in an asset
library for your office). Once it is in there, reference documents, or even sections of a reference
document, can be linked into a other projects, as needed.

5.6.9.1. Types of Re-Usable Document

Keep in mind that there are two types of re-use available for users:

● Duplicate: This means a copy of what was selected will be added to your document. The
content is static, once it has been copied over into your document. You will be able to edit the
content, as needed.

● Reference: This means a linked version of the reference content will be added to your
document. This content will be dynamic, which essentially means if a change is made to the
original reference content, that change will appear in your own document. You will not be
able to edit this content in your document.
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Warning

Using this feature entails the use of multiple Arbortext windows. A very important thing to
remember when using this feature is DO NOT confuse the windows around. It is critical to
remain aware of the Arbortext windows and note one window as the document you are actually
working on, and note the other as the referenced content.

It might be useful to take advantage of re-sizing windows to keep things straight. For example,
place the window for the document that you are editing on the left side of the monitor, and
place the window that contains the reference document on the right side of your monitor.

Just for clarity in this section, the planning document that you may be working on will be called
the “working” document, and the document that would be re-use will be called the “reference”
document. The basic process for utilizing the content re-use feature is listed below:

1. First, open up, for editing, the working document in Webtop.

2. Once that working document has opened in Arbortext, keep that window in the background
or to the side. In the Webtop window, find the reference document and open it up as “read
only”. See image below, for example.

3. In the reference document, copy the sections you wish to use in your own working document
(use Ctrl + C, or Edit > Copy).

4. In the working document, paste the content using Ctrl + V, or Edit > Paste.
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5. A window will appear giving you the option to Duplicate or Reference the information.
See image below. Choose the option that best fits your needs. Refer to the information
above that discusses the two types of content re-use.

Note

The content re-use feature between Arbortext documents works best with text content.

Re-usable content that contains images, tables, or figures may not copy over correctly. In this
case, copying those images and re-inserting them manually will be required.

5.6.10. Making Your Document Complete

In the following section, you will learn some more techniques for making your document look
more complete. Most of these other features pertain to the document’s "Back Matter", which
include items such as, glossaries, acronyms, bibliographies, and indexes.

5.6.10.1. Appendices

Adding appendices to a document is very easy. Appendices are, essentially, added at the end of
a Chapter tag.

Appendices are automatically lettered, rather than numbered. Though, under the appendix, all
sections, figures and tables are all numbered according to the appendix letter. See the example
image below.
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Appendices will appear in the Table of Contents, as well as List of Tables, List of Figures,
if there are any.

5.6.10.2. Glossary and Glossary Terms

A glossary is an alphabetical list of terms in a particular area of knowledge with the definitions for
those terms. Traditionally, a glossary appears at the end of a book and includes terms within that
book which are either newly introduced or at least uncommon.

In the "old" days, glossaries were static documents. It was incumbent upon the reader of the
document to flip to the glossary section of the document to 1) determine if a term was defined
and 2) to read its definition.

In ePlanning, you can create a smart glossary that enables the readers of your electronic
documents (either electronic PDFs or Interactive Documents) to link directly from a glossary term
to its definition. This can save a reader time and make large documents more user friendly. In this
section, we will teach you how to take advantage of smart glossaries.

The best way to tackle a glossary in Arbortext is to create the glossary first, then "tag" glossary
terms. You'll learn how to create the glossary, then tag glossary terms, and finally, there will
be some tips on best practices for a glossary.

In addition to creating a glossary from scratch, in this section, you will also learn how to use
the basic glossary that is available in the ePlanning Asset Library, which is done by copying
and modifying it to meet your unique needs.

There is another option available for glossaries, which is to use a standard glossary from the
Asset Library. Even if you use the glossary from the Asset Library you will need to add some
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terms to it specific to your project. Therefore, it is important to know how to create and add
entries to a glossary.

5.6.10.2.1. Creating a Glossary and Adding Glossary Terms

Example 5.24. Create a Glossary and Adding Glossary Terms

Create a glossary and add glossary terms to your project’s document.

Note

The stylesheet feature will automatically alphabetize glossaries for you.

Here are the step-by-step directions to create a glossary:

1. Place your cursor in the location in which you would like the glossary to appear. In most
cases, you'll want to make sure that this is at the end of your document. A good rule of
thumb is to place your cursor just inside of the "Book" end tag. In the example below, the
Glossary will be placed between Chapter 3 and the end of the book tag.

2. Once your cursor is placed, click Enter to reveal the list of acceptable tag elements for this
location. Glossary should be a valid choice.

Chapter 5 Arbortext Editor
Making Your Document Complete January 1, 2013



ePlanning Training Manual and Reference
Guide

193

3. Select Glossary from the list. A set of Glossary tags (containing a set of title tags) will
appear (see below image).

4. Give your glossary a title.

5. After giving your glossary a title (by typing the name of your glossary between the title
tags), you can begin adding terms to your glossary. In Arbortext, a glossary is comprised of
Glossary Entries. Each Glossary Entry is made up of a Glossary Term and a Glossary
Definition. We will work with each of these tags below.

6. First, place your cursor between the closing title tag and the closing glossary tag and click
Enter. A small list of acceptable tag entities will appear. Choose Glossentry from the list
(see below image).

7. Your glossary should now be populated with one entry. The glossentry tag will contain a
set of glossterm tags. Type the term within the glossterm tag. In the example below, the
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glossary term to be defined is "Glossary." The text of your glossterm will appear in blue
and will be underlined (see below image).

8. Next, you will add the definition to your Glossary Entry. Place your cursor between the end
glossterm tag and the end glossentry tag and click Enter. From the tag list, choose glossdef.

9. A set of glossdef tags will appear after the closing glossterm tags. Within the glossentry
tag, begin typing the definition within the glossdef tags. You'll notice that a set of para
tags automatically appear. In the sample below, the definition of glossary has been added
to the glossdef tags.
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5.6.10.2.2. Shortcut for Creating a Glossentry

You can speed up the glossentry process by creating a glossentry with the associated glossterm
and glossdef tags prior to populating them. Follow these two steps to create a glossentry:

1. Once you have the empty tag set, simply copy the whole glossentry (see below image).

2. Then, paste it at the end of the glossentry (see below image). Repeat as needed to create
several glossary entries and to save time when adding your terms and definitions.
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5.6.10.2.3. Making the Glossary Term Linkable

Now that you have created a glossary, added a glossary term, and defined its associated definition,
let's take advantage of the powerful linking tools that are available to us in Arbortext Editor.
By using these linking tools, you can make your web documents very user friendly. For the
electronic PDF or the interactive document, readers can simply click on a glossary term in the
body of the text which they are reading and be taken directly to the glossary list and definition.
A few steps are needed to do this, however...

Note

The linking tools described below for glossaries are also the foundation for successful creation
of bibliographies, cross references, and acronyms. Once you get the hang of this process, you
can apply it to many other areas within your document(s).

A glossary does not need to be within an appendix.

The process of making the glossary terms linkable is the same as using the xref tag. The glossary
term in the glossary needs a unique ID and then the linkend is used through out the document to
tie the glossary term to the glossary.

Place your cursor anywhere inside of the glossterm tag.
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Choose Edit >Modify Attributes from the Menu bar, or Ctrl + D from your keyboard. The
Modify Attributes window will open.

Here, you will give your glossary term a unique identifier such that this identifier located in the
body of your document can link to. It is recommended that a common nomenclature be used for
glossary terms, for example, "Gloss" followed by the term itself. In this example image below,
the term is "Glossary." This unique identifier should be placed in the id field of theModify
Attributes window, with no spaces. Give your term a unique identifier, as in the image below.

Note

It is recommended that a common nomenclature be used for glossary terms such as "Gloss"
followed by the term itself. Later, when working with acronyms, you may want to use the
nomenclature of "Acronym," "Biblio" for bibliography entries, etc.
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Click OK after you have given your glossary term an unique ID.

Next, we will consider the glossary term in the document itself and, how to link it directly
to your glossary

5.6.10.2.4. Identifying Terms to be Placed in the Glossary

Now that you have created your glossary and added your terms, you can link the terms from the
body of your document to the glossary itself.
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In the body of your document, find the location of a term you've placed in the glossary and
highlight that term. In the example below, the term in question is "glossary."

Once your term is highlighted, click Enter and chose glossterm from the list of applicable tags.

The word will now be in underlined blue font and will be flanked by the glossterm tags (see
below image).

January 1, 2013
Chapter 5 Arbortext Editor

Making Your Document Complete



200 ePlanning Training Manual and
Reference Guide

Note

To complete the link to the term listed in your glossary, place your cursor anywhere inside of
the glossterm you just created (or highlight the entire glossterm entry) and open the modify
attributes window (Recall, there are two ways to do this, either by choosing Edit >Modify
Attributes from the Menu bar, or Ctrl + d from your keyboard).

Now, in the linkend field, type the same value you placed in the id field of the glossary entry (in
this example, it was "GlossGlossary").
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Click OK.

Now, when a web PDF or interactive document is produced, terms linked to the glossary will
appear in blue and will be linked to the glossary (see below image).
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You will need to add a glossterm tag and the appropriate linkend value for each occurrence of a
term you wish to link to the glossary.

Tip

If you wish to link every occurrence of a term (as opposed to just the first occurrence) with
the term and definition on the glossary, it may be best to wait until you are complete the your
document to link to your glossary. Using the search tools in Arbortext, you can search for each
occurrence of the term in question and add the glossterm tag and linkend value.
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Be careful with the Replace With field. Make sure the entire contents of the tags are included.
You don't want to spend the time adding the glossary term through out your document only to find
out it was incomplete thus bad. Check the box to Match Markup and the actual code will be added
rather then the text that shows up within the field.

5.6.10.3. Acronym List and Acronyms

Similar to a "smart glossary," you can create a smart acronym list in Arbortext. We will use
the same foundations we used to create a glossary to create an acronym list. Acronyms are
abbreviations that are formed using the initial components in a phrase or name. A list of acronyms
may be placed at the end of a document for reference purposes. In Arbortext, an acronym list is
essentially a different type of glossary. The Acronyms do not need to be in an Appendix.

5.6.10.3.1. Creating an Acronym List and Adding Acronyms

Example 5.25. Adding a Acronym List and Acronyms

Add an acronym list and acronyms to your project’s documents

Here are the step-by-step directions to create an Acronym List and Acronyms:

1. To start, you will follow the same steps you utilized to make a glossary. In the example
below, a new glossary tag is being placed immediately after the closing tag for the glossary
created in the previous section of instruction (see below image).
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2. In the title tag of this second glossary, add your Acronym List title. for example, you may
want to keep things simple and call it "Acronyms".

3. Building your list of acronyms is similar to building your list of glossary terms. First,
add a glossterm tag. Then, add an acronym tag by placing your cursor in between the
two glossterm tags, clicking enter, and choosing acronym from the list of valid tags (see
below image).
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4. Type your acronym between the Acronym tags. In the example below, we'll work with the
acronym "BLM" (see below image)

5. Now that you have created your acronym entry and have added your acronym, you can now
add the definition of your acronym the same way you did for glossary definitions. Place
your cursor after the end glossterm tag, click Enter, and choose glossdef from the list
of acceptable tags. Type your definition between the glossterm tags. The para tag will
automatically be added (see below image).
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6. As with regular glossary entries, you may want to save some time by creating a generic
acronym entry, copying it, and pasting it for as many entries as you need (see below image).

5.6.10.3.2. Making the Acronym Linkable

By now, you should have recognized several similarities between creating a glossary and creating
an acronym list using Arbortext Editor. The similarities will continue for making your acronym
terms linkable to actual acronyms in the body of your document. Let's see how that would work.

Here are the step-by-step directions to make acronyms linkable:

1. Place your cursor anywhere inside of the acronym and choose Edit >Modify Attributes
from the Menu bar, or Ctrl + d from your keyboard.

2. Here, you will give your acronym a unique identifier to which terms located in the body
of your document can link. As with glossary terms, coming up with a nomenclature is a
good idea. We recommend that you use the prefix of "Acronym" for each acronym id you
create. This unique identifier should be placed in the id field of theModify Attributes
window, with no spaces.
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3. Click OK after you have given your acronym a unique ID.

5.6.10.3.3. Identifying Terms to be Placed in the Acronym List

You have created your acronym list and added your terms. Here are the step-by-step direcitons to
link the terms from the body of your document to the acronym list itself:

1. In the body of your document, find the location of an acronym and highlight it.

2. Once your term is highlighted, click Enter and chose acronym from the list of applicable
tags. The term will now be in blue font and will be flanked by the acronym tag.

3. Select the complete acronym tag and hit Enter. Select glossterm.

4. To complete the link to the term listed in your acronym list, place your cursor inside of the
glossterm tag you just created and open theModify Attributes window (recall, there are
two ways to do this, either by choosing Edit >Modify Attributes from the Menu bar,
or Ctrl + d from your keyboard.
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5. Now, in the linkend field, type the same value you placed in the id field of the acronym
entry (in this example, it was "AcronymBLM").

6. Click OK.

Now, when a web PDF or interactive document is produced, terms linked to the acronym list will
appear in blue and will be linkable to the glossary.

Note

You will need to add an acronym tag and the appropriate linkend value for each occurrence of
a term you wish to link to the acronym list.

Tip

Just as with the Glossary, if you wish to link every occurrence of a term (as opposed to just
the first occurrence) with the term and definition on the acronym list, it may be best to wait
until you have completed your document. Using the search tools in Arbortext, you can search
for each occurrence of the term in question and add the acronym tag and linkend value.

5.6.10.4. Bibliography and Bibliography Entries

A bibliography is an important part of your documentation and can be complicated. In Arbortext
Editor, as with Glossaries and Acronym Lists, you will create them in a similar fashion. The
bibliography or references cited do not need to be within an appendix. There are several ways
to achieve the steps outlined above. For now, we will discuss the simplest method to add a
bibliography. Some direction will be abbreviated when steps are similar to those taken for
glossaries and acronym lists. A biblioentry can contain several different types of elements and
can contain your reference needs depending on the reference style you use and the characteristics
of each reference. The tags/elements that can be placed in each biblioentry include:
● abbrev: An abbreviation, especially one followed by a period.
● abstract: A summary of content.
● address
● affiliation: The institutional affiliation of an individual.
● author: The name of an individual author.
● authorblurb: A short description or note about an author.
● authorgroup: Wrapper for author information when a document has multiple authors or
collaborators.

● authorinitials: The initials or other short identifier for an author.
● bibliomisc; For bibliographic information that does not fit neatly into the other bibliographic
fields (such as Author and Publisher).

● biblioset: The purpose of this wrapper is to assert the relationship that binds the collection.
For example, in a BiblioEntry for an article in a journal, you might use two BiblioSets to wrap
the fields related to the article and the fields related to the journal.

● citetitle: The title of a cited work.
● collab: Identifies a collaborative partner in a document. It associates the name of a
collaborator with his or her Affiliation.
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● contractnum: Occurs in bibliographic metadata and contains information about the contract
number of a contract under which a document was written.

● contractsponsor: Contains information about the sponsor of a contract under which a
document was written.

● contrib: Contains a summary or description of the contributions made by an author, editor,
or other credited source.

● copyright: Holds information about the date(s) and holder(s) of a document copyright. If
an extended block of text describing the copyright or other legal status is required, use
LegalNotice. The Copyright element is confined to meta-information. For copyright
statements in running text, see Trademark.

● corpauthor: In documents that have no specific authors, but are credited as authored by a
corporation, the CorpAuthor tag can be used in place of the Author tag to indicate authorship.
This element is used in bibliographic metadata.

● corpname: The name of a corporation.
● date: The date of publication or revision of a document.
● edition: Contains the name or number of the edition of the document.
● editor: The name of the editor of a document.
● honorific: The title of a person.
● firstname: The first name of a person.
● indexterm: IndexTerms identify text that is to be placed in the index. In the simplest case, the
placement of the IndexTerm in the document identifies the location of the term in the text.
In other words, the IndexTerm is placed in the flow of the document at the point where the
IndexEntry in the Index should point. In other cases, attributes on IndexTerm are used to
identify the location of the term in the text.

● isbn: The International Standard Book Number of a document.
● issn: The International Standard Serial Number of a periodical.
● issuenum: The issue number of a periodical.
● orgname: The name of an organization other than a corporation.
● othercredit: A person or entity, other than an author or editor, credited in a document.
● othername: A component of a persons name that is not a first name, surname, or lineage.
● pagenums: The numbers of the pages in a book, for use in a bibliographic entry.
● pubdate: Date of publication of a document.
● publisher: Publisher of a document.
● revhistory: History of the revisions to a document.
● seriesvolnums: Numbers of the volumes in a series of books.
● subtitleSubtitle of a document.
● surname - A family name; in western cultures the last name.
● title - The text of the title of a section of a document or of a formal block-level element.
● titleabbrev: The abbreviation of a Title.
● volumenum: The volume number of a document in a set (as of books in a set or articles in
a journal).

5.6.10.4.1. Creating the Bibliography and Adding Entries

Example 5.26. Create a Bibliography and Add Entries

Create a bibliography for your project’s document.

Here are the step–by–step directions to create a bibliography and link to entries in your document:
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1. In your document, press Enter and place a bibliography element somewhere between
the end of your content chapters.

2. Place your cursor in between the bibliography tag, press the Enter button and select the
biblioentry tag.

3. Place your cursor in between the biblioentry tags, press the Enter button and select the
bibliomisc tag. When a bibliography is built on XML like the image below.

4. Within the bibliomisc tag, type your reference.
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To make this entry linkable to a reference in the body of your document, you will need
to add a unique id to the entry. Instead of identifying the bibiloentry, however, you will
place the id at the bibliomisc level (placing it at the biblioentry level will add the id text to
your entry). To do this, make sure to highlight just the bibliomisc portion of your entry,
or place your cursor to the right of the bibliomisc tag. ThenModify Attributes and give
a unique ID to your entry. It is recommended that bibliography entries use the following
nomenclature: "Biblio" + Author's Last Name + Publication Year. Whatever naming
convention you use, keep it consistent.

5. Before linking to the entry, you will give your entry an abbreviation to make searching for it
easy. To do this, place an Abbrev tag between the beginning biblioentry and beginning
bibliomisc tags.

6. Within the abbrev tags, type the parenthetical reference that you will use in the body
of your document. In this example, the parenthetical reference will be "Doe 2009"

7. Now, you will need to give a unique ID to the abbreviation. In this example, it will be
"AbbrevDoe2009".
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So, now your bibliographic entry has two unique Identifiers -- one for the overall entry and one
for the abbreviated entry. Each unique identifier will be needed when you link from the body of
your document to the bibliography.

5.6.10.4.2. Making the Bibliographic Entry Linkable

Here are the step-by-step directions to link a reference in your document to the reference entry
in the bibliography:

1.
Place the reference inside of a set of citation tags

2. Then, place the content of the citation into a pair of xref tags. A Modify Attributes
window will open.

3. In the endterm field, type the ID for the abbreviation you created in your bibliography (In
this case, it's "AbbrevDoe2009").

4. In the linkend field, type the ID you created for the entire biblioentry (In this case, it's
BiblioDoe2009)(see below image).
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5. Click Ok

When your document is rendered for the web, it will look like this:

5.6.10.5. Index and Index Terms

An index is a detailed alphabetical listing of names, places, and topics along with the numbers
of the pages on which they are mentioned or discussed, usually including in or constituting
the back matter. It can also be considered a sequential arrangement of material, especially in
alphabetical or numerical order. You can easily create an index in ePlanning. For an index, you
do not need to use the ID and Linkend rules that we have been working with for glossaries,
acronym lists, and bibliographies.
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5.6.10.5.1. Creating an Index and Adding Terms

To create an index in Arbortext Editor, place your cursor in the location where you would like
your index to appear and insert the index tag from the list of tag elements available. Unlike
Glossaries, Acronym and Abbreviation Lists, and Bibliographies, you do not need to place index
terms into the index. You simply need to identify index terms in the body of your document and
they will automatically be populated in the index when your document is rendered.

Example 5.27. Creating an Index and Add Index Terms

Create an index and index terms of your document.

Here are the step-by-step directions to create Index terms to be placed in the index:

1. Place your cursor immediately to the left or right of the term you would like to place in
the index.

2. Choose indexterm from the list of available tags.

3. An indexterm tag will appear next to the term you wish to place
in the index. In this example. The index term is ePlanning.

T-
he indexterm tag will be automatically populated with a primary tag.

4. Type the name of the index term within the primary tags

5. You can also add a secondary tag or see also tag inside of your index term (see below
example).

The index terms may not immediately show up in your index but when you render the document,
they will. Your rendered document will look like this:
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5.6.11. Miscellaneous Advanced Information

5.6.11.1. Tag Templates

Use Tools > Tag Templates to create and insert frequently used sets of tags and content. Tag
templates can insert sets of instructions or a partially filled-in list that you want to use repeatedly.
You can also use them to create tables in which you only need to add cell information. If you
create a tag template by highlighting a table, the tags surrounding the table image, such as table
tags, must be included.

To view the current Tag Templates, select Tools > Tag Templates from the menu bar and the Tag
Template.xml will appear.

5.6.11.1.1. To Create a New Tag Template

You must have Full Menus turned on to access Tools > Tag Templates. If Full Menus is not
already on, go to the Tools > Preferences dialog box and choose theWindow category and
then check Full Menus box.

Example 5.28. Creating a New Tag Template

Create a new tag template to use in your project’s documents.

Here are the step-by-step directions to create a new tag template:
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1. In your document, insert or find the tags that you want to use as your template.

2. Highlight the tags to be used in the template.

3. From the menu bar, choose Tools > Tag Templates.

4. In the Tag Templates dialog box, click the New button to open the New Tag Template
dialog box.

5. Enter a unique name for the template in the Name text box. The highlighted markup and
content appears (in ASCII form) in the Content list box.

6. Choose a path from the Store template in path list where you want to save the tag template
file. The saved template file has the extension .tpl.

7. Click OK to return to the Tag Template dialog box (see below image).

Now if you look at the Tag Templates you will see that a new tag template has been added.
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Important

Since everyone can use tag templates it might be a very good idea to store your tag templates in
a unique location. There are a number of default locations and, it would be a good idea to save
them on your desktop so they will remain in tack.
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5.6.11.1.2. To Insert a Tag Template

1. In the Edit window, place the cursor in a valid location for the template.

2. From the menu bar, choose Tools > Tag Templates. The Tag Templates dialog box appears.

3. In the dialog box, select the template name from the Templates list by clicking on it.

4. Click on Insert. The template appears at the cursor location.

5. Use Find to seek NEPA and clicked Insert (see below).

Chapter 5 Arbortext Editor
Miscellaneous Advanced Information January 1, 2013



ePlanning Training Manual and Reference
Guide

219

6. After the Insert, now NEPA is an identified hyperlinked acronym (see below).
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5.6.11.1.3. To Delete a Tag Template

It is very easy to delete a tag template, just follow these steps:

1. From the menu bar, choose Tools > Tag Templates. The Tag Templates dialog box appears.

2. Select the template name from the Templates list by clicking on it.

3. Click Delete.

5.6.11.2. Distinguishing Between Dashes and Hyphens

Starting with Arbortext Editor Version 5.4, a feature with hitting the dash key, quickly, in
Arbortext Editor will cycle through some different choices. Pressing the dash key will cycle
through three different versions of a dash. The first click is the em-dash, second is the hyphen and
third is the en-dash.

● Click anywhere in a paragraph and press the hyphen key. The initial type of dash is
context-sensitive. For example, if you insert a single dash between letters, you get a hyphen.
If you insert a single dash between numbers, you get an en-dash. By pressing the hyphen key
a second and third time, you cycle through all the available dashes. If you press a fourth time,
you return to the initial selection.

From Wikipedia:

A dash is a punctuation mark. It is similar in appearance to a hyphen, but a dash is longer and it is
used differently. The most common versions of the dash are the en dash (–) and the em dash (—).

5.6.11.2.1. Hyphen or Figure Dash

The figure dash (-) is so named because it is the same width as a digit, at least in typefaces with
digits of equal width.

The figure dash is used when a dash must be used within numbers. This does not indicate a range
(for which the en dash is used), or function as the minus sign (which also has its own glyph).

5.6.11.2.2. En Dash

The en dash, or n dash, n-rule, etc., (–) is usually half the width of an em dash.

The en dash is used in ranges, such as 6–10 years, read as "six to ten years".

5.6.11.3. Quotation or Inverted Comma

Quotation marks or inverted commas are punctuation marks used in pairs to set off speech, a
quotation, a phrase, or a word. They come as a pair of opening and closing marks in either
of two styles: single (‘…’) or double (“…”).

In Arbortext, you’ll notice that, much like the section above, the single or double quotation marks
have a feature where you can cycle through the type of mark you would like to use.
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You can test this out in Arbortext by simply pressing the key for the quotation marks quickly to
see the choices.

5.6.11.4. Processing Instructions

Processing Instructions (PIs) are information for the application. PI's allow documents to contain
instructions for applications. Like comments, they are not textually a part of the XML document.
And, they can be placed almost anywhere in a document

In Arbortext Editor (AE), PI tags always start with an underscore (“_”), which usually prevents
name collisions with elements. PIs are a form of content re-use. Many of the templates in the
Asset Library contain PIs. Once the Export Info to Document has been ran, the PIs are stripped
out of the document. However, you can go into almost any document and re-add more PIs.

If the PI refers to a repeating attribute, the replacement text will include each attribute value
separated by a comma character by default. If a different separator character is desired, specify
the delimiter=’?’ string within the PI, where ‘?’ represents any character. Project repeating
attributes are identified in the following table by the inclusion of a delimiter string within the
attribute PI definition.

How to Insert Processing Instructions into Arbortext Editor

There are a couple of ways in which to add PI to your XML document. One way is to, copy from
another source and then paste it into you document. The other way is to use the Insert Markup -
Advanced Arbortext in AE. Here are the two ways to enter a PI:

1. When copying from another source such as this document, the PIs will look like this,
<?dbfo table-width="120%?>. When pasted into AE the same PI will look like this,

.

2.
From the Markup Toolbar, select the insert markup tool ( ). The Insert Markup -
Advanced Arbortext menu will come up. In theMode: field select PIs (see below image).
Select pi and click the Insert button.
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3. The Insert Processing Instruction form will come up. Type in the PI and click the OK
button. The PI will appear in your document.
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Tips with Working with Processing Instructions

● PIs can go into any EPL Document (epl_doc).

● Must have the metadata field EPL Document Type populated. See the document, EPL
Workflow Details.xls, found in the Asset Library (Cabinets/Asset Library/Document
Templates/Standard Templates/Planning and NEPA Documents Templates), for a complete
list of valid entries.

● The project metadata field, EPL Project Export Document Type, must match the document
metadata field EPL Document Type for the Export Info to Document to work.

5.6.11.4.1. Comment Analysis Processing Instructions

These processing instructions are for bringing in the comment analysis from CommentWorks
into AE.

Table 5.2. Comment Analysis Attributes

Project Metadata Export Processing Instruction (PI) Project Schedule Form Field Name
<?epl.start_comment_analysis?> Start the placement of the comment analysis

information
<?epl.end_comment_analysis?> End of the placement of comment analysis information

An example of using the Comment Analysis is shown in Figure 5.2, “Comment Analysis
Example” (p. 223).

Figure 5.2. Comment Analysis Example
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Example 5.29. Using Processing Instructions Demo

There is a trick to adding in the repeating start tags. The epl.start must be placed before the
row tag. You cannot see the row tag while in WYSIWYG (What You See Is What You
Get) window of AE, instead you need to change the way the table tags are displayed. To
do this go to the View > Tables > Table Mark Up. It is not pretty however, it is the best
way to view the code so the PI's will work properly.

The good news there is a Tag Template available for the List of Preparers. Add the a
table for list of preparers

Table 5.3. List of Preparers

Name Role Discipline

Example 5.30. Exercise — Updating the List Of Preparers

1. Add the table from the Tag Templates for the list of Preparers.

2. Do it again but only select out the roles; Team Lead and Author. An example was
given under Project Team Definition Attributes Example Processing Instructions.
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6.1. Introduction

When a team member has completed a document (or a portion of the document), the next step of
the ePlanning process will be to send out the document for review. Hence, this chapter will show
you how to send out your document(s) for reviews to fellow team members. Also, this chapter
will describe the document review process utilizing the “enabled for comments” PDF method.

6.1.1. Objectives

Upon completion of this chapter, you will be able to:
● Create a review package for the document that will be reviewed.
● Enable the annotations feature for the PDF in the review package.
● Send the review package to team members.
● Utilize the reviewing tools for a comment-enabled PDF.
● Review comments from team members.

6.2. Beginning a Peer-to-Peer Review

The Peer-to-Peer review is conducted in an informal way during document preparation to keep
peers or counterparts informed about what is being written in a specific section or to get feedback
about the whole document. For a Peer-to-Peer review, an author could build a PDF of their
sections of the document and send that PDF to their selected peer(s) or counterpart(s) in the office
or at another organizational level (the District or State Office, for example).

Note

If you want to create a review of the entire document you must assign yourself all areas from
the “Task Assignment” screen prior to creating your review.

Example 6.1. Creating a Peer-to-Peer Review Package

● Navigate toMy Authoring Tasks or the Task Assignments Screen and find the
project that will be reviewed.

● Highlight the sections you want included, right click and then select the Create
Review option from the Context Menu.

● Create a review title, select the individuals who will review the document, and assign a
due date.

Here are the step-by-step directions for creating a Peer-to-Peer review package:
1. In Webtop, navigate to and click onMy Authoring Tasks or the Task Assignments Screen.
2. Select the project and specific document using the filter fields near the top of the Display

Pane. If you are in the Task Assignments Screen highlight the sections you want included,
right click and then select the Create Review option from the Context Menu.

3. Left-click to select the document section(s) that you want reviewed. To choose multiple
sections, simply hold down the shift button on your keyboard while choosing the desired
sections.
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4. Now right-click in the highlighted area to call forth the Context Menu, and select the
Create Peer Review option (see image below).

5. Another window will open with the Create Review Package form (see image below). This
form has several required fields that must be entered.

6. The Review Type drop-down box should default to "Peer Review."
7. The Review Title allows you to enter a name for your review package. Call it something that

makes sense, but be careful not to use special characters (such as a back slash or forward
slash) in the name of your package. Like many other software programs, Webtop sees
these slashes as path names, which will prevent your review package from being created
successfully.

8. The list of selected document objects appears in the Selected Document Objects. The
following rules apply to creating a review package:
● Only sections from a single document can be added to a review package.
● Sections of the document may be removed from the list by selecting them from the list
and clicking on the Remove button to the right of this Selected Document Objects
section.
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9. In theMandatory Reviewers and Additional Reviewers fields, add individuals to the review
package by clicking the Add button next to the appropriate box.

Important

The Team Leads must add themselves as a mandatory reviewer along with their team.

When the Add button is clicked, the User Chooser form will open. ePlanning can send the
review to ePlanning users, BLM people who are not ePlanning users (BLM Active Directory
Users), and/or people external to BLM system.
● If the review is for BLM staff who are also ePlanning users, choose "ePlanning System
User" in the User Type: field. Then, in the field next to User/Group Name:, type in their
last name and click on the Search button. One or more possible name selections will
come up in the lower portion of the window.

● To add a Reviewer, click the Select link next to the name of the individual.
● If the review is for BLM staff who are not ePlanning users, choose "BLM Active
Directory User" in the User Type: field. Then, in the User/Group Name: field, type in
their last name and click on the Search button. One or more possible name selections
will come up in the lower portion of the window. Select the user by clicking the select
link next to the individual's name.

● If the review is for a non-BLM person, choose "Non-BLM Active Directory User" in
the User Type: field. Then, in the User/Group Name: field, type in the name that will
appear in the TO: line of an incoming email. Next, enter their email address in the
Email Address field. Click on the Add button to insert their name in the Reviewer list.

10. Choose a due date by clicking on the calendar button to the right of the Due Date field and
clicking on the date (see image under step 5).

11. If you choose to add an attachment, the document must be located in the ePlanning Webtop
content manager.

12. When the required fields are filled in, you may add instructions to reviewers in the
Additional Instructions field. When the fields have been completed in the Create Review
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Package form, you can click on the Finish button to create the review package and initiate a
Document Review workflow.

Note

Reviews can be sent to any combination of user types listed above. Everyone will receive the
same review package. The difference will be in how the author compiles the comments into a
single comment document.

Also note, if the review package is being sent to individuals outside of ePlanning and exceeds
the file size of 5 megabytes, the BLM's email system will reject it. Large documents will need
to be broken up into small pieces, which can be completed by selecting sections for review
instead of the whole document.

6.3. Document Review Workflow

When the review has been created, the Document Review workflow will be initiated. The first
step in the workflow will be to enable comments on the PDF file that was created for the review.
The person who created the review package will get a task in their own Inbox to “Enable
Annotation” (see image below).

This alerts the Team Lead that the document they are sending out for review has been prepared to
accept comments from Reviewers using Adobe Acrobat Professional.

From your Inbox, navigate to the message titled “Enable Annotation”. Open that message up by
clicking on that message name. Now FINISH THE TASK (by clicking on the Finish button) IN
YOUR INBOX! ePlanning will now send the review package to the Reviewers that you have
identified and send them an email that a review is waiting for them.

6.4. Commenting on a Review

At this point, the focus shifts from the sender/preparer of the review to the identified reviewers.
The information below shows the steps for conducting a review.
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Tip

It is very important to note (as described below) that to comment on a review, the reviewers
only need to DOUBLE CLICK ON THE PDF.

This will ensure that all comments from multiple users are easily consolidated into one version
of the document, instead of different versions of the document.

DO NOT check out (Edit) the PDF when reviewing and adding comments.

6.4.1. Reviews from Interdisciplinary Team Members (who have
access to ePlanning)

The reviewer will receive an email and a task in their ePlanning Inbox, alerting them to the
review request (see image below).

Example 6.2. Conduct a Review

● Navigate to the Inbox and open the new message for “Review”.
● Open the review folder in the lower half of the message and click on the name of the
review document.

● When Adobe Acrobat opens, begin utilizing the commenting tools for the review.
Make sure to synchronize your comments by clicking the Send and Receive
Comments button.

● When the review is complete, close the window and finish up the “Review” task in
your Inbox.

Here are the step-by-step directions for conducting a review:
1. Navigate to the Inbox, and look for the message titled “Review”. Open that message and

examine the details within.
2. In the lower-half of this message, click on the review folder. This will open up the review

package in the project folder.

When you click on that folder, it opens to reveal the actual review PDF. You will also see
an XML document, which contains processing instructions for the PDF. Ignore this XML
document.
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3. Double Click on the name of the PDF file to begin commenting and review. Do not open
in edit mode!

4. Enter comments into the file using the feature available from the Comment & Markup
on the far right hand side of your screen.

5. Make sure that the Send and Receive Comments button is clicked.

This will send the comments back to the server where the document came from and will
allow:
● Many reviewers to comment simultaneously.
● Reviewers to see comments that are sent when the comments synchronize.
● ePlanning to automatically compile all the comments into a single comment document.

6. Once the review has been completed, the window for the review can be closed. There is
no need to save the file, as clicking the Send and Receive Comments button records all
of the comments that were made.

Once the reviews have been completed, the original sender of the review can summarize all the
comments and determine how to address the issues. If the author desires another peer review after
the document is revised, he/she can initiate another review in the same way the original review
was conducted by assigning a new review to that same audience.

6.4.2. Reviews from Interdisciplinary Team Members (who may
not have access to ePlanning)

Documents can be sent to team members for review who may not have access to ePlanning. To
do this, send a review package via their personal email (as an attachment) to a non-BLM Active
Directory user.

The Reviewer will receive the review package in their regular email. As mentioned earlier in this
chapter, ePlanning is subject to the same 5 MB file size limitation as email users for the BLM.
Some review packages may exceed this, though it would be unusual for a Peer Review to do so.

Individuals receiving a review through an outside email account will receive a PDF file that has
been enabled for commenting. The file can be reviewed using Adobe Acrobat Reader. The
reviewer will open the file and insert the comments they wish to make, and when finished, the
file will have to be saved. With the comments included, the file can be emailed back to the
sender of the review. See the subsection below for further information on consolidating multiple
reviewed documents.

Note

If several reviewers were sent documents and the author (sender) expects several reviews back,
make sure those PDF files that are returned have unique names such that they do not overwrite
other documents. For example, one suggestion might be to append the reviewers initials after
the file name (and before the .pdf) to distinguish between files.

6.4.2.1. Consolidating Reviews from Multiple PDFs into one Document

The following information only applies if multiple PDFs were sent and returned to the peer
reviewer.
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Multiple PDFs can be imported along with all of the comments and placed into one consolidated
document that can reside in the ePlanning system.

Here are the step-by-step directions for consolidating multiple PDFs.
1. Navigate to the PDF file created for the review.
2. Right-click on the PDF file name and from the Context Menu select the Edit option.
3. The PDF file will open in Adobe Acrobat Professional. When it is open, click on the

Comments menu.
4. In the Comments menu, choose the option to Import Comments.

Note

For this process to work easily, the files that are to be imported must be saved locally.

5. A navigation window will appear, which will allow for the PDF files with comments
to be located.

6. Select all the files by holding down either the shift or control keys and clicking on the
subject files with the mouse pointer.

7. When all the files are selected, click the Select button.
8. All of the comments have now been brought into the single PDF file in ePlanning. Save the

file with the imported comments.
9. The original PDF that was checked out for editing should be brought back into the system

through the Check In option.

Once all review comments have been received, the author can use Adobe Acrobat Professional to
summarize the issues and revise the document in Arbortext, as needed.

6.5. Print PDF to Include Comments using Adobe Acrobat Pro
from Citrix Metaframe

Follow these steps to print the PDF with reviewers' comments:

1. Go to Citrix Metaframe and click open Adobe Acrobat Pro

2. Click File on the above menu bar.

3. Select the Open option and search for the PDF you want to print that includes reviewers'
comments.

4. Click on the Comments tab.

5. Click on the Print with Comment Summary... option. The screen will refresh and a
Summarize Options box will open.

6. Select a print choice such as Document and comments with sequence numbers on
separate pages.

7. Then click on the Print Comment Summary button.

8. Your printer choice screen will appear, then select your printer and press OK.
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6.6. Comment Response and Revision

When all comments have been combined into one PDF document on the ePlanning server, the
Author can review the comments by opening the document in Adobe Acrobat Professional.

When the document is opened, the Author can see all the comments that have been compiled by
clicking on the Comments List button on the lower left hand side of your screen.

By displaying the comments in the document, additional comment options are available, which
include:
● Finding where the comment is in the document and jumping directly to it.
● Tracking the status of the comment.
● Replying to the reviewer detailing how the comment was (or will be) managed.

6.6.1. Response and Revision

An author can begin revising their document, as appropriate, and reply to reviewers comment(s)
in the Adobe PDF file. By selecting a particular comment and clicking on it, several tools become
available in the tool bar for this comment list section.

Two items that may be of interest are the Set Comment Status and Reply to Selected Comment
tools.

6.6.1.1. Setting Comment Status

If the Set Comment Status tool is selected, a Review sub-menu option becomes available.

Options under the Review sub-menu include:
● None: the status for all comments to begin with.
● Accepted: the Team Leader could use this to identify comments that will be resolved.
● Cancelled: this might be used for comments that were received but, through further
discussion, were later removed by the original reviewer.

● Complete: this could be used for comments that have been resolved through document
revision.

● Rejected: this could be used for comments that will not be addressed.

6.6.1.2. Replying to Selected Comments

The other useful item in Adobe Acrobat is the Reply to Selected Comment tool.

When a particular comment is selected/highlighted, you can click on the Reply to Selected
Comment icon and a sub-thread will open up below the original comment, which will allow for
additional notes to be added.

6.7. Revising the Arbortext Document

Revision to the NEPA document can be completed by checking out (Edit) the document in
Arbortext, making the changes, saving the document, and then checking it (Check In) back
into the ePlanning system.
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6.7.1. Working with the “Author Rework” Task (if necessary)

In Peer-to-Peer and Interim Reviews, ePlanning reviewers may also choose to click on the Reject
button in the review task that shows up in their Inbox, which initiates an "Author Rework"
workflow.

When a Reviewer rejects the review activity, the Author will need to revise the document (or
sections) as indicated by the comments in the review PDF.

Here are the basic steps for “Reworking” a document:
1. Navigate to the Inbox. The “Author Rework” task appears for the review package that

was created (see image below).

2. Open the “Author Rework” message and review the details within. A link to the review
package folder also appears in the lower part of the message.
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3. Click the Review Package folder and open the PDF file inside by clicking on the name of
the file. Review the comments that were made.

4. Navigate to the sections of the document that require changes. Edit the document in
Arbortext, save the changes, and return the sections through Check In.

5. When all of the changes have been completed, click the Inbox in the Navigation Pane.
6. Complete the Author Rework task by opening the message up and clicking the Finish

button in the lower-right part of the screen.
7. Click OK on the confirmation screen. The ePlanning system automatically generates a new

review package with the new content from the modified sections. The Author Rework task
is completed and removed from the Author’s Inbox. Another review workflow is initiated
and the steps described in the sections above are repeated.

6.7.2. Submitting the Work to the Team Lead

When the revisions to the sections are completed, the Author can complete the related workflow
item(s) in the Inbox and navigate toMy Authoring Tasks to select the Submit to Team Lead
button for that project. This will notify the Team Lead that the assigned sections for that
individual have been completed.

Here are the step-by-step directions for completing the work for reviews:
1. When Authors have finished with their assigned sections, they can select those items inMy

Authoring Tasks.
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2. Right-click on the document section(s) that have the task status of “Authoring”. The
document section(s) appears as selected and a series of options become available from the
context menu.

3. From the Context Menu select the Submit to Team Lead option. TheMy Authoring
Tasks screen will refresh and the selected document section(s) are removed from that project.

4. The status of the sections are set to "Submit to Team Lead" and the Team Lead can be
notified that those sections have been completed. Once submitted, the team member will be
locked out of the document.

Important

The task cannot be submitted to the Team Lead, if the document (or section) is checked
out, for editing. Be sure to Check In the document back intoWebtop before submitting
to the Team Lead.

6.8. SUPPLEMENTAL INFORMATION

6.8.1. Interim Review Workflow and Second Way to Create a Peer
to Peer Review

When a review package is created, it initiates an ePlanning workflow that tracks the steps involved
in the review. An Interim Review, unlike a Peer to Peer review, is designed to be conducted at
different BLM organizational levels as needed. The review package is sent to one person (an
ePlanning user identified with a particular role in the project's Team Definition) who will then
distribute the review package to whomever is responsible for program lead reviews at that level.

For example, a review for the State Office is sent to the State Office P&EC. That person gets
notification of a review request in their ePlanning Inbox. They are responsible for establishing
the protocols for how the review will be conducted in that office, notifying the staff of who will
review the document, and to assure their comments are returned to the project's Team Lead. There
are a number of ways a review of this nature could be done and best practices will probably
emerge with more system experience.

Here are the basic steps in an Interim Review:
1. Send the review package to people who will coordinate review at various organizational

levels (an automatic step).
2. Reviewers provide comments using Adobe Acrobat.
3. The Team Lead collects the comments into a single document.
4. The document is revised based on comments.
5. If the Author wants the document to be reviewed again, the review cycle can be repeated.

If not, the review can be ended.

6.8.1.1. Interim Reviews

The second review type that would be commonly conducted with basic NEPA documents is an
Interim Review. Typically, these reviews are conducted in a little more formal method than a
Peer-to-Peer Review as a way to get the involvement of the Field Manager (or higher).
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For this type of review, the Team Leader would create a PDF of the document or document
sections for which review is required, and send it to their Field Manager and/or others. When a
planner at a higher organizational level receives an Inbox notification of the review, the PDF files
can be distributed out to the reviewing staff for commenting in Adobe Acrobat. Comments would
be made and compiled in the same way as the Peer-to-Peer Review.

Here are the step-by-step directions for creating an Interim Review:
1. Navigate to the virtual document in the project folder.
2. Right-click on the virtual document name, then from the Context Menu select ePlanning >

Document > Task Assignments (see image below).

3. Select the document, or the sections, by left-clicking on them (to select multiple sections,
hold down the shift key while choosing the desired sections). Now, right-click on the
selected sections to call forth the Context Menu and select the Create Review option (see
image below). This is also where you could create a Peer to Peer review as well.
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4. The Create Review Package form will appear. This form has several required fields that
must be selected, which will determine the type of review (see image below).

5. The Review Type will be defaulted to “Peer Review”. Change this to "Interim Review".
6. Enter a name for the review package in the Review Title field.
7. The list of selected document objects appears in the Selected Document Objects list box.
8. This review differs slightly from a Peer-to-Peer Review in that, instead of choosing the

Reviewers as described earlier in the chapter, the Field Office Manager, District Office
Planner, and State Office Planner, andWashington Office Planner can be identified here.
These individuals would be identified through the Team Definitions menu for a project. See
Chapter 3, for more information.

Note

People included in the project's Team Definition do not have to be ePlanning users.
However, only ePlanning users can be recipients of this type of review package.

9. See below image for more detail.
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Choose a due date by clicking on the calendar button to the right of the Due Date field.
10. When the required fields are filled in, the Author may choose to add instructions to

Reviewers in the Additional Instructions dialogue box.
11. When the form has been filled out, click on the Create button to create the review package

and initiate a Document Review workflow for the Interim Review.
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7.1. Introduction

This chapter will cover basic stylesheets available in ePlanning. The stylesheet you apply to your
content will dictate the look and feel of your document. For example, you can create a document
with one or two columns, a simple document without a table of contents, publish to a web site
with/without the ability for commenting, or create an interactive document. This chapter will also
cover creating a build(s) for your document or various parts of a document to view or publish.

7.1.1. Objectives

Upon completion of this chapter, you will be able to do the following:

● Have an understanding of stylesheets and the stylesheet options, what they are, and why
they are used.

● Be able to create various builds of your document(s) and know where they are stored in
your project.

7.2. Stylesheets

In ePlanning, there is a separation of the content entered from its presentation format. This
separation of the content provides more flexibility and control in the specification of the
presentation characteristics and reduces the complexity and repetition in the content. There is
no need to reformat the content of your documents for the various output formats, such as PDF,
Interactive Document and/or CD-ROM. Content is entered once and is presented in different
styles for different viewing methods. The presentation of the content or document depends on
which stylesheet is applied.

Stylesheets contain a variety of commands that dictate how a whole document or selected
portions will be formatted. For example, Authors can select stylesheet items for their XML text,
such as one or two column(s), New Times Roman and 12 pt. This means that no other column
selection, font style or other stylesheet option will be used. Stylesheets help publications maintain
consistency. Common elements such as text, bulleted lists and headings always appear the same.
One of the goals of ePlanning is a common look and feel for all documents presented on the web
for public viewing.

7.2.1. ePlanning Stylesheets

Currently, in ePlanning we have seven different stylesheets (see below).
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Table 7.1. ePlanning Stylesheet Descriptions

Project Stylesheets Stylesheet Options Description
Federal Register Build
Stylesheet

Print PDF-Federal Register Meets the EPA requirements for Federal Register
notices.

Interactive Document
Build Stylesheet

EPL Web Publication This is the HTML version of a document that is
interactive. These documents are for the web and
CD-ROM.

Complete-Print PDF-One
Column

One column document. Includes Cover, Table of
Contents, List of Figures, List of Maps and chapter
pages. Front matter, such as the Table of Contents, Dear
Reader letter, will not be two columns. Hyper links will
not be visibly identifiable however, they do work.

Complete-Print PDF-Two
Column

Two columns. Includes a Table of Contents, List of
Table, List of Figures, List of Maps and chapter pages.
Front matter, such as the Table of Contents, Dear Reader
letter, will not be two columns. Hyper links will not be
visibly identifiable.

Print PDF Build
Stylesheet

Simple-Print PDF Informal printing, no Table of Contents, no chapter
pages, no cover page, etc. Used for short documents
such as DNAs or CXs.

Web PDF - One Column Same as the Complete-Print PDF-One Column. Hyper
links are visible and they work.

Web PDF Build
Stylesheet

Web PDF - Two Column Same as the Complete-Print PDF-Two Column. Hyper
links are visible and they work.

7.2.2. Selecting Project Stylesheets

Only one type of project stylesheet can be active at any given time. Authorized project user
permission will dictate which roles can change a project's stylesheet. The following roles have
permissions to change a project stylesheet:
● P&EC
● NEPA Project Creator
● Project Administrator
● Editor

Example 7.1. Select a Stylesheet for the Project

Using the directions below, select the stylesheets for your project.

Note

If you want to select a “Complete Print PDF One Column” type stylesheet (which is most
commonly used) the defaults are automatically preset for you and you need not continue.

Here are the step-by-step instructions on how to select a stylesheet for your project:
1. Navigate to the project, either through the ePlanning Projects Cabinet or, if you had saved

it under Subscriptions, go to Subscriptions.
2. Highlight the project.
3. Right click on the highlighted project Select ePlanning Project > Manage Style Sheets.
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The project stylesheet form will then appear with fields for selecting the default project
stylesheets that will be used for creating published renditions of your documents (see
below). You can click on the Preview button to preview a sample document where the
selected stylesheet (but it won't be your document).

4. Click OK to select the stylesheet. The stylesheet is now set for the project.

7.3. Builds

A build in ePlanning refers to the process of transforming the authored XML content into an
ePlanning-published format, such as HTML or PDF. Builds are different than Compose, as builds
are saved in your project library. Documents created in Arbortext and posted on ePlanning web
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pages are pulled from the Build folder in your project library. Only documents that have a build
can be published to web pages. ePlanning users with the following roles can create builds:

● Author

● Editor

● NEPA Project Creator

● P&EC

● Project Administrator

● Team Lead

7.3.1. Creating a Document Build

For the purpose of this course, we will create two builds, an Interactive Document build and
a Print PDF build. We need the Interactive Document build because we have created an EA
project that will need a commenting period.

Note

Reminder: Project Web Sites are used for those projects which require a comment period. If
your project does not require a comment period, use a Project Summary Web Site.

Public commenting is completed on Interactive Documents. Therefore, if you are have a
comment period on a document, you need to generate an Interactive Document build as well as
a corresponding Print PDF.

Example 7.2. How to Create a Build of your Document

Using the directions below, create a build of the project's document.

Here are the step-by-step directions for creating a document build:

1. Go to your project at the folder level and then highlight the project.

2. Then right click the highlighted project and then select the ePlanning Project > Manage
Builds option.
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3. The Manage Project Document Builds screen appears (see below image). And then, under
the Filter by Document: menu, select Environmental Assessment.

4. Then press the New Build button (see above image).

Now that you know how to create a new document build, you will now create your first required
document build: an Interactive Document build.

7.3.2. Creating the First Required Build: An Interactive
Document Build

Here are the step-by-step directions for creating an Interactive Document build:
1. Click the New Build button.
2. Under the Build Title: select a title for your Interactive Document (see below).
3. Under the Build Type: select Interactive Document (see below image) (see below).
4. Under Sections: press the Edit button (see below).
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5. Check the box to the left of the Document sections that are to be included in the document
build (see the image below). You can select each section one-at-a-time, select the whole
document, or sections and associated sub-sections. Selecting the box to the left of
Document Section will result in all of the document sections being included.

6. Then press the Select button. The check box labeled Include Children? is the default,
which means all of the children under that chapter will be included in this build.

7. Once the screen refreshes, press the Create button.
8. Now, proceed to the next section to create the second required build.
9. Refresh this screen, which you can do by clicking on the Apply Filters button, until you

have a status of “Done” for the build you have just created.
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7.3.3. Creating the Second Required Build: Print PDF

Here are the step-by-step directions for creating the Print PDF build:
1. Click the New Build button.
2. Under the Build Title: select a title for your Print PDF.
3. Under the Build Type: select Print PDF.
4. Under Sections: press the Edit button.
5. The screen will refresh and then you must select the document section(s) that you wish to

include in your Print PDF.
6. Press the Select button.
7. Once the screen refreshes, press the Create button.
8. Refresh this screen, which you can do by clicking on the Apply Filters button, until you

have a status of “Done” for the build you have just created.

Note

When you have verified that both builds are completed, with a status listed of Done (see image
below). Close out the ePlanning Webtop page and proceed to the ePlanning Back Office login to
add your project to the NEPA Register.

There are four possible statuses for each build created:
● Requested: a request has been sent to the publishing engine to generate a document. The new
folder in created in the Builds folder and the XML instructions are placed in that new folder.

● Started: The Publishing Engine has executed the request to generate a document.
● Done: The Publishing Engine has rendered the document and put the appropriate document
type in the Builds folder (PDF or zip).

● Error: If you receive this error message, go back to your document and perform a
Completeness Check and look for possible errors such as open ulinks, anchors and incomplete
cross-references. These are the most common types of errors that could have occurred. If you
still have problems then conduct a more thorough review of your ArborText content.

7.4. The Build Directory

The very first time a build is created, a Builds sub-folder is created within the project.
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This is where you will find all of the builds that were created within a project. For each build that
is created, a new folder is created within the Builds folder. The name of this new folder comes
from the information entered in the Build Title field when the new document build was created.

If you click on one of the folders in the Builds sub-folder, there are two files that will appear
within that folder.
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Depending upon the build type, PDF or web, a PDF file or a zipped file will be added to this folder.
In the example above, the build type was PDF thus there is a PDF file in the folder. The second
file is an XML file that the system created so it could generate the document build you requested.

Note

You should not do anything with this XML file!

Tip

When a build is being generated, the first step within the system is the creation of the XML file
associated with the build. The second step is the document type that is created. One thing to
check is to see if the build was created properly, if you don't see the second file, either the build
has not been completed or something went wrong. Also, if the PDF created is only 1 KB in size,
either, the build is not finished or it failed.

7.5. PDF 508 Compliance

7.5.1. 508 Compliance

Follow these steps to make your project’s build’s PDF 508 compliant:

1. Go to your project’s builds folder.

2. Navigate to your build PDF, right click on the PDF and select edit .

3. This will open your document in Adobe Pro 10 (check to be sure your language is set
to English by clicking on File in the main menu, Properties and then clicking on the
Advanced tab then click OK).

4. Click on View>Tools>Accessibility from the menu options, then under Aceessibility on
the right side of your screen select Full Check and then click on the “Start Checking” and
“OK” button. Then select Add Tags to Document, and TouchUp Reading Order Click on
the “TouchUp Reading Order” box at the top and drag it out of your way so you can view
your document and the Accessibility Report.
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1. Your Accessibility Report will appear on the left hand side of your screen (see below image).
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2. Now scroll down your Accessibility Report until you find your Detailed Report with
Errors, if you have no Accessibility errors your document is compliant (skip to step 12).

3. To correct your errors simply click on the error link for each error in order. This will take
you to your error in your pdf document. Once you are taken to the figure that says “No
alternative text exists”, right click on the figure and select Edit Alternate Text.

4. This will allow you add the alternate text necessary to make that portion of document 508
compliant. Type in your desired text and clickOK. Repeat this process as often as necessary.

5. Once all corrections have been made (or if you did not have any). Click the Close button
on the TouchUp Reading Order menu. See image below:

6. To ensure nothing was missed, go back and click on Full Check if you have no errors come
up then click Save and close out of the PDF document and Check In the document as the
next version, else repeat these steps from the beginning.
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7.5.2. Filter by Status

The Filter by Status drop-down list will display all of the current document build statuses (from
the Arbortext Publishing Engine).

7.5.3. Manage Project Document Builds Buttons

From the Manage Project Document Builds window, you can highlight a build and then right
click on that build to pull up its build options (see below image).

There are 5 build options, which are:

1. View Details: opens the Document Build Details window to display the build's details.

2. View Build: takes you to the actual build so you can open it for viewing

3. Delete Build: deletes the selected build.

4. Rebuild: rebuilds the selected build with the same options as the first time it was built.

5. Modify Build: allows you to make changes to a build that has already been created. This
would be used in cases where you wanted to add more sections of the document for the
build or change the build type, etc.
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8.1. Introduction

This chapter covers the functionality of both the Back Office (BO) and Front Office (FO).
The Back Office deals with the creation and maintenance of websites. The Front Office is the
information that is published to the Internet, which is where the public interacts with the BLM's
interactive documents (this is also where the public goes to comment on documents that have
open comment periods).

8.1.1. Objectives

Upon completion of this chapter, you will be able to:
● Create a Project Web Site.
● Administer and maintain a Project Web Site from Back Office.
● Understand and interact with Front Office's final and public view of a Project Web Site.

8.2. Back Office

Now that we have two builds with a status of “done” for our NEPA project, it is now time to
log in to the Back Office. The BO is where:
● Webpages are created and maintained.
● NEPA and LUP Registers are populated.
● Comment periods are set-up.
● ePlanning users can enter comment letters, supporting documents, and/or additional maps
to their project web pages.

For the purpose of this course, we will create a Project Web Site so our NEPA project will have
a public comment period. Under SUPPLEMENTAL Information at the end of this chapter,
the procedure for creating a Project Summary Web Site is provided, which is the web site for
NEPA projects that do not require a commenting period. Four types of web pages can be created,
which are:
1. NEPA Project Web Sites.
2. NEPA Project Summary Web Sites.
3. LUP Project Web Sites.
4. LUP Plan Web Sites.

Table 8.1. ePlanning Website Types

Webpage Type Description Comment Period
Allowed

NEPA Webpages
Project Website This type of website is typically for EISs or, larger EAs

that are going to have a public comment period(s).
Yes

Project Summary Website This is the simplest ePlanning webpage. This website type
is for DNAs, CXs, and EAs. This type's Web pages show
the who, what, where, and when. Additionally, it provides
a link to the document.

No

RMP Webpages
LUP Project Website This type's webpages are used when working on a RMP. Yes
LUP Plan Website This type of webpage is used for land use plans after the

ROD has been signed.
No
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8.3. General Information

The ePlanning Back Office is accessed from the Citrix MetaFrame. And, a separate login is
used for the BO. Even though some people will only be using BO, they will still need to be an
ePlanning user.

8.3.1. Accessing the Back Office

The process for accessing Back Office is the same as opening up Webtop in ePlanning, which is:

1. Log into the Citrix Web Interface, and then click on the Training ePlanning Back Office
icon.

2. The ePlanning Back Office login page will open (see below). Then use your BLM Active
Directory login and password.

8.3.2. Back Office Navigation

After you have logged into BO, your BO's homepage will be displayed (see image below). Also,
you can see that the user has not yet created any websites for any NEPA or RMP projects. Once
you start creating websites, the display pane will show all active projects.
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8.3.2.1. Understanding the Back Office Homepage

Breadcrumb: Use this for path navigation while in the BO.

Yellow Text: The menu item that is related to the current application is displayed in yellow,
all others are displayed in black. In the screen shot shown above, the current application is
displaying the BO's homepage.

Site Navigation: This section displays links within the BO, which will change depending upon
where you are within the application. For example, as soon as you create a website, a Site
Administration link will show up towards the bottom of the navigation pane. Additionally, when
you are working on developing and/or maintaining a website, the site navigation section for
that particular website type will be displayed.

Display Pane: This section displays links to your active project(s) when you are on the BO
homepage.

Other Useful Information (circled in red in the graphic above):

● User: This shows the name of the user who is logged into the BO.

● Help: This displays a link to the BO's help system. When clicked, an HTML page opens in a
new window displaying the BO Help, with the top of the page being the topic related to where
you are in the BO when you clicked Help (content sensitive help).

● Logout: Closes all BO related browser windows.

January 1, 2013
Chapter 8 Back Office and Front Office

Back Office Navigation



262 ePlanning Training Manual and
Reference Guide

8.3.2.2. Understanding Webpage Status Indicators: Colors & Definitions

Depending on the publishing stage of a project, the webpage status indicator displays a specific
color. The three stages are described below.
● Red: The Back Office page content has just been created and/or differs from the Front Office
website, or has not been approved by the Public Affairs Representative.

● Yellow: The page content in Back Office has been approved by the Public Affairs
Representative, but has not been synchronized with the Front Office website.

● Green: The Back Office page content has been approved by Public Affairs and all metadata
has been synchronized with the Front Office website.

Table 8.2. Back Office Webpage Status

Indicator Description
A red light means the website has been modified and/or has not yet been approved for
publication to the Front Office. As soon as a project is added to a NEPA or LUP Register,
the BO will create the appropriate webpage(s). Though, there will not be any content in any
of the pages and the indicator will be set to red.

A yellow light means the site content has been approved by a Public Affairs person, but the
content has NOT been published to the Front Office website.

A green light means the website is up to date and the content has been published to the
Front Office website.

8.4. Adding Your NEPA Project to the NEPA Register

The first step in working in Back Office is to add your project to the NEPA Register.

Example 8.1. Adding a Project to the NEPA Register and Creating a Project Web Site

● Log in to Back Office and click on the NEPA Register link.
● Click on the NEPA Register's green Add link.
● You will then be taken to the Add NEPA Web Site page.
● Find your NEPA project from the Repository Project drop down list.
● Under the Display Site As: drop down box, choose Project Web Site.
● Click the Add button in the bottom right-side of the screen.
● You will receive a message window notifying you that your NEPA Project Site has
been successfully created.

● Click the OK button within this message.
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8.4.1. Adding a Project to the NEPA Register

Here are the step-by-step directions for adding your NEPA project to the NEPA Register:

1. Log in to Back Office and click on the NEPA Register link.

2. Click on the Land Use Planning and NEPA Register's green Add NEPA link for all
NEPA projects or click the green Add LUPlink for all LUP projects. (see below image).

3. You will then be taken to the Add NEPA Web Site page (see below image). Find your
NEPA project from the Repository Project drop down list.

4. Under the Display Site As: drop down box, choose Project Web Site.

5. Click the Add button in the bottom right-side of the screen.

6. You will receive a message window notifying you that your NEPA Project Site has been
successfully created (see image below). Click the OK button within this message.

7. Your screen will refresh and you will see your newly created Project Web Site (see image
below).
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8. Click on the Documents link in the Navigation Pane on your Project Web Site.

9. Click on the Documents green Add button (see below image).

10. The Add — Project Document screen will appear (see below image).
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Note

Now you must select the two builds (i.e. Interactive Document and Print PDF) that you
created so they can be added (one at a time) to your Project's Web Site. Again, an Interactive
Document must always be accompanied by a PDF (i.e., Print or Web). Follow the below steps
to add both builds.

8.4.2. Adding The Interactive Document Build

Here are the step-by-step directions to add the Interactive Document Build:

1. Under Document Name on the Add — Project Document screen, select a name for your
Interactive Build PDF (see below Step 3 image).

2. Select a Release Date.

3. Then press the Document Renditions: green Add link (NOT THE ADD BUTTON AT
THE BOTTOM OF THE PAGE!).

January 1, 2013
Chapter 8 Back Office and Front Office
Adding The Interactive Document Build



266 ePlanning Training Manual and
Reference Guide

4. The screen will refresh and update to show you the Add — Project Document —
Rendition screen.

5. Under the Rendition Type: drop down, select Build (see below image).

6. Under the Build Rendition: drop down, select your Interactive Document Build.

7. Press the Add button at the bottom right-side of the screen. The screen will refresh and you
will see that your Interactive Document Build has been added (see below image).

8.4.3. Adding The Print PDF

Here are the step-by-step directions to add the Print PDF to your Project's Web Site:

1. Click on the Document Renditions: green Add button (NOT THE ONE AT THE
BOTTOM OF THE PAGE!) to add the Print PDF.
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2. Under Rendition Type: select Build (see below Step 3 image).

3. Under Build Rendition: select your Project's Print PDF (or Web PDF if used).

4. Press the Add button at the bottom of the page. Your screen will refresh and you will see
your two builds added to your Project Web Site (see below image).
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5. Now press the Add button at the bottom of the page (see below image).

6. Your screen will refresh and you will see two link icons on the Project Web Site for both the
Interactive Document and the Project PDF (see below image).
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8.5. Enhancing the Project Web Site

Now that the Project Web Site has been created and the appropriate documents have been added,
the web site must have information added prior to seeking approval from the public affairs office.
Using the built-in text editor in Back Office, you can enhance the links (such as Home, Contact
Information, and How to get Involved) located in the navigation pane.

Example 8.2. Utilizing the Text Editor

Use the Text Editor to add some content to the Home link.

Here are the step-by step directions for using the text editor to add content to your site:

1. Click on the Home link in the Navigation Pane of the Back Office (see image below).

2. Click on the Edit link that is on the right, next to the red circle, as noted in the image above.
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3. This opens up the text editor box allowing you to add additional information to the Home
page for the project that you created (see image below).

Note

Some additional notes regarding the text editor:

● At this moment, you cannot upload a photo from within the text editor.

● It may be useful to utilize the Home link to describe how to use the interactive
document format, optimal display settings, and preferred browsers for viewing the
documents.

4. When the content has been added in the body of the text editor, you can save that information
by clicking on the floppy disk icon as noted in the image below.

This process can be repeated for the other related links, such as Contact Information or How to
get involved, in the Navigation Pane of the Back Office program.
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8.6. Submit Web Site for Public Affair's Approval

Here are the step-by-step directions to submit your web site to the Public Affairs for approval:

1. Click on the Submit Changes for Approval link (see below image).

2. The Submit Changes for Approval screen will refresh (see below image). This Submit
Changes for Approval link will begin the process for submitting your Project Web Site to
the Public Affairs Officer for approval.
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3. Select the project's designated Public Affairs Reviewer from the drop-down box.

Note

If you do not see a Public Affairs Reviewer in the drop down box (see image above),
go back to your project in Web Top and add a Public Affairs person under your Project's
Team Definition tab. In addition, this person must be an ePlanning user.

4. Click the Submit for Approval button.

8.7. Public Affairs Approval Process

Upon submitting your Web Site for approval, these next steps in the publishing process will
involve the Public Affairs Reviewer.

Here are the step-by-step directions to submit your project to the public affairs official:

1. The Public Affairs reviewer will receive an email stating, "A site has been submitted to
you for your approval".

2. The Public Affairs reviewer will be provided a link directly to Back Office in the email that
they received. When the link (within the email) is clicked, the Back Office login screen
appears for Public Affairs Reviewer to log in to the Back Office.

3. The Public Affairs Reviewer will review the Project Web Site information. When they feel
that everything within the Project Web Site is ready for publishing, they will click on the
Approve Site Changes link (see below image).

4. When the screen refreshes, there will be an Approve button for the Public Affairs Reviewer
to approve the website. If necessary, the Public Affairs Officer can reject the website by
clicking on the Reject button.
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Additionally, the Public Affairs Reviewer can add Comments with the Approval or
Rejection of the Project Web Site.

8.8. Publishing the Project Web Site

Once the Public Affairs Reviewer has approved the website for publication:
● The status indicator of the Project Web Site will change from red to yellow.
● An email will be sent to you (Project Team Lead), notifying you that the website has been
approved.

Here are the step-by-step directions to publish your project website:

1. Click the Publish Site Changes link to take you to the publishing screen.
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2. Now that the Project Web Site has been approved (indicated by a yellow status indicator),
the next step is to publish the site. There are two options to publishing the project:

a. Publish Now; or

b. Publish on a Future Date.

8.8.1. Publish Now Option

If you wish to click on the Publish Now button. The website will be published immediately.

8.8.2. Publish on a Future Date Option

The second way to publish is to pick a future date in which to publish the webpage. Click on the
calendar icon (see below) to select a future date in which to publish the webpage.
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After the website has been published, the status indicator in Back Office will change from yellow
to green (see below image) and the bottom of the screen will show the person who last modified
the site and date as well as who approved the site and the date approved.

8.9. Editing the Published Website

What do you do if you need to update some information on the recently published website? For
example, let's say the Team Lead needs to add in a decision date. The Team Lead will add the
decision date to the project's Background tab, and then check the box for their project in the BO
so the Edit, Delete and Refresh buttons will appear (see below image). This refresh option is
used when a NEPA project is using a Project Web Site and anytime modifications are made to
data or content within the ePlanning Webtop. The system can "pull" new information from the
project and automatically update the project's webpage.
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When your NEPA project has a Project Summary Web Site (no comment period), and when
content needs to be changed on the project, another option to refresh your project is to simply
click the link Refresh Metadata from Repository (in green) next to the NEPA Project Summary
title (see below image).

Note

When updating/refreshing a project, the project's status indicator will turn back to red. The
process for Public Affairs approval will need to be repeated.

At this point, you will be able to check how the public would find the project on the NEPA
register and view the Project Web Site.
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8.10. Front Office (FO)

Example 8.3. Using Front Office

● Open the Front Office application.
● Find your project in the NEPA Register.

Note

While in the ePlanning training environment, you have to login (using your BLM AD login and
password) to the Front Office. For the members of the public, when webpages are published to
the Internet, there will be no need to login to the FO.

Here are the step-by-step directions showing how to view and use features for your project in
Front Office:

1. Click on the Training ePlanning Front Office icon.

2. In the example BLM website (see image below), click on the NEPA link and the NEPA
Register will be displayed (this Training Front Office display has a similar look and feel
as the external/public NEPA Register).
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3. Search for your project. Highlight the appropriate search items in State and Office. If
necessary, you may opt to define the search further by selecting the Document Type(s),
Fiscal Year(s), and Program(s).

4. Click the Search button. The screen will refresh and the search results will be displayed on
the same screen. Your NEPA project should be displayed in the search results.

5. Under the results, locate and click on the link for your project. Your NEPA Project Web
Page will open.

6. Look at your project.

Note

The LUP Register contains a project titled 'Phoenix North', which has practical content in the
interactive document. Additionally, it has a very long comment period. This example is ideal
for familiarizing yourself with features in the Front Office.
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8.11. SUPPLEMENTAL INFORMATION: Back Office & Front
Office

8.11.1. Creating a Project Summary Web Site

Here are the step-by-step directions tocreate a Project Summary Web Site for a NEPA project
that does not require a commenting period:

1. Click on the NEPA Register in the navigation pane. You will be taken to the NEPA
Register page.

2. Click on the Add link (in green and at the top of the page next to the words NEPA Register).
You will then be taken to the Add NEPA Web Site page (see image below).

3. Choose your project from the Repository Project drop down list (see image above).

4. Choose Project Summary Web Site in the Display Site As drop down list (see image
above).

5. The screen will refresh. Several new select boxes (see above image) will be added to the
screen including:
● Project Lead
● Phone Number
● NEPA Document
● FONSI/Decision Record Document
● Tiered EA/EIS Document
● Include Maps Section (checkbox)

6. Ensure the following red circled fields in the above image are filled in.

7. Click the Add button.

8. You will see your newly created Project Summary page (see below example).
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8.11.2. Submitting to Public Affairs

The next step in the publishing process will involve two parties, the Author and the Public Affairs
Representative.

Here are the step-by-step directions showing how to submit the project for approval by Public
Affairs:

1. Under the Public Affairs Reviewer section, select the person that is responsible for
approving your office's Web sites for publication. Add to the Additional Comments section,
if needed.

2. Click on the Submit for Approval button.

At this point, here are three things to note:
● The website will now be ready for the selected public affairs person to approve or reject
the website for publication.

● The Public Affairs person will also receive an e-mail in their Outlook inbox stating, "A
site has been submitted to you for your approval." The image below is an example of the
e-mail that the Public Affairs Officer receives.
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● The Public Affairs person will be provided a link directly to Back Office in the email
that they receive. It tells Public Affairs what part(s) of the website has been changed.
When the link (within the email) is clicked, the login screen appears for Public Affairs to
log into the Back Office.

3. As the Public Affairs Officer, review the project information and click on the Approve
button to approve a website.

4. As the Team Lead, once you have received an Outlook email stating your project has been
approved, go in to the Back Office and Publish Now or at a Future Date your project's
webpage.

8.12. Advanced Back Office Features

8.12.1. Introduction

The focus of the following content of this section is on ePlanning’s Back Office (BO) application.
BO is a useful tool for ePlanning users, as it allows them to create, as well as maintain their
project’s website in a centralized and standardized repository that is both visible and accessible
by the general public. It is assumed at this point, that system users recall from the introductory
ePlanning course how to preform the basic steps required to erect their project’s websites. As
such, the topics discussed in this chapter provide greater detail about a few of the more complex
features of BO. Specifically, we will examine in-depth how to create comment periods, how to
enter form letters, as well as how to use the search features in BO.

8.12.1.1. Objectives

Upon completion of this chapter, trainees will be able to:

● Establish and Modify a Comment Period
● Enter Form Letters into Back Office

8.12.2. Establish and Modify a Comment Period

In this section, we will set-up a comment period, set-up an initiative in CommentWorks, pull
comments from the Internet and put them into CommentWorks. Comment periods can only be
established for documents that are in the interactive (html) format. The same roles that can create
web pages can also set-up a comment period for a document. These roles are:

● P&EC
● NEPA Project Creators
● Team Lead
● Project Administrators
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Tip

Here are some things to remember about comment periods in ePlanning...

● Comment periods can only be added to Interactive Documents.

● Once a comment period has started, you cannot make any changes to the on-line document.

● Once a comment period has received a letter/submission/comment, it can never be deleted.

● A comment period can be closed, but it can never be deleted.

8.12.2.1. Establishing a Comment Period

Example 8.4. Establish a Comment Period

Create a comment period for your project’s website

Follow these steps to establish a comment period:

1. Login into the Back Office

2. Open the appropriate web page by choosing one fromMy Active Projects.
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3. Under Site Administration select Comment Periods (see below image). This will open
the Comment Periods web page.

4. Click Add. The Add - Comment Period dialog form will come up.

Start at the top of the form and work your way down.

5. Select the Project Document from the pull down list.

Tip

The project document lists the Interactive Documents that are found on the Documents &
Reports web page. If the document that you wish to have a comment period is not on the pull
down list, you need to first add it to the Documents & Reports web page.
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6. Add the comment period start date in the Start Date field. Either enter a date in the correct
format or click the calendar icon; and, the calendar wizard will come up. Then, select
the start date.

7. Add the comment period end date in the End Date field. Either enter a date in the correct
format or click the calendar icon; and, the calendar wizard will then come up. Then, select
the start date.

8. Select Yes or No for allowing comments to be submitted by the public after the comment
period has ended.

9. Select the CommentWorks Initiative, which is a pull down list (see below image).

Note

At this time in the class we are not going to select an initiative, for it is not a required field.
You will add one after you have learned how to create an initiative.
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Tip

The CommentWorks initiative does not need to be created before the comment period is
added. However, when the Front Office is synchronized with the Back Office, submissions are
pushed into CommentWorks. And, if an initiative is not set-up, "Where do those comments
go?" It is best not to leave this to faith, set-up the initiative BEFORE publishing a document
with a comment period.

All of the CommentWorks initiatives will show up in this list, which is going to become very
long. Therefore, using a standard naming convention is going to become very important.

10. Add any Public Comment Issues here that will be displayed on the external comment form
(see below). This is list of topics or issues for the public to assign to their comment. It is a
way to get the public to assign their comment(s) to a general issue (this is an optional field).

Perform the following steps:

a. Click on -Add New Public Comment Issue-

b. Type in the desired topic or issue to the left of the Add button. Click the Add button.

c. Continue until you have added all of the topics or issues you wish to have for the comment
period.

d. You can re-arrange or delete (remove) topics or issues that you have added by selecting
and hitting the appropriate button.
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11. Add the actual physical locations where you will be storing the paper letters. The list is
populated here and you will add this metadata by letter when entering letters via the Back
Office (this is an optional field).

Perform the following steps:

a. Click on -Add New Paper Record Physical Location-

b. Type in the location to the left of the Add button. Click the Add button.

c. Continue until you have added all of the possible locations where you will store the physical
records.

d. You can re-arrange or delete (remove) locations that you have added by selecting and hitting
the appropriate button.

12. Enter the letter Submission ID Prefix: for this comment period.

Tip

Anything can be entered in this field. So we will be using a three part data standard for this
Submission ID Prefix. The first part should be the two letter administrative state code, the
second part is an abbreviation for the project and the third part is for the type of commenting.
For example, SC = Scoping, DR = Draft and PR = Protest.

13. The next pieces of information that can be customized are the optional and required
demographic information to be included on the comment submission form. Simply check
the box to the left of the item to have it included on the comment form and then wether to
make it a mandatory field.

14. The next items deal with disclaimers. The first disclaimer is the standard one from the
solicitors, this must go on all comment forms. You then have the opportunity to add up to
two custom disclaimers on the comment form.

15. Click the Add Button. The comment period will be established and the Comment Period
dialog form will close and you will be back at the Comment Periods web page.
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8.12.2.2. Modifying a Comment Period

Once a comment period has been established, you can make some modifications to them. A
comment period can be edited, deleted or closed. If there are some submissions that have been
received for a comment period, then that comment period cannot be deleted.

Example 8.5. Modifying a Comment Period

Modify the comment period for your project’s web site

Here are the step-by-step directions to modify some of the options of a comment period:

1. Click the checkbox to the left of the comment period you wish to change. You will now have
the options to Add, Edit, Delete or Close the selected comment period (see image below).

2. Edit a Comment Period. When a comment period is selected and Edit is clicked, the edit
Comment Period dialog form comes up, make any of the changes desired. Click the Save
Button in the lower right of the form. The comment period will be updates and the Comment
Period dialog form will close and you will be back at the Comment Periods web page.

3. Delete a Comment Period. When a comment period is selected and Delete is clicked, the
comment period will be deleted. The system will ask you if you really want to delete the
comment period. However, if there are submissions that have been added to this comment
period, you will receive a message telling you so and that the comment period cannot be
deleted.

4. Close a Comment Period. When a comment period is selected and Close is clicked, the
comment period will be closed.

CommentWorks initiatives are created only by ePlanning Specialist at the National Operations
Center. Therefore, when going into a comment period submit a Remedy ticket to have your
initiative created.

8.12.3. How to Enter Letters via the Back Office

Letters/submissions/comments received outside of ePlanning can be entered into ePlanning
via the Back Office. In this section you will learn how to submit or enter these comments into
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ePlanning. Before we input form letters, however, let us examine the buttons on the Comment
Submission dialog window.

8.12.3.1. Comment Submission Dialog Window

1. User Site Administration click on Comment Submission.

2. Select the appropriate Comment Period from the pull-down list and the Comment
Submission dialog window will be displayed (see below image).

8.12.3.1.1. Buttons

There are 7 buttons on the Comment Submission Window.

Synchronize Now Button

When there is an open comment period for the general public, the comments they submit to the
BLM are actually stored in the network’s DMZ in a separate database from the Back Office.
For security reasons the public cannot touch the same database as the BLM does. Therefore,
submissions or comments must be pulled from the Front Office to the Back Office.
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For ePlanning, a custom job will be created that instructs a custom Java program to call the Back
Office Web Service and to instruct it to initiate the transfer of submissions from the Front Office
to the Back Office once a day (this can be done automatically or manually).

The Back Office Web Service initiates the transfer of submissions by connecting to the Front
Office Web Service, and calling a web method that sends the submissions to the Back Office Web
Service. Once the Back Office Web Service has stored all submissions that were sent from the
Front Office without error, the Back Office Web Service instructs the Front Office Web Service to
delete the transferred submissions from the Front Office submission database.

If project team members would like to initiate the immediate transfer of submissions related
to their project from the Front Office to the Back Office, then they may do so by clicking on

the button in the Comment Submissions page of the Back Office web site
for the specific project. If there are any letters in the Front Office they will be brought over to
the Back Office.

Comment Submission Buttons

Send To CommentWorks Button

If there are letters that are not in CommentWorks they do to be moved into CommentWorks.
Typically this needs to be done when submissions/letters are entered via the Back Office.

1. Check the box to the left of a letter that is not in CW.

2. Click the Send to CommentWorks button.

Add Submission Button

The users clicks this button to create a new submission for the selected comment period. These
new submissions typically are ones received outside of ePlanning. When clicked, the Back Office
Web Site Comment Submission form is displayed in a new browser window.

Edit Submission Button

This button allows the user to edit submissions/letters that are already in the system. This option
is only available to submissions/letters that are not in CW. This button may also be greyed out if
the user not the one who created the submission or is not the project-specific Data Entry user,
P&EC, NEPA Project Creator, Project Administrator, Team Lead, or ePlanning Administrator.

View Submission Button

This button allows you to view a single submission/letter that is selected (box is checked to the
left of a single submission).

Delete Submission Button
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This button allows users to “delete” a submission. The submission appears to be deleted but it
really is not. It no longer appears in the list of submission however, it does exits in the database.
This button may also be greyed out if the user not the one who created the submission or is not
the project-specific Data Entry user, P&EC, NEPA Project Creator, Project Administrator, Team
Lead, or ePlanning Administrator.

Submission Listing Button

This button brings up the Generate Submission Listing window. A submission listing is a
generated PDF file that contains the submission information from one or more submissions. This
listing includes all the submission listed in the Submission Table.

8.12.3.2. Entering a Letter in Back Office

Example 8.6. Entering a Letter in Back Office

Enter a form letter in to your project’s web site.

Now that we know what all the buttons are on the comment submission window, let’s examine
how to enter a form letter. Here are the step-by-step directions to enter a letter into Back Office:

3. Open the Comment Submission Dialog Window and Click the Add Submission button.
The Back Office Comment Submission Form wizard will come up. This should look
familiar, since it is almost identical to the Front Office Comment Submission Form Wizard.
The big difference is an extra step in the BO, Submission Classification (see below image).

4. Open the digital copy of a submission that was received. If you don't have a digital copy,
one need to be created some how. This is outside the scope of ePlanning. Either scan the
document or you will need to type it up.
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5. Copy the text from the digital submission and paste it into the comment area of the Back
Office Comment Submission Form.

Important

It is highly recommended that text from a Word document or PDF document be copy
and pasted into Notepad (found in your Start menu for Windows). This will strip out all
extraneous or hidden web-formatting from the text. From there, perform another copy
and paste process to put it into the comment submission form area.

6. Click the Add Comment Button.

Important

There is a character limit for the public comment submission form. There is now a
character counter at the bottom of the comment field. Pay close attention to this. You may
need to break a single digital submission into multiple comments, if it is lengthy.

7. Optional – you may want to upload any attachments associated with this submission. Click
the Browse button and located the file on your system.

8. If there is a request some where in the submission you have the option to send an email to
someone in the BLM. The email will go to the selected person.

After one comment has been added to the comment form the Require Immediate Attention
button appears. This is used to send an email notification to someone, as a result of some
information in the comment submission. This can be used for any reason. The original
thought was if there was any type of requests received via the comment submission form
that really were not part of the actual commenting process. for example, FOIA requests,
requests for information, etc. It can also be used to notify the Team Lead when comments
are received from publics of interest (see below image).
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Notice in there is no information supplied in the form. It is up to use the user to supply
everything. So, you will need to copy and paste information in the body of the email so
the recipient has some idea why they received this email. The recipient will receive an
email from doNotReply_ePlanning.

9. Click the Next button.

10. The comment submission form will move to step 2 of the process. Enter the demographic
information for the submission.

11. Click the Add Submitter button.

Repeat if there is more than one signature on the submission.

12. Click the Next button.

13. The comment submission form will move to step 3 of the process. This specific step 3 will
only be seen by users of Back Office. There are different pieces of information available to
you, which are explained below.

● Response Type: Identifies the specific format of the correspondence. For example,
letter, petition, etc.

● Delivery Type: How the letter was received. For example, email, fax, etc.

● Receipt Date: Enter the date the submission was actually received.

● Physical Location: If you enter a physical location where hard copies are being stored
when the comment period was set-up you would select that location here.
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● Active: If you are entering all of the submission at this time select Active. A submission
must be saved as “Active” before it can be posted to CommentWorks. Only submissions
that have at least one comment and submitter can be saved as an “Active” submission.

● Deleted: To flag a submission as deleted. It will not go into CommentWorks.

● Incomplete: The “Incomplete” option can also be specified even if comments or
submitter information have been enter. This allows a user to save a partially entered
submission and complete it at a later time. A submission identified as incomplete
can subsequently be changed to active and therefore be available to be posted to
CommentWorks.

● Ad-Hoc Fields:These fields allow the user to add user-defined metadata for submissions
using arbitrary field name and value pairs. A user specifies an ad-hoc field by selecting
the “Add field” link. This will display a new field name/value text field pair. The user
enters the name of the ad-hoc field into the “Field Name” text field and the value into the
“Value” text field. The user can specify up to five field name/value pairs. Once the fifth
pair has been displayed the “Add field” link will no longer be displayed.

Click, fill in, or add the appropriate information on this window.

14. Click the Next button.

15. The comment submission form will move to step 4 of the process. Review what you have
entered. Answer the Disclaimers and Agreements.

Optional – you may want to upload the digital copy of the submission to keep it with the
submission in ePlanning. You should save all of the “original” digital submission in your
ePlanning project library any way but attaching it here may make it easier to view it when in
CW. Click the Browse button and located the file on your system.

16. Click the Submit button.

17. The comment submission form will move to step 5 of the process. This is where you get a
submission number for the submission. You may want to write this on the paper version
of the letter for record keeping purposes.

18. Either click the Add a New Submission button or the Close Window button.

19. Repeat this process for all submissions received outside of ePlanning.
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9.1. Introduction

Standardized guidance has been issued from the Bureau of Land Management on compiling
a Decision File. The current guidance was issued from the BLM Director in Instruction
Memorandum No. 2006–225 on August 4, 2006. The BLM's policy is:

"It is critical that all BLM offices maintain organized, accurate, and thorough
Decision Files and Administrative Records in order to provide the decision maker
with information sufficient to render a well-reasoned decision and to document the
process the agency took in reaching the final decision."

9.1.1. Objectives

Upon completion of this chapter, you will be able to:
● Create a Decision File in ePlanning.
● Import documents into the project Decision File.

9.2. The Decision File

9.2.1. NEPA or LUP Project and the Decision File

The Decision File structure is created when the Project Team Lead initiates a new NEPA Project
or Land Use Planning Project in ePlanning. The project's Team Lead assigns specific tasks to the
project team to ensure that a Decision File is being built throughout the project lifecycle.

Data and documents for the Decision File should be updated and archived throughout each phase
of the project. At a minimum the content for the Decision File should be checked and evaluated at
the following milestones:
● Scoping
● Analysis of the Management Situation (AMS)
● Draft EIS, RMP or RMPA
● Final EIS, RMP or RMPA
● CX, DNA, or EA
● Finding of No Significant Impact, Decision Record or the Record of Decision (FONSI)

Tip

Decision Files are maintained as project documents are generated or received. Decision Files
should be maintained for all NEPA and LUP projects, which include documents such as
categorical exclusions (CXs) and determination of NEPA adequacy (DNAs).
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9.2.2. Creation of the Directory Structure for the Decision File

The project folder is created when the project is created in ePlanning. The name of the project
folder is automatically generated. For a NEPA project it is the value of the system-generated
NEPA Number. For a RMP-EIS project the folder is the "short-name". An example showing the
of a Land Use Plan RMP-EIS project folder and NEPA project folder names is shown below:

9.3. Working with Folders and Files in Webtop

9.3.1. Create a New Folder in your Project

Example 9.1. Creating a New Folder

For this exercise, create a Folder in the AR Index folder within your project. The Name
should be "Published Reports". The Folder Type is "dm_folder"

Here are step-by-step instructions for creating a new folder:
1. Navigate to the location where you want to create the new folder.
2. Select File > New > Folder in the ePlanning menu.
3. On the New Folder: Create page, and under the Create tab; give your folder a Name.

Then, under the Folder Type field, select dm_folder.
4. Click the Finish button.

Additional folder properties such as information about the folder and folder-level permissions may
also be defined in the Info and Permissions tabs in the New Folder page when creating a folder.
Chapter 9 Decision File
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9.3.2. Importing Documents or Folders

The ePlanning Webtop allows documents and/or folders to be imported directly from your local
drives such as the "share drives" or file servers. If you have numerous relevant documents in a
single folder - the entire folder, including the documents it contains, can be imported at once.
Documents that should be imported include emails and PDF scans of paper documents that are
essential for the Decision File and Administrative Record.

Here are step-by-step instructions for importing a document:
1. Open the destination folder, by clicking on the name, within your project where you would

like to import the document(s) and/or folder(s).
2. Select File > Import from the ePlanning menu bar.
3. Click the Add Files or Add Folders button (if you select a folder, both the folder and all its

contents will imported).
4. Select the file(s) or folder(s) you want to import by browsing through your computer's

folders and clicking on the file(s) and folder(s) you wish to add (you can select more than
one file at a time by holding the Control or Shift key while doing a left-click on your mouse).

5. Click the OK button.
6. Once all of the file(s) and/or folder(s) you want to import are selected click Next.
7. For each object, you will have the option to set the object's properties (in general, it is best

to leave the properties to their default values):
● Name: which defaults to its original name in the location from which you are importing.
● Type: use the default type "Document (dm_document)" for most objects. Note: your
choice of document type will depend on the choice of document you are importing
to your project folder.

● Format: Documentum infers the object format (analogous to Windows file type)
from the file's extension. Currently Office 2007 file extensions (e.g., "*.docx") are
not recognized.

8. Click the Finish button. If you are importing more than one object, you can click the Finish
button at any time and it will finish importing the objects with the default properties.

9.3.3. Working with Folders and Documents

Folders and documents can copied, moved, or deleted similar to working with folders and
documents in Windows.

Here are the step-by-step directions to copy an item:
1. Navigate to the item(s) you wish to move.
2. Select the box(es) for the item(s) you wish to move (To move several items at once, check

each item's box).
3. Select Edit > Copy in the ePlanning menu bar or click the Add To Clipboard button

in the ePlanning toolbar.
4. Repeat the above steps if you want to add items from other locations to the clipboard for

moving.
5. To view the clipboard, select Edit > View Clipboard in the ePlanning menu bar or click the

View Clipboard button in the ePlanning toolbar.
6. Navigate to the destination folder (where you want to put the item(s)) and select Edit >

Paste from the ePlanning menu bar.
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You may also move the folders/files, rather than create copies, by selecting Edit > Move Here
instead of Edit > Paste in the ePlanning menu bar. Remember to view your clipboard before
moving items to make sure the clipboard contains only the items you want to move. If an item is
not on the clipboard, make sure you have set your view filters to display the item.

Here are the step-by-step directions to delete an item(s):
1. Navigate to the folder which contains the item(s) you wish to delete.
2. Select the box(es) for the item(s) you wish to delete.
3. Select File > Delete from the ePlanning menu bar.
4. For Folder(s) in the Delete form.

a. Select one for Folders:
● Deleted only the Selected Folder.
● Delete the Selected Folder and All Sub Folders and Objects.

b. Select one for Versions:
● Delete Current Versions (folder will not be deleted in object versions remain).
● Delete All Versions.

c. Click the OK button.
5. For File(s) in the Delete form.

a. Select one for Version:
● Selected Version.
● All Versions.

b. Click the OK button.

Warning

Do NOT delete the "Project Configuration" folder from any project! This folder and its
contents are used by the application. And, deleting the project configuration folder will cause
errors, possibly including irrevocable damage to the project!

9.3.4. Decision File Structure

Note

All of the information below was taken directly from the H -1790-1 - National Environmental
Policy Act Handbook. Appendix 10, pp 167–168. This information and more can be
found by visiting this web address: http://www.blm.gov/pgdata/etc/medialib/blm/wo/
Information_Resources_Management/policy/blm_handbook.Par.24487.File.dat/h1790-1-2008-
1.pdf .

The Administrative Record needs to demonstrate all of the factors considered and the process
used in reaching a decision. The record must also document public involvement in the process.
Be aware that some documents in the Administrative Record are subject to the Freedom of
Information Act and Privacy Act (consult your FOIA Officer). And on those documents that are
subject to the Freedom of Information Act and Privacy Act , make a note on those documents
and indicate it in the database. (Except for some grazing actions, if information is not in the
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administrative record, then the court or the IBLA considers that it did not happen. Documents or
other info cannot be added after the decision is final, regardless of how relevent it is.)

If the Administrative Record is used in lawsuits, protests, and so forth, and if information is not
filed in the Administrative Record, the courts or the IBLA may consider that it did not happen.)

Administrative Records may include (but are not limited to) these documents (from the NEPA
Handbook, pp.167–168):

General Information
● Federal Register Notices
● Interdisciplinary Team or Project Team Membership
● Preparation Plans
● Contract Information (if the project is contracted)

Public Information
● Public Involvement Plans
● Public Information Documents (letters, notices)
● News Reports and Clippings
● General Correspondence
● Meeting and Workshop Records (attendance lists, announcements)
● Scoping Report
● BLM Responses to Comments (if not included in the environmental document)
● Protests or appeals and the BLM’s responses
● Mailing Lists
● Public Comments (from all phases of the project)

External Communications
● Other Federal Agencies
● Cooperating Agencies
● Tribes
● State Agencies
● Local Agencies
● Elected Officials (Governor, County commissioners, city officials, and so forth)
● Individuals
● Organizations
● Freedom of Information Act (FOIA) Requests and Responses (maintained by the FOIA
Officer)

Internal Communications
● Project Management Correspondence
● Interdisciplinary Team–Project Team Correspondence (meeting notes, agendas)
● FOIA exempt documents
● Quality Assurance Determination
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Background Material/Supporting Information
● Data
● Data Standards
● Metadata
● References
● Analyses (of alternatives, environmental consequences)
● Appendixes
● Special Reports (ACEC Report, Reasonably Foreseeable Development Scenarios, Mineral
Assessments, Wild and Scenic River Suitability Assessments)

● Biological Assessments or Opinions
● Section 106 Consultation

Environmental Documents and Decisions
● Draft EIS
● Final EIS
● DNA, CX, EA, and FONSI
● Record of Decision or Decision Record

Chapter 9 Decision File January 1, 2013
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10.1. Introduction to Maps within ePlanning

Maps are an essential part of the planning process and are included in many NEPA documents.
This chapter will describe a new process for utilizing collaborative maps that you can use
with your ePlanning projects. This new interactive web map feature is similar using maps
through Google, Yahoo!, or Bing. At the moment, it will allow for some very basic geospatial
commenting, but some additional commenting tools are in the works, for this new map feature.

Alternatively, remember that you can use static map images as well. Refer to the Arbortext
chapter (Chapter 6) for more information on how to do this.

For the remainder of this chapter (and to distinguish from the use of static map images), the maps
using this new feature will be referred to as “webmaps”.

This chapter is not focused on technical GIS process for creating a map from scratch, rather it will
show how ePlanning can use these maps once they are ready for a project.

10.1.1. Objectives

Upon completion of this chapter, you will be able to:
● Describe the basic process for getting interactive maps setup in ePlanning.
● Set up a map in Back Office that will be seen by the public and can be commented on.
● Describe the process for analyzing the geospatial map comments received from the public.

10.2. An Overview of the ePlanning Map Feature

Note

If you have technical questions or concerns with working with these webmaps in ePlanning,
please submit your issue or question to the ePlanning group via a Remedy ticket. A member of
the ePlanning user support team will get back to you as soon as possible.

Requirements: At least one team member must be assigned to the project as a GIS Specialist, in
order to access the appropriate software. A project-specific geodatabase must be created on the
ePlanning servers and will be created by a member of the ePlanning IT team.

Using ArcGIS version 10.1, maps (with the associated basemap and layers) will be created by the
GIS Specialist. The map data should be saved as a map package.

A project website format will have to be, initially, created and setup in Back Office

Submit a Remedy ticket to the ePlanning group indicating that there are maps to be linked to an
existing ePlanning project. A member of the ePlanning team will be in contact with the GIS
specialist (or project lead) to get that map package transferred over to the NOC. At this point, the
NOC will load the map package onto an ArcGIS server tied to ePlanning.

Once the map data is loaded, the GIS specialist (or project lead) will be notified by someone on
the ePlanning team. From there, the user can start creating their webmaps for their project.

A comment period for a specific document will have to accompany any maps are setup, as well.
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If there are changes to the map package or specific layers, notify the ePlanning team via Remedy
ticket to get the map information revised.

A basic overview of the process is illustrated in the image below.

10.3. Preparing Maps for your Project

Once these maps have been loaded into the system and you have been notified by the ePlanning
support team, go into Back Office to start preparing the webmap for the NEPA or LUP project you
are working on. In Back Office, you will setup the map layers that will be seen by the public.

Note

These types of maps are best utilized for projects using the “project website” format, not the
“project summary website” format. Review the information in the Back Office/Front Office
chapter from the basic ePlanning course for more information on how to setup your ePlanning
website.

10.3.1. Setting Up the Webmaps in Back Office

Example 10.1. Create the Webmaps in Back Office

Jump into Back Office and create your maps for a project.
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Here are the step-by-step directions to create webmaps for your project:
1. In the home screen in Back Office, select the project you are working on from the “My

Active Projects” list. See example image below.

2. In the navigation screen on the left side, selectMaps, and then select the Add Web GIS
Maps link up top.
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3. This will take you to a screen similar to the image below. Click on Create New Map
button as illustrated in the image.

4. Click the New Layer button in the same area.
5. Enter in a Name and Description for the webmap.
6. Select an option from the Service dropdown menu. Once that is selected, start choosing the

Layer to add to the webmap. Click the Add button when finished. See image below.
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7. When you add a layer, you can keep adding more layers to the webmap by repeating steps 4
through 6

8. Use the zoom feature, as well as the Draw Extent and Overlap Transparency features to
further enhance or define your map.

9. When you are finished, click the Save button.

You can add multiple webmaps to the project by repeating all of the steps in this section.

As you save each new webmap, you will see the name of the map(s) added to the Web Maps
area, as illustrated in the image below.
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10.3.2. Publishing the Webmaps

Before the maps are actually seen by the public, it is recommended that you finalize all other
portions of the project website, such as filling in background information, contact information,
and anything else that is pertinent to the project.

Make sure to set up comment period for your project as well!

When you are ready to publish, submit the site to the public affairs official for approval. When
the site has been reviewed and approved, go ahead and click the Publish button immediately, or
on a specified date.

Refer to the Back Office/Front Office chapter for more specific information on how to publish
your project website and how to setup a comment period in ePlanning.

10.4. Understanding Public Involvement with Webmaps

Once the project website is approved and published, the public will be able to search for the
project and make geospatial comments on the maps. There will be two areas where the general
public can view the maps. Let’s quickly explore these two options.

● TheMaps link will display all of the webmaps that were created for the project. In this area
the public can only see the extent of the area selected and the layers for the map. Geospatial
comments are not allowed here.

● The Documents and Reports link will display the webmaps, under the interactive document’s
public comment submission feature. It is here that the public will be able to make geospatial
comments on the maps, if a comment period was setup for the document.
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10.4.1. The Maps Link

Using Front Office, look for the project that was just published. Select theMaps section and
explore the maps in this area.

Example 10.2. Explore the Webmaps in the Maps Section

Take a few minutes to look at the maps under this section of the project’s webpage.

Here are step-by-step directions for viewing this area of the project website:
1. Click on the Maps link. Then, select one of the webmaps that is available, as illustrated

in the image below.
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2. When the webmap is selected, the layers may take a few seconds to load. Here, you can
zoom in and out of the map area, as well as view the legend of the map features. Remember
that this is just a reference point for viewers. Public comments on the maps are not allowed
here, but is a great starting point for understanding the planning areas in relation to
project document(s).
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10.4.2. The Document and Reports Link

Using Front Office, look for the project that was just published. Select the Documents and
Reports section and make comments on the maps in this area.

This section will just focus on making the geospatial comments for webmaps. To complete
the public comment submission (with the map comments), the entire commenting process will
have to be completed

Note

Remember that this process requires a comment period setup to fully utilize the geospatial
commenting ability for the maps. Refer to the information above, or review the chapter on Back
Office/Front Office, for more details on how to create a comment period for your project.

Example 10.3. Explore the Webmaps in the Document and Reports Section

Take a few minutes to look at the maps under this section of the project’s webpage.

Here are the step-by-step directions for viewing this area of the project website:
1. Click on the Documents and Reports link. Then, select the Interactive Document icon,

as illustrated in the image below.

2. Highlight some content and click on the “Click Here to Submit Comments” link.
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3. This will open up the public comment submission form. This will look familiar to the
content reviewed during the Back Office/Front Office chapter. However, notice that there is
one small difference here; we now have a section to comment on maps.
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4. Go ahead and click on the Comment on Maps button.
5. The webmap feature will load up. From here, you can select a specific map to view using

the “Select a Comment Map” dropdown menu. You can also zoom in and out, or pan around
to more specific areas using the tools provided.

6. In the example image below, the map titled “Workbook Example” was selected. Click on the
Draw Point button, pick an area on the map, and make a comment on the XY coordinates.
For the moment, this map comment feature allows for only XY coordinates. We anticipate
that the ability to comment using polygons and lines will be added in the near future.
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7. You may add as many geospatial comments as you would like. You can switch between
webmaps, using the starting dropdown menu. When finished, turn off the Draw Point
button, and select the Back to Form button.
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8. This will close the webmap screen and allow for further text comments to be made by the
public. Notice that the number of comments on the maps is noted at the top of this section.
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Continue on with adding in comments for the issue. If needed, refer to the Back Office/Front
Office chapter on how to proceed with using the basic portion of the public comment submission
form.

The last section of this chapter will briefly discuss how to analyze those geospatial comments
that were received from the public.

10.5. Analyzing the Map Comments in the Back Office or in
CommentWorks

Now, let’s take a look at what to do with to do with those comments that were made by the
public. In Back Office, you will be able to review the public comment submission just as it was
discussed in the Back Office/Front Office chapter.
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(See image above.) With the webmaps feature though, you’ll be able to review the geospatial
comments as well. Under the “Site Administration” menu for your website, click on the
Comment Submissions link. You may have to select the Synchronize Now button to bring in
any recent comments.

From here (see image above), you can view the text comment by checking the box next to the
submission and going to the View Submission button. Reviews of this type were discussed in the
Back Office/Front Office chapter.
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Alternatively, you can click the View Map Comments button to view the geospatial comments
that were made by the public on the webmap(s).

When the webmaps screen opens (see image above), you can select a specific submission ID to
view, which will, in turn, load the comments below, as well as where on the map those XY points
were made. Of course, there are additional features here available for you. You can choose a
different map, if you have multiple maps, under the “Select a Comment Map” dropdown menu.
Also, you can zoom in and out, and pan around the map to get more detail(s) on the map display.

If you choose the View as Text button, next to the Comments heading (see image below), you
will get the exact latitude and longitude coordinates for each geospatial comment that was
made. This information can be shared with the GIS specialist in your office, if map revisions or
modifications are needed.
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The text comments and the geospatial coordinate data is recorded in Back Office and will be sent
over to the CommentWorks initiative for your project, if you have one setup.
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In CommentWorks, the map and text comment(s) from the public will be displayed normally and
will be ready for further comment analysis and review on your end. See image above.
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11.1. Introduction

CommentWorks is a web-based software solution for analyzing, sorting, tracking, summarizing,
and responding to public comments. By using CommentWorks, U.S. federal, state, and local
government agencies and private companies can streamline the labor-intensive process of
accepting and resolving public feedback and integrating these comments into projects and
programs. Dozens of federal departments and agencies, as well as states and companies, have
relied on CommentWorks to manage and analyze hundreds of thousands of comments on their
regulations, guidance documents, environmental analyses, and other types of reports and projects.

CommentWorks is mentioned in the basic ePlanning course, but is not thoroughly explored.
In this course, we will take the time to explore this system in more detail. The version of
CommentWorks that we are currently working with is: 4.2.1.

11.1.1. Objectives

Upon completion of this chapter, you will be able to:
● Understand the terminology related to the CommentWorks application
● Work with comments, which include:

○ Synchronizing comments from Back Office
○ Parsing and categorizing comments
○ Manual entry of comments via CommentWorks or Back Office

● Generating reports

11.2. Overview

CommentWorks was designed to assist users with collecting, tracking, analysis, documenting and
responding to comments. Users will be able to:
● Review the text of public comment submissions
● Conduct full-text searches of these submissions
● Categorize and sort comment excerpts from the submission by key issues
● Draft, edit, and generate reports of comment summaries and responses
● Navigate between submissions and related comment excerpts, issues, summaries, and
responses

● Perform other critical comment analysis functions

11.2.1. Comment Analysis Process Overview

The following flow chart provides a basic overview of the comment processing and analysis
process that CommentWorks is used for.
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Source: ICF International, 2011. CommentWorks 4.2 User’s Guide.

11.2.2. CommentWorks Terminology

The terms used for CommentWorks (CW) are unique, but it is not too difficult to understand.
Below is a list of the commonly used terms in this application.

Initiative Each project in CW is known as an Initiative.
Submission CW calls letters or comments "submissions." These can take the form of emails, web form

submissions entered directly into the ePlanning Front Office, handwritten letters, public
meeting transcripts, etc.

Comment A submission can be divided into individual distinct comments.
Issues Each individual distinct comment is assigned an issue, also known as a topic. Issues are

typically unique to a project.
Issue Outline The comprehensive list of issues for an ePlanning project that are related or defined to a

given initiative.
Parsing The process of assigning comments to relevant sections of the issue outline is referred to

as "parsing/bracketing/coding."
Representative
Comment

An individual comment that is selected to represent all of the comments for a particular
issue/topic. This identified comment will be exported into the document along with the
summary statements and responses.

11.2.3. CommentWorks Permissions

There are two levels of security within CommentWorks. Generally, all users are given a system
security role first. Then, for each individual initiative, each user must have a specific set of roles
to work with the initiative.

System Security Roles
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● CWStandard: Most users will have this security role. This user can add submissions, parse,
and prepare/edit summaries and responses.

● CWAdmin: This will be a role handled at the NOC. This user can create initiatives, and
add/delete users.

Initiative User Roles
● Read Only: Allows users to look at everything in the initiative.
● Edit

○ InitManager: This user can edit the larger details for an initiative once it has been created.
It allows the user to manually add submissions directly into CW.

○ Edit Issue Outline: This user can edit the issue outline for an initiative.
○ Edit Submissions: This user can add letters, parse, and assign issues to letters.
○ Edit Summaries: This user can create and edit summaries.
○ Edit Responses: This user can create and edit responses.

11.2.4. Important Notes About CommentWorks

CommentWorks is tied into your BLM Active Directory (AD). Therefore, logins and passwords
will change only when your password changes for your BLM AD.

CommentWorks is Windows-based and thus, runs on its own server in the Production
environment. So, if ePlanning (Webtop or Arbortext) goes down for whatever reason,
CommentWorks should be up and running without any issues.

Use caution when working with initiatives and submissions, as they cannot easily be deleted.

Important

Initiatives should be created by the ePlanning team.

When using this application, ALWAYS remember the basic rules for working with issue
outlines and comment analysis. Very simply, always be in communication with your comment
analysis team members to ensure that everyone understands their roles and responsibilities
in CommentWorks.
● If a change needs to be made to the issue outline during the course of comment analysis, it
is HIGHLY recommended to perform this action when there are no other team members in
that specific initiative. Changes to the issue outline made at the beginning of the day or at
the end of the day, might be a good course of action to take. This will help guarantee that
the issues outline does not become corrupted from conflicting notes in the database.

● Also, when working with hundreds of comments, it is recommended that the team members
be very clear with each other on which set of comments will be worked on by whom. For
example, one person may want to analyze comments 1 through 50, while another person
may want to work on comments 51–100, and so on.

Make sure that two people are NOT working on one comment submission at the same
time. This will cause the latest change in a comment to override the previous work that
was performed on it.

Beware of special characters, as CW has difficulty with some of these in certain areas. For
example, “T & E Species” might be better written in this application as “T and E Species”.
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Like Webtop and Citrix, it is possible to become timed out of CommentWorks. Unfortunately,
there is no warning that indicates that time issue, if you get pulled away from your desk. DO
NOT LOSE YOUR WORK! SAVE OFTEN!!

11.3. Logging In and Out of CommentWorks

Getting into the CommentWorks application is pretty straightforward and similar to the processes
for getting into Webtop or Back Office.

Here are the directions for logging in and logging out of CommentWorks:
1. Once you access Citrix, click on the CW (CommentWorks) icon. The CW login screen will

be displayed.

2. Log into CommentWorks using your BLM AD user name and password.
3. The opening screen for CommentWorks appears. See image below.
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Note

There can be multiple pages of initiatives, so if you do not see the initiative that you are
looking for, use the page links (near the CommentWorks menus) to move to other pages.

4. If you would like to log out of CommentWorks, use the Logout link in the CW menu bar.

11.4. Managing Comment Submissions

Before you actually start parsing submissions of individual comments, you need to become
familiar with the submission by reading them thoroughly. In the long run, this will save you time
as you start thinking about what issues to assign to each set of statements, especially with the
identification of form letters. Form letters can come in all sizes.

11.4.1. Using the Submission List

The next three subsections will familiarize you with submission listings.

11.4.1.1. Viewing the Submission List

After you have selected your initiative, look at the submissions received. From the View menu,
select Submissions.
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When there are more items than what can be displayed at once, there is a navigation tool at the top
and bottom of those pages that allow you to move between pages.

Items can be sorted by clicking on the column names. Columns can be re-sized, similar to how
columns are re-sized in Webtop.

11.4.1.2. Searching Submissions

The sorting capabilities of CommentWorks is very robust. You can search the text of submissions
to identify form letters.
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1. Click on View and then select Submissions.

2. Click on the icon at the top of the screen with a red box around it in the image below.

Search and filter tabs will appear on the left side of the screen.
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3. Expand the Search/Filter section and choose whether to search by submission text,
submission number, received date, commenter, and various other items.

4. The Search/Filter section will default to the “Submission Text” icon. Clicking on any
other button such as “Submission Number” or “ Commenter” allows for the use of the
“Use Range” function. The “Use Range” function can allow for more specific filtering of
the submissions. Click on the “Search Help” link to help guide you utilizing the “Use
Range” capability.
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5. Type in a search term and click on “Apply Filter” at the top of the screen to retrieve the
results of your search. The number of matches will be displayed next to the Apply Filter
button. The submissions list will be updated to include only the submissions that meet
the search criteria.

Tip

“And” and “Or” terms may be added to expand or restrict searches. Place quotation marks
around a search term that consists of two or more words. Click on the “Search Help” link to
help guide you through utilizing the “Use Range” capability.
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11.4.1.3. Filtering Submissions

Once you have searched your submissions and applied some metadata to them, you can than
“find” them again by filtering your submission.

1. Click on View and then select Submissions.

2. Click on the icon at the top of the screen. Search and Filter tabs will appear on the left
side of the screen.

3. You may filter by clicking Additional Search Criteria, by Flags, or by Tasks. Expand the
criteria by selecting the “+” signs and then check each criteria that you wish to include in
your filtered list. Click the “Apply Filter” link at the top of the screen to retrieve the results
of your filtered list. Submissions that meet all other, unchecked criteria will be filtered out
of the resulting list.

4. The number of matches will be displayed next to the Apply Filter link. The submissions list
will be updated to include only the submissions that meet the filter criteria.

11.5. Entering Letters Directly into CW

The following process of entering letters directly into CommentWorks should only be used if
ePlanning is not used and CommentWorks is used exclusively from ePlanning. If users are using
ePlanning it is recommended that letters received outside of ePlanning be entered via the Back
Office. This is recommended so the demographic information is stored in BO so a mailing list
can be generated . Some BLM employees handling protests and land use planning teams may
decide not to use ePlanning except for the CommentWorks portion so knowing how to enters
letters directly into CW is important.

1. Select your initiative by going to Enterprise and then Select Initiative. Next, check the
box next to the initiative you’re going to be working with.

2. Select View and then Submissions.
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3. Select the drop down menu titled Select Action on the right of the screen. Now, select Add
New Submission. Next, click Go to the right of the drop down menu.
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4. The new submission screen will come up.

5. Click on Submission Tracking arrow located on the right side of the screen.
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You can now click on the Submission Number link highlighted in blue and CommentWorks
will populate a unique number.

6. Click on the Commenters arrow and this section. It is not necessary to fill out every section
but it would be a good idea prior to beginning of this project to have a standard operating
procedure agreed to by all members of the project for continuity.
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7. Go to your source, what ever it maybe and copy the contents of the letter.

8. Open Notepad from the Start Menu in Windows.

9. Paste the contents of your letter into Notepad.
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10. Compare the content to the original and correct any inconsistencies. Paste the contents from
Notepad into the Letter Area in CommentWorks.

11. Click on Save Submission.

11.6. Searching for Form Letters

The term “Form Letter” refers to responses that are received from different individuals but are
identical in content. In cases when response text paraphrases the content of a form letter with no
change in the topic discussed, the response is treated as a form.
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You want to identify form letters, which include form letter plus and form letter minus so you do
not parse these letters multiple times. If you do parse them multiple times. especially when there
are many people doing the parsing, what are the odds of them getting the parsing exactly the same?

By reviewing submissions as many times as possible before you start the actual parsing you
can begin to notice patterns in some of the letters. These common phrases can be used to find
potential form letters.

Some Terminology

Form Letter: Identical or very closely paraphrased text.

Form Letter Plus: Identical or very closely paraphrased, with one or more additional comments
that may or may not be codeable. If the additional comments are not codable, then treat it as a
regular form. Is that extra content substantive? Otherwise just code the plus content.

Form Letter Minus: Identical or very closely paraphrased, but contain only a piece of an
original letter. Postcards typically are a form letter minus. they don't write out the entire letter
just one or two sentences.

Form Letter Master: A form chosen from a group of identical forms. The form master is coded
and entered into the database and it is used as a template for all of the forms it represents.

Tip

One way to identify form letters is to search the internet for the groups that are encouraging
folks to submit a letter to the BLM. These are modern day letter writers. They make it very
easy for citizens to send a form letter to the government. All you have to do in enter your
demographic information and hit send. More sophisticated ones allow you to select paragraphs
to be included in their letter.

How do you identify a form letter?

1. Perform a search based on a "signature" text string that you have identified.

2. Designate a submission as the form letter submission. Pick the one that has most of the
text included.

Tip

There can be dozens of different form letters for a single project.

3. Select a signature text string from that master, and search the other submissions for it.

4. For those submissions found to contain the with the signature string, you can use the "batch
update" function to set the form letter category value to "potential form letter" and select
the corresponding form letter master from the form letter master drop-down list (only those
submissions that have been designated and saved with a "form letter category" of "form
letter master" will appear on the drop down list.
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11.6.1. Batch Processing Form Letters (CommentWorks 4.2.1)

There are a number a letters in my initiative and I want to identify potential form letters. I believe
submissions with the text “test” to be a potential part of a form letter. To find these potential form
letters you would need to follow these steps:

1. Conduct a search using the phrase “test” .

2. Click the Apply Filter to execute the search.
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There were 21 submissions that meet our search criteria.
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3. From the Select action ... pull-down menu, select Batch Update Submissions. Click
the Go button.

The Batch Update Submissions dialog box will come up.

4. From the Form Letter Category field, select Potential Form Letter.
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If you want to also update any tasks at this time enter that information and check the box to
the left of Update Tasks.

5. Click on Save All.
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Now you have some potential form letters identified.

6. Click the X in the upper right hand corner of the Batch Update Submission dialog close
to close it.

7. Repeat this process.

8. Search using Potential Form Letters found under Additional Search Criteria >
Submission > Form Letter Category.
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9. Review the returned submission and identify one as the Form Master. This is done by
updating the metadata for that submission from Potential Form Letter to Form Letter Master.

Each form letter master submission ID is added to a list for form letter masters. There are
two drawbacks to this however; one you cannot view the whole field, and two the ID is
the submission ID.
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The Form Letter Master we just identified is the last one on the list.

10. Click Save Submission.

11. Do another search for signature text for that one form letter.

12. Click Apply Filter.

13. Review the search results.

14. Repeat the Batch Update Submission process, described above, but this time select Form
Letter from the Form Letter Category filed and select the appropriate Form Letter Master.
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15. Click Save All.

When you parse the submission you only parse the Form Letter Masters.

11.7. Parsing and Coding Comments from Submissions

Now is the time to identify the submission received and identify the individual comments from
each of the submissions.

11.7.1. Open a Submission

1. Click on Enterprise menu and click Select Initiative.

2. Check the box to the left of the initiative that you are going to work on. The initiative
selected will be highlighted in gold.

3. Click on View menu and click Submissions. This will take you to the List Submissions
window for the selected initiative. This window displays a plethora of information about
your initiative.
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Figure 11.1. List Submissions

Click on Open to view a submission. It will open the Edit Submission window.

Figure 11.2. Edit Submission Window

11.7.1.1. Submission Metadata

You will find a significant amount of information displayed here.
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11.7.1.1.1. Submission Tracking

The information found here came from the Back Office or Front Office of ePlanning or was
entered manually from CommentWorks users.

Submission Tracking

This is metadata about the submission itself.
Not all of the metadata added on in Back Office
transfers over to CW.
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11.7.1.2. Commenters

This area shows the demographic information about each of the commenters for the submission.
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11.7.1.3. Comments

This area shows the parsing results and comment numbers. Each one is a link that will take to
that comment location in the submission. The Open link after each comment, opens the Edit
Comment window for that issue.

11.7.1.4. Tasks

This area is where you update the task information along with the processing of submission. This
is a manual process, so update this information as you continue. This is how the information is
updated in the List Submissions when you first open an initiative.

11.7.1.5. Flags

This area is where you view flags on a submission or where you can add a flag.
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11.7.1.6. Attachments

This area will show up if there are any attachments with the submission. These would have been
added in either the Front Office or the Back Office.

11.7.2. Parse and Code Submissions

Coding is the foundation of the content analysis process. It provides a starting point for identifying
public concerns from letters, faxes, emails, and public hearing transcripts – submissions.

Public submission letters display a range of depth and emotion, and vary from bold, simple
statements to highly detailed analyses of a proposal. Parsing is the task of dissecting pieces
of correspondence and determining which statements are relevant to the proposal, which
are outside the scope of the proposal, and which restate comments coded earlier in the
same letter.

Part of the “plan” that was prepared to execute the comment processing and analysis should
include what is a comment and should only substantive comments that gets coded? The Forest
Service defines a comment, “can be defined as a coherent segment of text that will stand-alone
as a suggestion, idea, request, or critique.” Each individual comment is assigned an issue found
in the issue outline.

Keep in mind that the goal of public comment analysis is to facilitate an accurate and
comprehensive response to that comment.

To parse and code submissions you will be working in the Edit Submission window and using
the Issue Outline and Submission components of that window.
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11.7.2.1. Editing Tools

There are many editing tools that are available in CW. These same tools, except for one, are
available for creating Summaries and Responses. The only difference is the Custom Excerpt
Tool, which is only available when working on submissions.

While looking at submissions it is not a good idea to do too much editing, even if you find
misspelled words. The exception to this rule would be if the submission that you are working
with in CW was scanned. Often, the conversion process is not 100% and making corrections to a
scanned version of a submission is necessary. Sometimes the conversion from Word to ePlanning
and/or CW may cause some characters to not come across correctly, such as quote marks, etc.

Table 11.1. Edit Submission Tools

Tool Definition
This is the tool that brackets the individual comments.
Submission entered from the Front Office / Back
Office will automatically be bracketed or parsed. This
is based on the public hitting the Add Comment button
on the Comment Submission Wizard. This can be
changed.

Going from left to right:
1. Custom Excerpt Tool
2. Copy (Ctrl + c)
3. Spell Check
4. Undo (Ctrl + Z)
5. Redo (Ctrl + Y)
6. Show/Hide Border
7. Zoom — for viewing
8. Increase Size (F10)
9. Decrease Size (F9)
10. Print (Ctrl + p).

Remember you are using Citrix! Prints the
submission as it appears.

Going from left to right:
1. Bold
2. Italics
3. Underline
4. Strike through
5. Super Script
6. Sub Script
Going from left to right:
1. Numbered List
2. Bullet List
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Tool Definition
Going from left to right:
1. Format Stripper. This strips tags from text that is

copied from different sources.

2. Cut (Ctrl + x)
3. Copy (Ctrl + c)
4. Paste (Ctrl + v)
5. Paste from Word
6. Paste as HTML
Foreground Color. Changes the color of the text that
is selected.
Table Editing Tools. Going from left to right:
1. Insert table
2. Insert Column to the Left
3. Insert Column to the Right
4. Insert Row Above
5. Insert Row Below
6. Delete Column
7. Delete Row

Parse a Comment

1. Since ePlanning adds the bracketing when clicking the Add Comment button, you may
need to update the bracketing. This is done be selecting the bracket number and moving it to
the appropriate spot in the submission. You may need to move the beginning, ending, or
both brackets.
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2. To add a new comment, highlight some text by placing your cursor at the beginning of
the text you want to bracket and drag the cursor to the end of the text to be bracketed.
The selected text will then be highlighted.
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3. Click the Custom Excerpt Tool icon. Once the excerpt is created, two blue brackets will
appear – one in front of the selected text and one directly after. Blue brackets indicate that
the excerpt has not been Saved.

4. You can code the excerpt you just bracketed (see below) or you can repeat steps 1 & 2 as
needed to bracket all of the text in each letter before coding the individual excerpts.

5. Update the Task metadata.

6. Click Save Submission above the right window pane.

7. Click Back.

8. Go to the next submission.

Tip

Don't forget about the form letters. You do not want to parse all form letters, just the form
letter masters.
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Code a Comment

1. To assign a particular issue code to the comment, click on the folder icon next to the desired
topic in the issue outline, and drag and drop it on the excerpt. Please note that the code
will be inserted where the cursor is placed, not where you drag and drop it (notice that
after you bracket text, the cursor defaults to the end of the excerpt). You can move the
code if it dropped outside of the bracketed text. More than one code can be assigned to an
excerpt, but note that the same comment will appear in both folders (watch for consistency
when writing summary statements and responses). It is best not to add multiple issues to a
comment since you can only have one summary and one response to each issue. If you are
consistently adding issues to a comment - split the issue in the Issue Outline and redo the
adding of a code to a comment.

2. Continue adding an issue to each bracketed comment.

Tip

Don't worry where the issue text ends up in your submission. When you hit Save
Submission the issue code will be move to the beginning of the bracketed comment and
just after the comment number.

3. Update the Task metadata.

4. Click Save Submission above the right window pane.

5. Click Back.

6. Go to the next submission.

11.8. Searching, Sorting and Viewing Comments

11.8.1. Searching and Sorting Comments

When working with comments, you may want to filter them before you start working on them. If
using the default Tasks for your initiative at this point, the Task column under List Comments
window will display Review. There are a number of reasons that you may want to filter and
sort comments before viewing and updating the task information. You may want to just look
at comments that were tagged as substantive, or any other flags you added to your initiative
under Lookup Values > Comment. You may also want to view all of the comments coded
to a particular issue.

This process is similar to the searching and sorting in previous sections, only some of the filter
options will be different.

To search/sort/filter comments:

1. From the View menu select Comments. The List Comments window will be displayed.

2. Click on the icon in the image below to open the Search/Filter Search Pane. Search and
filter tabs will appear on the left side of the screen.
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3. Choose to search the comments by Search/filter; Issues; Lookup Values: Submission;
Lookup Values: Comment; Flags; or Tasks.

4. Type in the search term(s) and/or check each criterion by which you want to search or filter.
Click on “Apply Filter” at the top of the screen to retrieve the results of your search. The
number of matches will be displayed next to the Apply Filter button. The Comments list
will be updated to include only the comments that meet the search/filter criteria.

11.8.2. Viewing Comments

To view comments:

1. From the View menu select Comments. The List Comments window will be displayed. If
you already performed a search to filter out comments to work on, you may skip this step.
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2. Click on Open to open an individual comment.

3. You may identify potential comments that are “representative” for an issue. This is done
by clicking on the Comment Links tab under the metadata section of the window. Select
Representative from the list under Link Status.

4. Update Tasks status based on the table below for a list of possible statuses. If you changed
the default tasks status when editing the initiative, your list of tasks maybe different.
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Table 11.2. Tasks for Comments

Tasks Status Definition
Review Comments have been reviewed by the appointed reviewer.
Approved Comments have been approved that they are adequately parsed. This is

done by the appointed approval person.
ID Representative This task would be done by the person reviewing the comments.

Meaning this comment selection is a good representative comment.
Representative — Approved The approval person has approved the selection of this comment as

Representative. This comment would then be published in the proposed
document along with the summary and response statements.

If the selection of representative comments is not sufficient, go into the Comment Links tab
and remove the Representative selection.

5. Click Save Comment to save your work.

6. Repeat the above steps for all of the comments in your initiative.

11.9. Viewing, Sorting and Searching Comment Links

This section is similar to the previous section. This is where the approval of the representative
comments would be completed.

1. From the View menu select Comment Links. The List Comment Links window will
be displayed.

2. Click on the icon next to the Apply Filter link to open the Search/Filter Search Pane. Search
and filter tabs will appear on the left side of the screen.

3. Open the Lookup Values: Comment tab by clicking on the text.

4. Click the + sign to the left of Link Status to expand the selection.

5. Check the box to the left of Representative.

6. Click on Apply Filter link.
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7. Click on the icon next to the Apply Filter link to close the Search/Filter Search Pane.

8. Click Open to view the first comment.

9. If this representative selection is correct, under the Tasks tab, change the Task to
Representative — Approved.

10. Click Save Comment to save your work.

11. Click Back to go back to the List Comments Links window.

12. Select the next comment on the list. Repeat the process until all representative comments
have been approved.

11.10. Viewing Comments, Summaries and Responses by Issue

This section will cover viewing and sorting/filtering by Issue.

1. From the View menu select Issues. The List Issues window will be displayed.

2. Click on the icon next to theApply Filter link and the Search/Filter Search Pane will open.
Search and filter tabs will appear on the left side of the screen.
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3. Click the arrow signs to the left of Issues tab and check the boxes next to the specific issues
on which you want to focus.
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4. Click Apply Filter at the top of the screen.

5. The issues list will be updated to include only the issues that you selected.

11.11. Writing Comment Summaries

When all of the submissions have been parsed, coded, and representative comments have been
identified, it is time to prepare the summary statements. One summary statement is prepared for
each issue. Could that be a problem? It could, if two issues where identified for one comment.
This would be up to the Team Lead to develop the SOP for dealing with these situations. You
don't want summary statements and responses for the same issues to contradict each other.

Before starting this step, the Team Lead needs to go though the issues and make assignments,
for both writing summaries and responses, as well as assigning a due date for each. Each person
preparing either the summary or response would use the searching/filering described in the
previous sections, so they are only “viewing” issues that they are responsible to prepare.

To prepare summary statements:
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1. From the View menu select Issues. The List Issues window will be displayed. You may
want to do this after you have run a search, so only the summary statement that you are
required to populate will be displayed.

2. To review the comments that have been coded to a particular issue, click on the Open link
that appears to the left of the issue number. A three-pane pop-up window will open with
the comments coded to the issue in the left pane, the summary and response related to the
issue in the center panes, and related tasks in the right pane.

3. Click on the Show Context link next to any given comment to see that comment in its
context. Click Back to return to your summary and response screen.

4. Click the Edit link at the bottom of the Summary pane and the Response pane to put the
Summary and Response sections in Edit mode. The edit tools shown are the same as the
tools used for editing submission, except for the Custom Excerpt Tool.

January 1, 2013
Chapter 11 CommentWorks

Writing Comment Summaries



366 ePlanning Training Manual and
Reference Guide

5. You can develop your summary statement directly in CommentWorks or block and copy
a summary from Word. To copy from Word, highlight your text in the Word document
and copy it. Paste the text into the summary window in CommentWorks using the “Paste
from Word” icon (clip board with a “W” on it). Beware of copying from Word as CW can
sometimes not copy correctly when there are a lot of special characters.

6. Click “Submit” when you’re done editing.

7. Click Save (immediately above the Summary window pane).

8. When you have completed the summary statement update the Task field. Select Summary
Completed.

9. Repeat the process for all of the summary statements and responses you need to prepare.
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11.11.1. Review And Approve The Prepared Summary Statements

After the summary statements are completed and updating the task status to Summary
Completed has been accomplished, the summary statements need to be reviewed and approved.

To review and approve the prepared summary statements do the following:

1. From the View menu select Issues. The List Issues window will be displayed. You may
want to do this after you have run a search so only the summary statement with the task
status of Summary Completed would be displayed.

2. Click on the Open link next to any given comment to see that comment in its context. Click
Back to return to your summary and response screen.

3. If the summary is acceptable, update the Task field to Approve Summary. If the summary
needs more work update the task field to Revise Summary or update it yourself.

4. Click Update.

5. Click Back to go back to the List Issues window.

6. Repeat the process for all of the summary statements you need to review and approve.

11.12. Writing Responses

After the summary statements have been prepared the next step is to prepare the response
statements. This is similar to writing comment summaries, except you will be writing responses.

To prepare summary statements:

1. From the View menu select Issues. The List Issues window will be displayed. You may
want to do this after you have run a search so only the responses that you are required to
prepare will be displayed.

2. To review the comments that have been coded to a particular issue, click on the Open link
that appears to the left of the issue number. A three-pane pop-up window will open with the
comments coded to the issue in the bottom pane, the summary and response related to the
issue in the left and right panes.
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3. Click on the + link next to any given comment number to see that comment in its context.
Click Show Context to view the whole comment in its entirety.

4. Click the Edit link at the bottom of the Response pane to put the Response in Edit mode.
The edit tools shown are the same as the tools used for editing submission, except for
the Custom Excerpt Tool.

Figure 11.3. Edit Summary and Response Tools

5. You can develop your responses directly in CommentWorks or block and copy a response
from Word. To copy from Word, highlight your text in the Word document and copy it.
Paste the text into the response window in CommentWorks using the “Paste from Word”
icon (clip board with a “W” on it). Beware of copying from Word as CW can sometimes
not copy correctly when there are special characters used.
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6. Click “Submit” when you’re done editing.

7. When you have completed the response update the Task field. Select Response Completed.

8. Click Update.

9. Click Summarize to go back to the List Issues window.

10. Repeat the process for all of the responses you need to prepare.

11.12.1. Review And Approve The Prepared Responses

After the responses are updated and the task status is updated to Response Completed, the
responses need to be reviewed and approved.

To review and approve the prepared responses do the following:

1. From the View menu select Issues. The List Issues window will be displayed. You may
want to do this after you have run a search so only the responses with the task status of
Response Completed would be displayed.

2. Click on the + link next to any given comment to see its context. Click - to return to your
summary and response screen.

3. If the summary is acceptable, update the Task field to Approve Response. If the response
needs more work, update the task field to Revise Response or update it yourself.

4. Click Update.

5. Click Back to go back to the List Issues window.

6. Repeat the process for all of the responses you need to review and approve.

11.13. Reports from CommentWorks

There are a number of reports that can be run directly from CommentWorks.

Reports can be run from any of the List windows (List Submission, List Comments, List
Comments Links, List Issues and List Tasks). There are various reports that can be run and they
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depend upon which data you have displayed. Available reports can be found from the Select
action... pull-down menu. To execute the request you must hit the Go button to the right of
the pull-down menu.

The Report will be run for the list that appears in the List window. Any searching, filtering or
sorting that has been applied will be reflected in the Report. Searching, filtering and sorting
are important first steps in Report generation.

CommentWorks provides the following options for reporting: Preview as HTML; Export as
HTML; Export as RTF; and Export as XML. Exporting as HTML allows for a clean copy and
paste of the report into Word for editing.

Note

The XML format does not use the ePlanning DTD, so it cannot be imported into ePlanning.

Once the Run Report is selected and a selection of an output is made, click “Generate”. Once
generated, click either ‘View Report” or “Download Report” (depending on the output option you
selected).

Sample

This is a sample report for the Issues. We want to see the comments, summary and response
statements as parts of this report. Since this is a CW report the representative comments are
not part of the report.

1. From the View menu, select Issues.

2. From Select action .... select Run Report and click the Go button. The issue report
window will come up.

3. Under Content Options, select Include Comment, Include Summary and Include
Response. Under Output Options select Export as HTML.

4. Click Generate. The report will start running.

Chapter 11 CommentWorks
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5. Click Download Report. Click Open to open the report in Word on Citrix.
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11.13.1. Submission Report

For this report, the Content Options are currently locked by CommentWorks (i.e. the user cannot
select from the content options that are presented in the Report window). The report displays
submission information and full submission text with bracketing and coding.

11.13.2. Comment Report

For this report, the Content Options are currently locked by CommentWorks (i.e. the user cannot
select from the content options that are presented in the Report window). The report displays
bracketing and coding for individual excerpts with the associate submission information.

11.13.3. Comment Links Report

For this report, the Content Options are currently locked by CommentWorks (i.e. the user cannot
select from the content options that are presented in the Report window). This report shows any
comment that has a comment link associated with it. This is how you can see the comment that
have been tagged as Representative.

11.13.4. Issue Report

The report displays submission information for every excerpt, organized by Issue Topic. This
report allows the user to choose to include comment text (i.e. excerpt text), summary text and/or
response text on the report.
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11.14. SUPPLEMENTAL INFORMATION

This section contains additional information about features in CommentWorks that may have not
been discussed in the Advanced User course.

11.14.1. Additional Functions in the Edit Mode for an Initiative

11.14.1.1. Details Tab

There are just a few things that you may want to change on this tab, such as description or
comment start and end dates.

Figure 11.4. CommentWorks Initiative Details
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Possible Initiative Status options: Active, Accepting Comments, Comment Period Closed or
Closed.

Important

Setting the Value to “Closed” will cause the initiative to “disappear”. It will no longer show up
any where in CW. However, it has NOT been deleted. The display flag for that initiative has
been set to “not display”. This can be changed by submitting a Helpdesk ticket that contains
the name of the initiative.

11.14.1.2. Lookup Values

With the correct permissions, a user can change these values for their initiative.

Figure 11.5. CommentWorks Lookup Values

11.14.1.3. Flags Tab

With the correct permissions, a user can add, modify, or delete flags.
Chapter 11 CommentWorks
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Figure 11.6. CommentWorks Flags

11.14.1.4. Tasks Tab

With the correct permissions, a user can add, modify, or delete tasks.

Figure 11.7. CommentWorks Tasks

11.14.2. Changing the Lookup Values, Flags or Tasks

To make changes or add a value to either lookup values, flags or tasks, the process is all the same,
and it is the same as adding issues to the issue outline. For example, if we want to add “Farm
Bureau” to the values under Commenter Type, we would:

1. While in Edit Mode, Click on the Lookup Values tab.
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2. Expand the Commenter Type title under Submission, by clicking on the + sign to the
left of Commenter Type.

3. Select Commenter Type by clicking on the words once. It should be highlighted in blue.

4. Click Add Child. A new item will be added at the bottom of the list called New Item.

5. Click on that value one to open it in edit mode.

Type in Farm Bureau.

6. If that is the only thing you are going to change, click on Save up at the top of the Edit
Window.

Repeat the process above, steps 1 – 6, for any value, flag or task you wish to change for your
initiative.

Chapter 11 CommentWorks January 1, 2013
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The information in this chapter addresses the most common user support issues seen in ePlanning.

Note

Remedy Tickets to the ePlanning Group

When submitting a help desk ticket to the ePlanning group, please remember to identify the
following items, at minimum:
● The project number and the document that you are having issues with.
● An estimate of the time in which the issue occurred.
● A quick description of what occurred.

○ If possible, get a screenshot of the error or issue and put it in the Remedy ticket.

Putting this information in a ticket will assist the user support team some more with the initial
analysis of possible issues in the ticket, and identify if the issue in easily resolved or if the
IT group needs to do further analysis on it.

As always, if you have additional tips or suggestions for possibly improving the use of ePlanning,
please submit that in a Remedy ticket to the ePlanning group, or direct an email to a member
of the ePlanning team at the NOC. Your input and suggestions have already helped to make
ePlanning a better system that is easier to use over these past few years!

12.1. Completing a Project

12.1.1. Updating the Status of a Project

When a project has been completed in ePlanning, remember to update the status field from the
project creation screen in Webtop. Once that is complete, if your project has been published to
the LUP/NEPA Register, refresh the metadata in the Back Office to get the project status column
up-to-date.

As ePlanning continues to grow and more NEPA and planning projects get into the system, it
is imperative that users be aware of the project’s status in the office, so that the information is
kept current for the public.

Important

If a project has been published to the Back Office or Front Office, and it is decided that the
project type needs to be change, such as from an EA to a CX, please remember to REVERSE
the steps you took in getting the project published.

That is to say, delete (remove) the project from the public website first in Back Office, THEN
go into Webtop and proceed with changing the project type.

Do not change the project type in Webtop first, if a project is in the Back Office/Front Office.
Doing it this way will remove the access to the project in BO/FO for the project’s team
members. If this has been done, please submit a Remedy ticket to the ePlanning group for
further assistance.
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12.1.2. eNEPA for EPA

Starting in October of 2012, the EPA is requiring EIS documents to be filed into their eNEPA
system. The process is very simple and more information on starting with can be found here:
http://www.epa.gov/compliance/nepa/submiteis/index.html

From an ePlanning perspective, there isn’t too much additional work within ePlanning that is
required from users. Once the PDF is created from within the system (from either a document
build or a compose PDF preview), the BLM user will just need to, basically, ensure that the file
size of the document is okay, as well as making sure the metadata for the PDF file is filled in,
prior to submission.

Additional information on preparing the PDF document for submittal into the
eNEPA system can be found here: http://www.epa.gov/compliance/nepa/submiteis/
e-nepa-guide-on-registration-and-preparing-an-eis-for-electronic-submission.pdf

12.2. Webtop Tips

If you encounter a situation where a team member cannot access a project that you have just
created, a common error that may be causing this is to double-check the team definitions screen in
Webtop. If the team member is expected to work on the document or project, always make sure
that they are an “ePlanning system user” when they are added to the team definitions.

Selecting “BLM Active Directory User” in the team definitions screen is useful for accounting
who is attached to the project, but it does not give that person direct access to work on the project
in the ePlanning system.

12.3. Arbortext Tips

12.3.1. Change Tracking

ePlanning does not recommend the use of the track changes feature in Arbortext Editor.

12.3.2. Working with Large Documents

Working with large document such as a DRMP/DEIS can be challenging. Here are some tips that
can help with larger documents in ePlanning:
● Establish some naming conventions in your office before starting a large project. These
should include:
○ Sections
○ Tables
○ Figures
○ Appendixes
○ Glossary (you may want to utilize the stock glossary that is in the Asset Library)

● When tagging items such as Index, Glossary, etc., it is best to have the entire complete
document checked out to add these items. This way, you are making changes for the complete
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document. If you just checkout one chapter to add references and related items, it is going to
complicate how links and references work together across chapters or sections.
○ Tag the sections and chapters first, then start working on the cross-referencing from there.
This will ensure you are linking to a correct sections, since the section names will be
displayed in the document.

12.4. Back Office Tips

In the project summary website in Back Office/Front Office, users occasionally note that they
would like to change the contact person and number that is initially displayed. This can easily
be resolved by assigning the “project administrator” or “team lead” role within Webtop to one
additional team member.

Once that has been done, go into Back Office, find the project from the LUP/NEPA Register
screen, check the box next to the project, and choose the edit option to go back to the original
website creation screen for your project summary website. From here, you can select the desired
person to display on the public facing website.

12.5. CommentWorks Tips

When using this application, ALWAYS remember the basic rules for working with issue outlines
and comment analysis. Very simply, please always be in communication with your comment
analysis team members to ensure that everyone understands their roles and responsibilities in
CommentWorks.
● If a change needs to be made to the issue outline during the course of comment analysis, it is
HIGHLY recommended to perform this action when there are no other team members in that
specific initiative. Changes to the issue outline made at the beginning of the day or at the end
of the day, might be a good course of action to take. This will help guarantee that the issues
outline does not become corrupted from conflicting notes in the database.

● Also, when working with hundreds of comments, it is recommended that the team members
be very clear with each other on which set of comments will be worked on by whom. For
example, one person may want to analyze comments 1 through 50, while another person may
want to work on comments 51–100, and so on.

Make sure that two people are NOT working on one comment submission at the same
time. This will cause the latest change in a comment to override the previous work that
was performed on it.

12.6. Citrix Shadowing

ePlanning users who are comfortable with the system can certainly request Citrix Shadowing for
their accounts. This will allow that individual to initial assist with troubleshooting an issue within
a state, district, or field office. If you wish to have this ability, please submit a Remedy ticket to
the ePlanning group requesting shadowing capabilities for your ePlanning account.

As you may have seen if you have contacted user support, the Citrix Shadowing application only
allows a person to view another user’s Citrix session. Nothing else on the desktop (or outside
of the Citrix environment) can be seen. Once connected, be mindful of who is controlling the
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mouse. Both users can easily spend time “fighting” for control of a mouse, if the shadower and
the shadowee are not communicating clearly.
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List of Abbreviations
BLM:

Bureau of Land Management

BMP:
Best Management Practice

CD:
Compact Disk

CX:
Categorical Exclusion

DNA:
Determination of NEPA Adequacy

DOI:
Department of Interior

DTD:
Document Type Definition. The DTD specifies and defines the vocabulary of the markup for
which SGML or XML provides the syntax. A DTD consists of a set of entity, element type,
attribute list, and/or notation declarations that are combined to determine the structure of a
document. A DTD contains a DTD set that defines the structure of document types and
information about the intended meanings (semantics) of the element types defined in the
DTD set.

EA:
Environmental Analysis

EIS:
Environmental Impact Statement

EPL:
ePlanning Project

FOM:
Field Office Manager

FONSI:
Finding of No Significant Impact

GIS:
Geographic Information System

LUP:
Land Use Plan

NARA:
National Archive and Records Administration
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NEPA:
National Environmental Policy Act

P&EC:
Planning and Environmental Coordinator

PDF:
Portable Document Format. An Adobe file format that allows cross-platform viewing of
formatted documents using an application such as Adobe Acrobat Reader. PDF files retain the
source document’s formatting, including fonts, color, and graphics.

ROD:
Record of Decision

URL:
Uniform Resource Locator. A standard for specifying the location of an object or server
on the Internet.
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Glossary
Active Directory:

Active Directory (AD) provides central authentication & authorization services and stores
network information across an entire domain for Windows-based computers. AD plays an
important role in the security of the ePlanning system. For users, the convenience of AD will
allow individuals to login to ePlanning using the same username and password that they
use to access the BLM Network.

Build:
A build in ePlanning refers to the process of transforming the authored XML content into an
ePlanning published format, such as HTML or PDF.

Cabinet:
A computer file container such as a cabinet of folders, in which documents are kept in some
sort of preset and determined order.

Citrix:
Citrix by itself is a name of a company. The reference used in ePlanning does not refer to
the company rather it refers to the Citrix MetaFrame. The Citrix MetaFrame Presentation
Server is a technology that can allow remote users to connect to applications that are actually
installed on a remote computer. In the case of ePlanning, the remote computer is in Denver.
It uses a mix of technology that results in that remote application looking and behaving just
as though it was installed on the local machine. Applications running on Citrix may access
the users local drives including the C: drive.

Click:
For computer operations, it is the press of computer mouse button: a single action of pressing
and releasing either the right or left button on a computer mouse (Encarta, 2009).

Contract:
Shrink or lessen: to shrink or become smaller, or make something shrink or become smaller
(Encarta, 2009). Example: contract the folders in the Navigation Pane.

Cooperating Agency:
"Cooperating Agency" means any Federal agency other than a lead agency which has
"jurisdiction by law" or "special expertise" with respect to any environmental impact. A
State or local agency of similar qualifications or, when the effects are on a reservation, an
Indian Tribe, may be by agreement with the lead agency become a cooperating agency (40
CFR 1508.5).

Descendant:
The files within a virtual document are called descendants.

Display Pane:
The window to the right of the Navigation Pane.

DocBook:
DocBook is a structured markup language enables its users to create document content in a
presentation-neutral form that captures the logical structure of the content; that content can
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then be published in a variety of formats, including HTML or PDF, without requiring users to
make any changes to the source.

Edit Pane:
The main working area for creating and editing documents in Arbortext Editor, also called
the Edit window.

Environmental Impact Statement :
An environmental impact statement (EIS) under United States environmental law, is a
document required by the National Environmental Policy Act (NEPA) for federal government
agency actions "significantly affecting the quality of the human environment.” A tool for
decision making, an EIS describes the positive and negative environmental effects of proposed
agency action - and cites alternative actions (Wikipedia, 2009).

ePlanning:
ePlanning is an application for writing, reviewing, and publishing Land Use Plans such as
RMPs, EISs, and Scoping Reports online. Once a plan is published to a website, the public
can read the plan documents, review maps included with the plans, search content, and write
comments to the land use planning community. ePlanning then supports the planners in
managing and tracking the comments received.

ePlanning Webtop:
ePlanning Webtop is the software program that ePlanning users use to create HTML/XML
formatted documents for publication on the World Wide Web. ePlanning Webtop must be
entered from a BLM computer to access the Citrix remote web server. This web server
restricts access only to our private network, e.g. BLM’s intranet.

Expand:
Make or become larger: to become or make something become larger in size, scope, or extent,
or greater in number or amount Example: we need to expand the folders in the Navigation
Pane.

Extensible Markup Language (XML) :
The Extensible Markup Language (XML) is a general-purpose specification for creating
custom markup languages (see Markup Definition) XML is classified as an extensible
language, because it allows the user to define the mark-up elements. XML's purpose is to
aid information systems in sharing structured data, especially via the Internet, to encode
documents, and to serialize data (Wikipedia, 2009).

Markup Language:
A markup language is a set of codes that give instructions concerning the structure of a
text or how it is to be displayed. Markup languages are used in computer typesetting and
word-processing systems to specify the formatting, layout, structure, and other elements
of a document (Wikipedia, 2009).

Menu Bar:
The menu bar is the region where computer menus are housed. It provides access to such
functions as opening files, interacting with an application, or help. Menu bars are typically
present in graphical user interfaces with windows (Wikipedia, 2009).
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Navigation Pane :
The Navigation Pane shows the repository’s directory structure (in Webtop), similar to
a table of contents.

NEPA Project:
The National Environmental Policy Act (NEPA) is a United States environmental law, which
established a U.S. national policy promoting the enhancement of the environment and also
established the President's Council on Environmental Quality (CEQ). But NEPA's most
significant effect was to set up procedural requirements for all federal government agencies
to prepare Environmental Assessments (EAs) and Environmental Impact Statements (EISs).
EAs and EISs contain statements of the environmental effects of proposed federal agency
actions. NEPA’s procedural requirements apply to all federal agencies in the executive branch.
NEPA projects include EAs, EIS, RMPs, and CXs.

Node:
The top level of a repository in Webtop consists of the different nodes that give you access to
the different items and functions. To open a node, click it.

Object:
A document, portion of a document, graphic, or other component of a document that is stored
in a document database.

Parent Document:
A virtual document which is composed of multiple files called descendants or children.

Peer-to-Peer Review:
In ePlanning, peer review refers to a type of document review in which a work product
(normally some form of NEPA document) is examined by its author and one or more
colleagues, in order to evaluate its technical content and quality.

Preferences:
Preferences determine your personal settings and are stored on your computer. The
preferences are specific to that computer. If you use another computer, it might not have the
same preference settings.

Processing Instructions:
Instructions to the processing system, in its own language, to perform an action. Unlike
other kinds of markup, processing instructions are system-dependent and usually
application-dependent. They usually need to be changed if the document is processed
differently (for example, formatted in a different style) or processed on a different system
that may ignore the processing instructions.

Resource Management Plan (RMP) :
A Resource Management Plan (RMP) includes such components as financial resources,
inventory, human skills, production resources, or information technology (IT). It covers
the best resource management processes, techniques and philosophies for allocating
resources. Resource management is a key element to activity resource estimating and project
human resource management. Both are essential components of a comprehensive project
management plan to execute and monitor a project successfully (Wikipedia, 2009).
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Respository:
A repository is a digital library in which data collections are stored in digital formats (as
opposed to print, microform, or other media) and accessible by computers. The digital content
may be stored locally, or accessed remotely via computer networks. A digital library is a type
of information retrieval system (Wikipedia, 2009).

Root:
The uppermost node in a tree is called the root node. Being the topmost node, the root node
will not have parents. It is the node at which operations on the tree hierarchy commonly begin.

Style Sheet:
A Style sheet is a form of separation of presentation and content in desktop publishing
programs that store and apply formatting to text (Wikipedia, 2009). Style sheets are a common
feature in Arbortext’s word processing program and desktop publishing.

Tag:
In Arbortext Editor, a graphical representation of the string of markup characters used
primarily to identify the type and extent of elements.

Tool Bar:
A “tool bar” is usually displayed near the top of an application window and contains “icons”
(little pictures) or “buttons” to select commonly used functions.

Virtual Document:
A virtual document is a file that contains one or more files nested within it. The virtual
document is called the parent document and the files within are called descendants.
Descendants are also called children.

Webtop:
Please see ePlanning Webtop.

Workflow:
A workflow is a process that electronically passes documents and instructions from user to
user. For example, an employee might initiate a travel expense report; another employee
might review it and return it for revision; and a third employee might approve it. A workflow
automates the process, ensuring that the right file goes to the right people in the right order.
(From Documentum Help)
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Appendix A. Arbortext Editor Tags
Arbortext Editor allows for the insertion of various "tags" to markup document text.
The tags and a brief definition are in the table below. For more information, go to
http://www.docbook.org/tdg/en/html/docbook.html.

Table A.1. Arbortext Editor Tags

Tag Definition
abstract A summary
ackno Acknowledgements in an Article

acronym
An often pronounceable word made from the initial (or selected) letters of a name or
phrase

address A real-world address, generally a postal address
affiliation The institutional affiliation of an individual
alt Text representation for a graphical element
anchor A spot in the document
appendix An appendix in a Book or Article
appendixinfo Meta-information for an Appendix
attribution The source of a block quote or epigraph
author The name of an individual author
authorblurb A short description or note about an author
authorgroup Wrapper for author information when a document has multiple authors or collaborators
authorinitials The initials or other short identifier for an author
beginpage The location of a page break in a print version of the document
bibliodiv A section of a Bibliography
biblioentry An entry in a Bibliography
bibliography A bibliography
bibliographyinfo Meta-information for a Bibliography
bibliomisc Untyped bibliographic information
bibliomixed An entry in a Bibliography
bibliomset A cooked container for related bibliographic information
biblioset A raw container for related bibliographic information
blockquote A quotation set off from the main text
book A book
bookinfo Meta-information for a Book
bridgehead A free-floating heading
caption A caption
chapter A chapter, as of a book
chapterinfo Meta-information for a Chapter
citation An inline bibliographic reference to another published work
citerefentry A citation to a reference page
citetitle The title of a cited work
city The name of a city in an address
col Specifications for a column in an HTML table
colgroup A group of columns in an HTML table
collab Identifies a collaborator
collabname The name of a collaborator
colophon Text at the back of a book describing facts about its production
colspec Specifications for a column in a table
contractnum The contract number of a document
contractsponsor The sponsor of a contract
contrib A summary of the contributions made to a document by a credited source
copyright Copyright information about a document
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Tag Definition
corpauthor A corporate author, as opposed to an individual
corpcredit A corporation or organization credited in a document
corpname The name of a corporation
country The name of a country
date The date of publication or revision of a document
dedication A wrapper for the dedication section of a book
edition The name or number of an edition of a document
editor The name of the editor of a document
email An email address
emphasis Emphasized text
entry A cell in a table
entrytbl A subtable appearing in place of an Entry in a table
epigraph A short inscription at the beginning of a document or component
epl_map A custom figure to tag maps
epl_sciterm A custom emphasis tag for scientific terms
equation A displayed mathematical equation
example A formal example, with a title
fax A fax number
figure A formal figure, generally an illustration, with a title
firstname The first name of a person
footnote A footnote
footnoteref A cross reference to a footnote (a footnote mark)
foreignphrase A word or phrase in a language other than the primary language of the document
formalpara A paragraph with a title
glossary A glossary
glossaryinfo Meta-information for a Glossary
glossdef A definition in a GlossEntry
glossdiv A division in a Glossary
glossentry An entry in a Glossary or GlossList
glosslist A wrapper for a set of GlossEntrys
glosssee A cross-reference from one GlossEntry to another
glossseealso A cross-reference from one GlossEntry to another
glossterm A glossary term
graphic A displayed graphical object (not an inline)
highlights A summary of the main points of the discussed component
holder The name of the individual or organization that holds a copyright
honorific The title of a person
imagedata Pointer to external image data
imageobject A wrapper for image data and its associated meta-information
important An admonition set off from the text
index An index
indexdiv A division in an index
indexentry An entry in an index
indexinfo Meta-information for an Index
indexterm A wrapper for terms to be indexed
informaltable A table without a title
inlineequation A mathematical equation or expression occurring inline
inlinemediaobject An inline media object (video, audio, image, and so on)
isbn The International Standard Book Number of a document
issn The International Standard Serial Number of a periodical
issuenum The number of an issue of a journal
itemizedlist A list in which each entry is marked with a bullet or other dingbat
itermset A set of index terms in the meta-information of a document
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Tag Definition
jobtitle The title of an individual in an organization
keyword One of a set of keywords describing the content of a document
keywordset A set of keywords describing the content of a document
legalnotice A statement of legal obligations or requirements
listitem A wrapper for the elements of a list item
literallayout A block of text in which line breaks and white space are to be reproduced faithfully
lot A list of the titles of formal objects (as tables or figures) in a document
lotentry An entry in a list of titles
manvolnum A reference volume number
medialabel A name that identifies the physical medium on which some information resides
mediaobject A displayed media object (video, audio, image, etc.)
member An element of a simple list
note A message set off from the text
objectinfo Meta-information for an object
optional Optional information
orderedlist A list in which each entry is marked with a sequentially incremented label
orgdiv A division of an organization
orgname The name of an organization other than a corporation
otheraddr Uncategorized information in address
othercredit A person or entity, other than an author or editor, credited in a document
othername A component of a persons name that is not a first name, surname, or lineage
pagenums The numbers of the pages in a book, for use in a bibliographic entry
para A paragraph
part A division in a book
partinfo Meta-information for a Part
partintro An introduction to the contents of a part
personblurb A short description or note about a person
personname The personal name of an individual
phone A telephone number
phrase A span of text
pob A post office box in an address
postcode A postal code in an address
preface Introductory matter preceding the first chapter of a book
prefaceinfo Meta-information for a Preface
primary The primary word or phrase under which an index term should be sorted
primaryie A primary term in an index entry, not in the text
pubdate The date of publication of a document
publisher The publisher of a document
publishername The name of the publisher of a document
pubsnumber A number assigned to a publication other than an ISBN or ISSN or inventory part number
quote An inline quotation
remark A remark (or comment) intended for presentation in a draft manuscript
replaceable Content that may or must be replaced by the user
revdescription A extended description of a revision to a document
revhistory A history of the revisions to a document
revision An entry describing a single revision in the history of the revisions to a document
revnumber A document revision number
revremark A description of a revision to a document
row A row in a table
secondary A secondary word or phrase in an index term
secondaryie A secondary term in an index entry, rather than in the text
section A recursive section
sectioninfo Meta-information for a recursive section
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Tag Definition
see Part of an index term directing the reader instead to another entry in the index
seealso Part of an index term directing the reader also to another entry in the index
seealsoie A See also entry in an index, rather than in the text
seeie A See entry in an index, rather than in the text
seg An element of a list item in a segmented list
seglistitem A list item in a segmented list
segmentedlist A segmented list, a list of sets of elements
segtitle The title of an element of a list item in a segmented list
seriesvolnums Numbers of the volumes in a series of books
set A collection of books
setindex An index to a set of books
setindexinfo Meta-information for a SetIndex
setinfo Meta-information for a Set
shortaffil A brief description of an affiliation
sidebar A portion of a document that is isolated from the main narrative flow
sidebarinfo Meta-information for a Sidebar
simplelist An undecorated list of single words or short phrases
spanspec Formatting information for a spanned column in a table
state A state or province in an address
street A street address in an address
subject One of a group of terms describing the subject matter of a document
subjectset A set of terms describing the subject matter of a document
subjectterm A term in a group of terms describing the subject matter of a document
subscript A subscript (as in H2O, the molecular formula for water)
substeps A wrapper for steps that occur within steps in a procedure
subtitle The subtitle of a document
superscript A superscript (as in x2, the mathematical notation for x multiplied by itself)
surname A family name; in western cultures the last name
table A formal table in a document
tbody A wrapper for the rows of a table or informal table
td A table entry in an HTML table
tertiary A tertiary word or phrase in an index term
tertiaryie A tertiary term in an index entry, rather than in the text
textobject A wrapper for a text description of an object and its associated meta-information
tfoot A table footer consisting of one or more rows
tgroup A wrapper for the main content of a table, or part of a table
th A table header entry in an HTML table
thead A table header consisting of one or more rows
tip A suggestion to the user, set off from the text
title The text of the title of a section of a document or of a formal block-level element
titleabbrev The abbreviation of a Title
toc A table of contents
tocback An entry in a table of contents for a back matter component
tocchap An entry in a table of contents for a component in the body of a document
tocentry A component title in a table of contents
tocfront An entry in a table of contents for a front matter component
toclevel1 A top-level entry within a table of contents entry for a chapter-like component
toclevel2 A second-level entry within a table of contents entry for a chapter-like component
toclevel3 A third-level entry within a table of contents entry for a chapter-like component
toclevel4 A fourth-level entry within a table of contents entry for a chapter-like component
toclevel5 A fifth-level entry within a table of contents entry for a chapter-like component
tocpart An entry in a table of contents for a part of a book
tr A row in an HTML table
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Tag Definition
trademark A trademark
ulink A link that addresses its target by means of a URL (Uniform Resource Locator)
volumenum The volume number of a document in a set (as of books in a set or articles in a journal)
xref A cross reference to another part of the document
year The year of publication of a document
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Appendix B. Commonly Used Arbortext
Editor Attributes

Attributes provide additional information about tags that effect the way the object is handled
or interpreted by other components of the system. Attributes are used for modifying images,
creating hyperlinks and cross-references, etc.

Table B.1. Commonly Used Arbortext Editor Tag Attributes

Tag Attribute Notes and Allowable Values

align Align specifies the horizontal alignment of the content area in the
viewport area. Values are "center", "left", or "right".

depth, width

Use in conjunction with scalefit. Lengths must be expressed as a decimal value
followed immediately by an optional unit of measure or a percentage. Six and
one eight inches, for example, must be expressed as “6.125in”. Do not put a
space or other punctuation between the decimal value and the unit of measure.

scale

If scale is specified, it must be a positive integer. It is always interpreted to
be a percentage value where “100” represents 100%. (Note: Specification
of content area, scaling, and scaling to fit are mutually exclusive. If a

content area (contentwidth, contentdepth, or both) is specified, both scaling
and scaling to fit are ignored. If the content area is not specified and both

scaling and scaling to fit are specified, scalefit is ignored.)

imagedata

scalefit

If scaling to fit is requested, the content area is scaled until either the content
width is the same as the viewport width (and the content depth is less than or
equal to the viewport depth) or the content depth is the same as the viewport
depth (and the content width is less than or equal to the viewport width),
whichever comes first. Allowable values are "0" (false) or "1" (true)

imageobject role “print” if the image is a high resolution image for print publication or “web” if it
is a low-resolution image for posting to the Internet (you may insert one of each)

listitem override Type the number for which you want the list to begin. (Note: be aware of
potential conflicts with defining the continuation attribute of the orderedlist)

orderedlist continuation
"Restarts", the default, indicates that numbering should begin
again at 1. "Continues" indicates that numbering should begin

where the preceding list left off

type If using ulink to create a link to another object in Documentum
(for example, a map), enter "dctm"

ulink
url

The URL--or Uniform Resource Locator--may be the web "address"
(for a hyperlinks to a website) or the URL for the Documentum

object (for epl_map objects, for example)

various id

Unique identification for an object (acronym, appendix, epl_map, figure,
glossterm, orderedlist, table, etc.) to allow cross-referencing. The id must
not be a duplicate value and does not accept the space character. Using a

naming convention is recommended (e.g., "TableLandStatus").

xref linkend Enter the id of the object to which you wish to create the
cross-reference (e.g., "TableLandStatus").
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Appendix C. References
General

● ePlanning Community of Practice SharePoint Site

○ http://teamspace/sites-oc/eplanningcp/default.aspx

○ Calendar of events, including upcoming conference calls and/or WebEx meetings

○ This site also has many discussion boards: General, Webtop, Arbortext, GIS, User
Documentation / Training/ FAQ, Team Leads, CommentWorks, Front Office and Back
Office. This is a place to ask questions and to search answers of how to do things within
the ePlanning application.

○ Shared Documents – Look for folder called ePlanning for NEPA Training

● Web Sites

○ BLM Intranet - http://web.blm.gov/eplanning/

○ Internet - http://www.blm.gov/wo/st/en/prog/planning.html
PTC Arbortext

● ePlanning’s Arbortext Quick Reference Guide - handout

○ ePlanning Community of Practice – User Documentation / Training -> Arbortext
Documentation

● DocBook. This is an on-line description of the tags used in Arbortext Editor.
http://www.docbook.org/tdg/en/html/docbook.html

● ePlanning Arbortext Editor Tags.pdf. This document is located in the ePlanning for NEPA
Training folder on the ePlanning Community of Practice SharePoint Site. This is a brief listing
of the tags available in the ePlanning Application. In order to make it easier on the end user,
we, the ePlanning Team, has hidden some tags that ePlanning users will never use.
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Appendix D. Publishing Without Using an
Interactive Document

Publishing a document without using Arbor text has three key disadvantages the user needs
to be aware of before this option is chosen:

1. The first disadvantage is the inability to post a comment period on the NEPA or Land Use
Planning Register. The ePlanning system requires that an Interactive Document be added
to the Project Web Site before a comment period is added. If the document posted does
require a commenting period then the user will have to state that comment period in the
Home Page of the Project Web Site, as well as a statement on how to submit comments.

2. The second disadvantage is that the Comment Submission Form can’t be used by the
public to submit comments. By not using this form the public comments gathered will have
to be manually entered into Comment Works for further processing If Comment Works
needs to be used. The Comment Submission Form also has other capabilities that will not be
able to used as well such as an interactive map creation feature.

3. The third disadvantage is the inability for the user to fully utilize Created Templates and
the Builds features that ePlanning has to offer. By downloading an existing document it
may not follow the same templates that are incorporated into the ePlanning database for a
desired uniform appearance. The builds feature would also not be able to be fully utilized to
create partial documents for review.

The following example uses an Environment Assessment (EA) as an example document to be
published on a Project Web Site without using a Interactive Document created in Arbortext.
Each Section in this appendix will show the user the process to follow in order to add documents
to theProject Web Site.

D.1. Uploading the Desired Document Into the Project Folder

Here are the step-by-step directions for uploading the desired document into the project folder:

Save the document to a file location that can easily be found and identified and name the
document accordingly.

Create a project by following the instructions in Chapter 3 of this workbook.

Once the project has been created and a NEPA number has been assigned, subscribe to the
project folder.

Open the project folder to the location where the document belongs. As a default you may place
the document in the “Administration and Management” folder inside your project folder.
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Select File from the menu options in the tool bar and then select Import

The import file window will appear.

Click on the Import File button and when the browser window opens, find the document that
needs to be uploaded and click the OK button.

The document will appear in the import file window. Click the Finish button and the document
will appear in the desired file folder.

The document is now ready to be uploaded into your Project Web Site once your web pages
have been created in Back Office.
Appendix D Publishing Without Using an Interactive
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D.2. Adding the Document to The Project Web Site

Here are the step-by-step directions for uploading the desired document into the Project Web Site:

Add the project to the NEPA Register and start creating the web pages as described in Chapter
9 of this workbook.

When creating the project Home Page consider adding information about any commenting period
the project requires to be added here. Also consider adding statements that tell the public how
to submit comments to the office collecting them. The video tutorials are defaulted to the web
pages and reflect how to submit comments using the Comment Submission Form which will
not be available to the public for this project.

Note

Comment periods using the ePlanning application may not added unless an Inactive (Arbortext
Created) Document is added to the Project Web Site.

After you create the Home Page go to the Documents Page and click on the green Add link. The
Add — Project Document screen will appear (see bleow image).

Under Document Name on the Add — Project Document screen, select a name for your
Interactive Build PDF.

Select a Release Date.

Then press the Document Renditions: green Add link(NOT THE ADD BUTTON AT THE
BOTTOM OF THE PAGE!).

The screen will refresh and update to show you the Add — Project Document — Rendition
screen.

Under the Rendition Type: Repository Project File drop down, select .

Under the Build Rendition: click the Browse button and select the document you want to
upload (see below image).
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Press the Select button at the bottom right-side of the screen

followed by the Add button on the next screen that appears. This will take you back to the Add
— Document screen. The screen will refresh and you will see that your Interactive Document
Build has been added (see below image).

Complete the rest of your Project Web Site pages and submit to Public Affairs for approval by
following the remaining steps in Chapter 9.
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